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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be 
liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

For information about third-party license agreements, see the Open Source and Third-Party License Agreements on 
the HP Software Manuals Web site at h20230.www2.hp.com/selfsolve/manuals.

To view open source code, see the <PPM_Home>/integration/freeware/ directory of your PPM Center 
installation.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for 
Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 1997-2011 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

Intel®, Intel® Itanium®, Intel® Xeon®, and Pentium® are trademarks of Intel Corporation in the U.S. and other 
countries.

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Microsoft®, Windows®, Windows® XP, and Windows Vista® are U.S. registered trademarks of Microsoft 
Corporation.

Oracle® is a registered trademark of Oracle Corporation and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

2



Documentation Updates

This manual’s title page contains the following identifying information:

Software version number, which indicates the software version

Document release date, which changes each time the document is updated

Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

h20230.www2.hp.com/selfsolve/manuals

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact 
your HP sales representative for details.
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The following table indicates changes made to this document.

Publication Date Summary of Changes

July 27, 2011 (9.12)

Added warning that, from PPM Center version 8.03, customers must not upgrade to and then run 
at version 9.10 or 9.11. Instead, they must upgrade from version 8.03 to version 9.10 and then 
immediately upgrade to version 9.12.
Added procedure to flush the shared pool after installing version 9.12 if Operational Reporting 
has been used and before CP1 is installed.
Added certification of Microsoft Hyper-V support running Microsoft Windows 2008 SP2 
Enterprise Edition (32-bit) and Red Hat Enterprise Linux AS 4.0 (64-bit) platforms as virtualization 
server platforms.
Added JDK 64-bit support for Microsoft 2008 R2 Enterprise Edition (64-bit) and Red Hat 
Enterprise Linux AS 5.0 (64-bit).

The change bars in the left margins reflect the modifications made in the most recent version of the guide—
these change bars are not cumulative.



Support

You can visit the HP Software Support Web site at:

hp.com/go/hpsoftwaresupport

HP Software Support Online provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests

Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to: 

h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to: 

h20229.www2.hp.com/passport-registration.html
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1 Overview of PPM Center Version 9.12
This document provides an overview of the changes made to HP Project and 
Portfolio Management Center (PPM Center) for version 9.12 (Service Pack 2). 
It contains important information not included in the manuals. The sections 
New Features in PPM Center 9.12, Enhancements, Integrations, 
Certifications, and Fixes in PPM Center 9.12, and Known Problems and 
Limitations in PPM Center 9.12 provide information about the changes 
introduced with the new features, enhancements, certifications, and fixes for 
PPM Center version 9.12.

Protecting Your Deployment from Security Vulnerabilities

Make sure you take the necessary precautions to protect your PPM Center 
deployment from general security vulnerabilities, especially those related to 
Web server and related infrastructure vulnerabilities. Patch and configure your 
Web server’s operating system and DNS servers to prevent malicious attacks 
that could put your organization and data at risk. You can take such steps as 
disabling unused ports or enabling SSL in your environment. Consult your 
Web server vendor for the latest patches to prevent harmful attacks such as 
cross-site scripting.
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In this Version

The following new features are included in PPM Center version 9.12:

HP Financial Management

o Expected Start and Expected Finish Shown in Proposal and Project 
Financial Summaries

o Configurable Range of Fiscal Years for Financial Summaries and 
Financial Data Tables

o Options to Display Capital or Operating Costs in Financial Summary 
Graph

o Simplified Presentation of (x $1000) in Financial Summaries and 
Financial Data Tables

o “Forecast and Actuals” Changed to “Costs,” and “Planned” Changed 
to “Forecast”

o Displaying and Editing Data by Year in Financial Summaries and 
Financial Data Tables

o Displaying Line Totals in Financial Summaries and Financial Data 
Tables

o Copying Cost Lines from a PFM Request Financial Summary

o Simpler Procedure to Copy Forecast Data Across a Range of Cells in 
the Same Row

o Capital Expenses in Approved Budgets

o Confirmation for Updating an Approved Budget
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HP Portfolio Management

o Redesigned Configure Portfolio Management Page

o New Columns Available in Subportfolios Tab of Portfolios

o New Columns Available in Programs Tab of Portfolios

o New Columns Available in Proposals/Projects/Assets Tab of Portfolios

o Change to Exporting Portfolios to Microsoft Excel

o New Columns Available in Scenario Content Table

o Ways to Change Appearance of Scenario Content in Scenario 
Comparisons

o Relocated Add Content Button and New Remove Content Button in 
Scenario Comparisons

o New Update Scenarios Button

o Exporting Scenario Content to Microsoft Excel

o Filtering by Portfolio in Analyze Current Portfolio Portlet and Page

o “Budget” Changed to “Projected Cost” in Analyze Current Portfolio 
Portlet and Page

HP Project Management

o Project Tasks Indicate an Exception When User Does Not Specify 
% Complete If Required

o “Planned” Column Changed to “Forecast” in Project Cost Summary 
Portlet

HP Program Management

o New Columns Available in Program Overview Page

o “Planned” Column Changed to “Forecast” in Program Cost Summary 
Portlet

o New Options to Group and Ungroup Programs by Column Values

o Exporting Programs to Microsoft Excel
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HP Time Management

o Identification of Out-of-Sync Actuals Data Upon Upgrade

o Automatic Saving of Time Sheets to Prevent Data Inconsistencies

o Administration of Time Sheet Activities at the Request-Type Level

o Highlighting of Non-Working Days and Holidays on Time Sheets

o Renamed Buttons on Line Details Window

o New Time Sheet Notes Show “(Pending Save)” Until Time Sheet Is 
Saved

o Improved Error Management

o Improvements to My Tasks Portlet and Edit Effort Breakdown Page

HP APM for PPM

Integration with Microsoft Project 2010

Updates to HP Deployment Management Extension for Oracle E-Business 
Suite and HP GL Migrator to Support Oracle E-Business Suite Release 12

HP Demand Management

o New Table Component

Supported Validations

New Table Component Layout

Switching between Original and New Table Component Layouts

Editing Table Component Directly on Request Pages

Showing Total of a Table Component Column in Real-time

Quick Navigation through Table Rows

Other Changes

o Considerations for Using Rules in Table Component
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The following enhancements are included in PPM Center version 9.12:

Display of Project Number in Project Overview Page

Display of Project Number in Time Sheet Lines

Approval of Submitted Time Sheets for Future Periods

User Control of Vertical Size of Time Breakdown Tables on Time Sheets

New Report: Purge Empty Time Sheet Lines

Configurable Access Grants for Request Creators

New Option for Notifications: Prevent any email notifications regarding 
this staffing profile

New Rule Event: Apply on Copy

Improved Search Result in Microsoft Project

PPM Center Accessibility Improvements

Special Command ksc_copy_request Enhancement

Detecting Multicast Routing and Configuration Issues for a Server Cluster

Improved Startup Checks

SQL Debugging for All Product Areas

Accessing Services Exceptions Details

Enabling Debugging On a Per-User Basis

Improved Services Audit Results Page

Accessing Application Exception Details

Identifying Connection Issues

Updating a Microsoft Project Work Plan Hierarchy Integrated with HP 
Project Management
Overview of PPM Center Version 9.12 15



The following integrations are included in PPM Center version 9.12:

Lightweight Single Sign-On Authentication (LW-SSO) Support

SLICK Configuration Tool

CMQC for Quality Center 11.0

Importing New Service Manager Web Service Objects to Enable PPM 
Center Integration with Service Manager

Administration Tools Enhancements

Importing Requests from XML Files

The following certifications are included in PPM Center version 9.12:

Microsoft Windows Server 2008 R1 SP2, Standard and Enterprise Edition 
(both 32- and 64-bit) as PPM Center server platforms

Microsoft Windows Server 2008 R2, Standard and Enterprise Edition 
(64-bit) as PPM Center server platforms

Oracle 11.2.0.2.0 (RAC and Non-RAC) support for all PPM Server 
platforms

HP Service Manager version 9.21 support for PPM Center integrations 
with HP Service Manager (ALM and SM RFC)

HP Quality Center version 11.00 and HP Application Lifecycle 
Management 11.00 support for CMQC solution:

Support for HP Universal CMDB versions 8.06, 9.02, and 9.03 when used 
for impact analysis of PPM Center requests (using ALM) and for service 
portfolio

Support for use of HP Deployment Management Extension for Oracle 
E-Business Suite with Oracle E-Business Suite version 12.1.3 (requires 
patch PPMC_00098 for the Extension)

Support for Microsoft Office Project 2010 
16 Chapter 1



Support for tightening the access to the following packages for public roles 
in Oracle:

o HTTPURITYPE

o UTL_INADDR

o ALL_SOURCE

Microsoft Hyper-V support running Microsoft Windows 2008 SP2 
Enterprise Edition (32-bit) and Red Hat Enterprise Linux AS 4.0 (64-bit) as 
virtualization server platform

64-bit JDK support for 64-bit Microsoft 2008 R2 Enterprise Edition and 
64-bit Red Hat Enterprise Linux AS 5.0, Updates 1 through 6

Documentation Updates

The first page of this release notes document contains the following identifying 
information:

Version number, which indicates the software version. 

Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent 
edition, visit the following URL:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register 
for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html

You will also receive updated or new editions if you subscribe to the 
appropriate product support service. Contact your HP sales representative for 
details.

To view files in PDF format (*.pdf), Adobe Reader must be installed on your system. 
To download Adobe Reader, go to: http://www.adobe.com.
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Installation Notes

This procedure includes steps that are valid for PPM Center version 9.12. To 
install version 9.12:

1. Back up your database.

2. Stop the PPM Server. The Service Pack cannot be installed on an active 
server.

3. Copy the Service Pack file ppm-912-SP2.jar to the <PPM_Home> 
directory. This is the directory where the PPM Server is installed.

4. Change to the <PPM_Home>/bin directory.

5. Start the installation using the following command: 

sh ./kDeploy.sh -i SP2 

6. Follow the on-screen instructions to complete the Service Pack installation.

7. Compile the new JSP files using the following command: 

sh ./kJSPCompiler.sh 

8. Start the PPM Server.

PPM Center versions 9.10 and 9.11 were released before versions 8.03 and 9.12. 
Versions 8.03 and 9.12 include improvements to core functionality that are compatible 
between those versions, but are not supported on the older versions 9.10 and 9.11. 
If PPM Center is running at version 8.03, do not upgrade to and then run at version 
9.10 or 9.11. Instead, upgrade from version 8.03 to version 9.10 temporarily without 
running PPM Center, and then upgrade immediately to version 9.12. 

If you have already deployed the hotfix for QCIM1L39975 (Combined hotfix for 
PPM 9.1-SP1 JMS and Quartz issues), make sure to remove it before you 
proceed to step 2. The PPM Center 9.12 Service Pack file contains all fixes to the 
JMS and Quartz issues as well as additional fixes.

The current release of PPM Center does not support table or tablespace compression 
in Oracle. If you use compressed tables or compressed tablespaces, the upgrade 
scripts will fail.
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Out-of-Sync Actuals Data

The following sections describe what to do if the pre-validation process during 
installation determines that data is not synchronized between the HP Time 
Management and HP Project Management modules or between the HP Time 
Management and HP Demand Management modules.

Data Out of Sync Between HP Time Management and HP Project Management

If, during the installation of PPM Center 9.12, the pre-validation process 
determines that actuals data in the HP Time Management and HP Project 
Management modules are out of sync, an error occurs and you cannot continue 
with the installation.

To resolve the problem: 

1. To tag these data for synchronization, navigate to the                          
<PPM_Home>/deploy/912/SP2/phases/prevalidation directory and 
run the MarkPMTMActualsOutOfSync.sql script.

2. Re-install Service Pack 2.

3. After you successfully install Service Pack 2, navigate to the              
<PPM_Home>/bin directory and run the kPMTMSync.sh script, as follows, 
and redirect the output to a file:

sh ./kPMTMSync.sh -username <username> -password <password>

Data Out of Sync Between HP Time Management and HP Demand Management

During installation of PPM Center 9.12, if the pre-validation process 
determines that actuals data in the HP Time Management and HP Demand 
Management modules are out of sync, an error occurs and you cannot continue 
with the installation.

To resolve the problem:

1. Navigate to the <PPM_Home>/deploy/912/SP2/phases/prevalidation 
directory and run the CorrectDMTMActualsOutOfSync.sql script.

2. After the CorrectDMTMActualsOutOfSync.sql script has run 
successfully, re-install Service Pack 2.
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Post-Installation Preparation to Install Operational Reporting CP1

Operational Reporting functionality was introduced in PPM Center version 
9.10. If you have been using or plan to use Operational Reporting, after you 
upgrade to PPM Center version 9.12 do the following: 

1. HP strongly recommends that you log in to the PPM Center database as a 
DBA and use the following command to flush the shared pool:

alter system flush shared_pool;

2. Install PPM Center 9.12 Operational Reporting CP1. 

For information about Operational Reporting, see the Operational Reporting 
User’s Guide and the Operational Reporting Administrator’s Guide. 

Post-Installation Command for the Purge Empty Time Sheet Lines Report

PPM Center version 9.12 provides you with a new report to purge empty time 
sheet lines. To make this new report available, run the following command in 
the <PPM_Home> directory after the installation:

sh bin/kMigratorImport.sh -username "admin" -password '<admin 
password>' -action import ̈ Cfilename reports/PurgeTSLReport.zip 
-i18n charset -flags NNNNYNYNNNNNNNNNNNN -unescapeUnicode Y

For more information, see New Report: Purge Empty Time Sheet Lines 
on page 78.

Software and Hardware Requirements

Before you install PPM Center version 9.12, make sure that your system meets 
the minimum requirements, as described in the System Requirements and 
Compatibility Matrix, available at the HP Manuals site.
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Regenerating Web Service Stubs for Integrating with HP 
ServiceCenter

If you have integrated your PPM Center deployment with HP ServiceCenter, 
you can modify which fields are available through Web services, but you must 
regenerate the Web service stubs for the integration after installing any PPM 
Center service pack. 

After installing the service pack, regenerate the Web service stubs in the PPM 
Server from the new Web Services Description Language (WSDL) descriptor 
as follows:

1. Navigate to the <PPM_Home>/bin/sdi directory on the PPM Server.

2. Run the script:

sh ./kGeneratePeregrineStub.sh <wsdl-url> <PPM_Server_Name> 

where

<wsdl-url> represents the ServiceCenter WSDL URL for Change 
Management.

<PPM_Server_Name> represents the subdirectory of <PPM_Home>/
server specified during installation as the value for the KINTANA_
SERVER_NAME parameter in the server.conf file. (It is not necessarily 
the actual host name of the server.) When generated, the stubs will be 
placed under this subdirectory.

For example, run the script:

sh ./kGeneratePeregrineStub.sh http://host:12670/
ChangeManagement?wsdl kintana 

The stub configuration might fail if the host is not resolvable by name. To resolve 
the host by name, make an entry in the hosts file for the machine you want to 
connect. See the documentation for your operating system for the location of the 
hosts file.
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PPM Community on HPLN

The HP Project and Portfolio Management Center Community on HP Live 
Network (http://www.hp.com/go/livenetwork) is now live!  The PPM 
Community on HPLN (http://www.hp.com/go/PPM_HPLN) is a virtual 
community for HP Experts, Partners and Customers to collaborate and share 
knowledge, best practices, and add-on content for the PPM product.  You can 
log in to the PPM Community on HPLN to access the latest Content Packs.

Access to HP Live Network is available at no additional cost to all PPM 
customers.  Customers must log in using an HP Passport account. Customers 
without Passport accounts can register for free on HP Live Network.
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2 New Features in PPM Center 9.12
The following new features are included in PPM Center version 9.12:

HP Financial Management

o Expected Start and Expected Finish Shown in Proposal and Project 
Financial Summaries

o Configurable Range of Fiscal Years for Financial Summaries and 
Financial Data Tables

o Options to Display Capital or Operating Costs in Financial Summary 
Graph

o Simplified Presentation of (x $1000) in Financial Summaries and 
Financial Data Tables

o “Forecast and Actuals” Changed to “Costs,” and “Planned” Changed 
to “Forecast”

o Displaying and Editing Data by Year in Financial Summaries and 
Financial Data Tables

o Displaying Line Totals in Financial Summaries and Financial Data 
Tables

o Copying Cost Lines from a PFM Request Financial Summary

o Simpler Procedure to Copy Forecast Data Across a Range of Cells in 
the Same Row

o Capital Expenses in Approved Budgets

o Confirmation for Updating an Approved Budget
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HP Portfolio Management

o Redesigned Configure Portfolio Management Page

o New Columns Available in Subportfolios Tab of Portfolios

o New Columns Available in Programs Tab of Portfolios

o New Columns Available in Proposals/Projects/Assets Tab of Portfolios

o Change to Exporting Portfolios to Microsoft Excel

o New Columns Available in Scenario Content Table

o Ways to Change Appearance of Scenario Content in Scenario 
Comparisons

o Relocated Add Content Button and New Remove Content Button in 
Scenario Comparisons

o New Update Scenarios Button

o Exporting Scenario Content to Microsoft Excel

o Filtering by Portfolio in Analyze Current Portfolio Portlet and Page

o “Budget” Changed to “Projected Cost” in Analyze Current Portfolio 
Portlet and Page

HP Project Management

o Project Tasks Indicate an Exception When User Does Not Specify 
% Complete If Required

o “Planned” Column Changed to “Forecast” in Project Cost Summary 
Portlet

HP Program Management

o New Columns Available in Program Overview Page

o “Planned” Column Changed to “Forecast” in Program Cost Summary 
Portlet

o New Options to Group and Ungroup Programs by Column Values

o Exporting Programs to Microsoft Excel
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HP Time Management

o Identification of Out-of-Sync Actuals Data Upon Upgrade

o Automatic Saving of Time Sheets to Prevent Data Inconsistencies

o Administration of Time Sheet Activities at the Request-Type Level

o Highlighting of Non-Working Days and Holidays on Time Sheets

o Renamed Buttons on Line Details Window

o New Time Sheet Notes Show “(Pending Save)” Until Time Sheet Is 
Saved

o Improved Error Management

o Improvements to My Tasks Portlet and Edit Effort Breakdown Page

HP APM for PPM

Integration with Microsoft Project 2010

Updates to HP Deployment Management Extension for Oracle E-Business 
Suite and HP GL Migrator to Support Oracle E-Business Suite Release 12

HP Demand Management

o New Table Component

o Supported Validations

o New Table Component Layout

o Switching between Original and New Table Component Layouts

o Editing Table Component Directly on Request Pages

o Showing Total of a Table Component Column in Real-time

o Quick Navigation through Table Rows

o Other Changes

o Considerations for Using Rules in Table Component
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HP Financial Management

Refer to Figure 2-1, Figure 2-2, and Figure 2-3 to see where the changes in 
version 9.12, as described in the following sections, were made to financial 
summaries and to the Edit Costs page (formerly the Edit Forecast & Actuals 
page) and Edit Benefits page. 

Figure 2-1. Top part of example financial summary for a lifecycle entity in 
version 9.12
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Figure 2-2. Bottom part of example financial summary for a lifecycle entity in 
version 9.12
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Figure 2-3. Example Edit Costs page in version 9.12

The Edit Benefits page has changes analogous to those in the Edit Costs page.

The following sections are organized in the approximate order that the changes 
are seen in Figure 2-1, Figure 2-2, and Figure 2-3.

Expected Start and Expected Finish Shown in Proposal and Project Financial 
Summaries

In version 9.12, the Expected Start and Expected Finish date fields, if specified, 
are added at the bottom of the Summary section in financial summaries of 
proposals and projects (but not assets). See Figure 2-1. The dates are included 
when the financial summary is exported to Microsoft Excel®, but are not 
included in financial summary snapshots.
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Configurable Range of Fiscal Years for Financial Summaries and Financial 
Data Tables

The tables of costs and benefits in financial summaries, financial data tables, 
and their associated Edit Costs pages and Edit Benefits pages can display 
forecast values or forecast and actual values. Prior to version 9.12, the data 
(where present) was displayed over a fixed time range from up to two fiscal 
years ago to up to five fiscal years in the future. Financial summaries also 
displayed graphical data for one selected fiscal year in that range.

In version 9.12, administrators can configure the earliest and latest fiscal years 
of data to display, up to 20 years ago and up to 20 years in the future, by using 
the Administration Console to specify the new server.conf parameters 
NUMBER_OF_PAST_YEARS_TO_SHOW_ON_FINANCIAL_SUMMARY and        
NUMBER_OF_FUTURE_YEARS_TO_SHOW_ON_FINANCIAL_SUMMARY. The valid 
values range from 0 to 20, and the defaults are 2 and 5 for consistency with the 
previous design. The tables display data over the range of years calculated 
from the values specified in the parameters. 

In the Fiscal Year field, users select one of those years and then graphical data 
is displayed for that year in the Totals by Year section of the financial 
summary. See Figure 2-1.

The same server.conf parameters are applied to snapshots of financial 
summaries, but they are applied relative to the fiscal year each snapshot was 
taken, not relative to the current fiscal year.

Options to Display Capital or Operating Costs in Financial Summary Graph

In version 9.12, the graph in the Totals by Year section of a financial summary 
now includes a new field named Show Costs, with the options All, Capital, and 
Operating. See Figure 2-1. The field appears only if cost capitalization is 
enabled both in the financial summary and by setting the  
COST_CAPITALIZATION_ENABLED server.conf parameter to true. The 
default option is All, which causes the graph to display the same data as in prior 
versions. If the user selects Capital or Operating, the graph and the Forecast 
Cost, Actual Cost, and Approved Budget fields below the graph display only 
capital or operating costs accordingly. Forecast Benefit and Actual Benefit are 
not affected. 
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Simplified Presentation of (x $1000) in Financial Summaries and Financial 
Data Tables

If the BUDGET_IN_WHOLE_DOLLARS server.conf parameter is set to false, 
cost and benefit data in financial summaries and financial data tables is shown 
in thousands of dollars. In other words, the displayed values are to be 
multiplied by 1000. Prior to version 9.12, (x1000) or (x $1,000) was shown at 
the top of the columns for each quarter. 

In version 9.12, (x $1,000) is shown only once per cost or benefits table in a 
financial summary or financial data table, as follows:

After the titles Cost Details and Benefits Details when viewing the financial 
summary or financial data table (see Figure 2-2)

After the title Cost Details on the Edit Costs page (see Figure 2-3)

After the title Benefit Details on the Edit Benefits page (analogous to 
Figure 2-3)

“Forecast and Actuals” Changed to “Costs,” and “Planned” Changed to 
“Forecast” 

To improve consistency within and among windows for financial summaries, 
the term “Forecast and Actual(s)” has been changed to “Cost(s)” as follows:

In the financial summary, the section formerly titled Forecast and Actual 
Details has been renamed Cost Details to more clearly distinguish it from 
the Benefit Details section, which has its own data for forecast and actual 
benefits.

The section now named Cost Details previously displayed either an 
Edit Forecast and Actuals button or an Add Forecast and Actuals button, 
and these buttons have been renamed Edit Costs and Add Costs. 

To improve consistency within and among windows for financial summaries, 
the term “Planned” has been changed to “Forecast” as follows:

The display options (links) formerly labelled Planned Only and Planned 
and Actuals in the Cost Details and Benefits Details sections of the financial 
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summary and on the Edit Costs and Edit Benefits pages have been renamed 
Forecast Only and Forecast and Actuals. 

In the financial summary and the Edit Costs and Edit Benefits pages, all 
column headings and totals formerly labelled Planned have been renamed 
Forecast. 

In the Edit Costs and Edit Benefits pages, the tip about copying data to 
multiple cells began “In the Planned Only view...” and now begins with 
“In the Forecast Only view...”

The column heading Planned has also been changed to Forecast in the 
Project Cost Summary portlet and the Program Cost Summary portlet.

Displaying and Editing Data by Year in Financial Summaries and Financial 
Data Tables

The tables of costs and benefits in financial summaries, in financial data tables, 
and in their associated Edit Costs pages and Edit Benefits pages can display 
forecast values or forecast and actual values. Prior to version 9.12, users could 
choose to display and edit the data (where present) either by quarter or by 
month.

In version 9.12, users can also display and edit the data by year. The tables 
have options that appear as links named Months, Quarters, and Years. See 
Figure 2-2 and Figure 2-3.

On the Edit Costs page and the Edit Benefits page, when a user selects the new 
Years option, the tables display all the fiscal years in the configured range (see 
Configurable Range of Fiscal Years for Financial Summaries and Financial 
Data Tables). The Fiscal Year field (drop-down list) and the Copy from 
Previous Year button are no longer applicable and are not displayed.

Analogous to editing data by quarter, when costs and benefits are edited by 
year they are automatically apportioned equally among the months (and 
therefore among the quarters) in that year, overwriting all prior entries for 
months in that year.
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Displaying Line Totals in Financial Summaries and Financial Data Tables

In financial summaries and financial data tables, version 9.12 adds the Totals 
option to the costs and benefits tables, after the Years option. See Figure 2-2. 
Selecting Totals displays, line by line, the sum of all data for the entities over 
the entire range of years for which they have data, regardless of the range of 
years available to view in the Fiscal Year field of the financial summary.

If a user selects the Forecast Only view option, the associated costs or benefits 
table displays only one Totals column for total forecast values. If a user selects 
the Forecast and Actuals view option, the associated costs or benefits table 
displays one column for total forecast values and one column for total actual 
values.

In version 9.12, line totals are always shown on the Edit Costs page and the 
Edit Benefits page, regardless of whether the user has chosen to display 
Months, Quarters, or Years. See Figure 2-3. The totals are shown in the 
rightmost column in the Forecast Only view or the rightmost two columns in 
the Forecast and Actuals view. If the user displays months or quarters, the 
totals reflect the values for only the year selected in the Fiscal Year field. If the 
user displays years, the totals reflect the sum of the values for all the fiscal 
years in the configured range. The totals are updated dynamically as the user 
edits the displayed months, quarters, or years.

Copying Cost Lines from a PFM Request Financial Summary 

In version 9.12, a new Copy Cost Lines from Another Request button appears 
on the Edit Costs page of financial summaries. See Figure 2-3. This option 
allows users to copy all of the cost lines from the financial summary of one 
PFM request (PFM - Proposal, PFM - Project, or PFM - Asset request type) to 
the open PFM request. Search capability is provided to find the PFM request 
from which lines are to be copied. Cost lines rolled up from a staffing profile to 
the financial summary of the request selected from the search results are not 
copied to the financial summary of the open PFM request.

If the requests use different currencies, users can copy the cost lines but not 
any of their cost data. If the requests use the same currency, an option appears 
that allows users to copy the forecast cost data in the cost lines as well as the 
lines themselves.
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The new button also appears on the Edit Costs page of financial data tables. 
Users can copy cost lines from the financial summary of a selected PFM 
request to the financial data table, but they cannot copy cost lines from any 
other financial data table.

Simpler Procedure to Copy Forecast Data Across a Range of Cells in the Same 
Row

Prior to version 9.12, when viewing forecast (but not forecast and actuals) data 
on the Edit Costs page and the Edit Benefits page, you could edit costs or 
benefits across a range of cells in the same row by:

1. Clicking in the cell with the data value you want to copy.

2. Clicking in the cell at the other end of the range of cells into which the data 
is to be copied.

3. Pressing SHIFT + click. 

In version 9.12, the procedure is simplified as follows:

1. Click in the cell with the data value you want to copy.

2. With the cursor positioned in the cell at the other end of the range of cells 
into which the data is to be copied, press SHIFT + click. 

Capital Expenses in Approved Budgets

In version 9.12, a new Expense Type field appears on the Update Budget page 
accessed from the approved budget of the financial summary, with the options 
Capital and Operating. See Figure 2-4. The field appears only if cost 
capitalization is enabled both in the financial summary and by setting the 
COST_CAPITALIZATION_ENABLED server.conf parameter to true. 
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Figure 2-4. Approved Budget in version 9.12

On the Budget Details page, the Expense Type field is added as a new column 
in the approved budget. Near the top of the page, for the selected Fiscal Year, 
the Total Capital Approved Budget for FY<xxxx> and the Total Operating 
Approved Budget for FY<xxxx> are displayed next to the Total Approved 
Budget for FY<xxxx>. 

Web services can also specify capital expenses for approved budgets. For more 
information, see the Web Services Programmer’s Guide. 

For information about data model changes associated with this enhancement, 
see the Data Model Guide. 

Upon upgrade to version 9.12, all approved budget entries default to Operating. 

To change a budget entry for an editable fiscal year from Operating to Capital, 
create an offsetting negative budget entry with Expense Type set to Operating 
and create a budget entry in the same amount with Expense Type set to Capital. 

Confirmation for Updating an Approved Budget

In version 9.12, when updating an approved budget, a confirmation dialog is 
presented when the user clicks Done to allow the user to confirm or cancel the 
update. After confirmation, an update to an approved budget cannot be 
modified or deleted. Also, the on-screen text clarifies that the approved budget 
for the selected year will be increased or decreased by the amount entered.
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HP Portfolio Management

Redesigned Configure Portfolio Management Page

The Configure Portfolio Management page has new functionality and it has 
been renamed as the Configure Portfolio and Scenario Comparison Options 
page accordingly. In addition, the menu option has been changed from 
Open > Administration > Portfolio Management > 
Configure Portfolio Management to 
Open > Administration > Portfolio Management > 
Configure Portfolio and Scenario Comparison Options. 

The middle section of the page, titled Scenario Comparison Categorization 
Preferences, is unchanged in version 9.12, but the other sections of the page 
are changed as described in the following sections.
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Columns on Portfolio Proposals/Projects/Assets Tabs and in Scenario Comparisons

In version 9.12, the section previously titled Configure Columns for Portfolio 
Proposals/Projects/Assets Tab has been renamed Columns on Portfolio 
Proposals/Projects/Assets Tabs and in Scenario Comparisons, and it has been 
relocated from the bottom of the page to the top. 

The functionality of this section of the Configure Portfolio Management page 
has been extended to apply to scenario comparisons, and it continues to apply 
to portfolios. Specifically, in version 9.12 when an administrator selects 
columns from the set of Available Columns and moves them to the set of 
Selected Columns, users can add those columns to the Scenario Content table 
of any scenario comparison. (As in prior versions, users can also add the 
Selected Columns to the Proposals/Projects/Assets tab of any portfolio.)

As in prior versions of PPM Center, administrators can enable (select) up to 20 
of the available columns, which are determined from the combination of all the 
request fields in the PFM - Proposal, PFM - Project, and PFM - Asset request 
types. 

For detailed administrative information about selecting columns that users can 
then display, see the HP Portfolio Management Configuration Guide. 

As in prior versions of PPM Center, if the administrator selects Nominal Return    
and/or Net Present Value among the fields users can add to the                 
Proposals/Projects/Assets tab of a portfolio and a user does add them, those fields 
will appear on the Proposals/Projects/Assets tab only if the user sets the Fiscal 
Year field on the tab to Total to display the sum of all years.

If any of the Nominal return, Net Present Value, and Custom Field Value options 
were selected in the Scenario Comparison Tracking Preferences section on the 
Configure Portfolio Management page prior to version 9.12, the administrator must 
manually select the options as columns in the Columns on Portfolio         
Proposals/Projects/Assets Tabs and in Scenario Comparisons section for them 
to continue to be displayable in scenario comparisons in version 9.12. Users can then 
choose to display those columns as desired.
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Metrics Shown on Current Portfolio 

The section previously titled Scenario Comparison Tracking Preferences has 
been renamed Metrics Shown on Current Portfolio, and it has been relocated 
from the top of the page to the bottom.

In version 9.12, administrators can select the Nominal return, Net Present 
Value, and Custom Field Value options (checkboxes) to make them available as 
filters with ranges of values and as the horizontal or vertical axis in the bubble 
charts of the Analyze Current Portfolio portlet (formerly the Current Portfolio 
Map portlet) and the Analyze Current Portfolio page. 

In prior versions of PPM Center, administrators could select the options 
Nominal return, Net Present Value, and Custom Field Value for display as 
scenario comparison “tracking preferences.” In version 9.12, the display of 
these metrics in scenario comparisons is configured as described in Columns 
on Portfolio Proposals/Projects/Assets Tabs and in Scenario Comparisons. 
See that section for important information about upgrade consequences in 
regard to displaying these fields. 

x

As in prior versions of PPM Center, the set of Available Columns includes all of the 
fields in the PFM - Proposal, PFM - Project, and PFM - Asset request types.          
PPM Center allows the same field to have different validation types in different 
request types. In this case, in prior versions, the field was not included among the 
Available Columns. 
In version 9.12, the field is included among the Available Columns. In a scenario 
comparison or in the Proposals/Projects/Assets tab of a portfolio, data in such a 
displayed column might not be formatted consistently or as expected.
The validation types for the field used in multiple request types do not have to be 
identical, but they should be compatible. For example, displaying various types of text 
fields in a column might be acceptable. However, if the inconsistent formatting of the 
data is unacceptable, the administrator should check the field definitions in the 
request types and establish unique fields for them that each use appropriate 
validations so that they will appear as separate columns.
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New Columns Available in Subportfolios Tab of Portfolios

In version 9.12, if the COST_CAPITALIZATION_ENABLED server.conf 
parameter is set to true to enable separate tracking of capital and operating 
costs, the following new columns are available to all users to add to the 
Subportfolios tab of any portfolio: 

Approved Capital Budget 

Approved Operating Budget 

Forecast Capital Cost 

Forecast Operating Cost 

Actual Capital Cost 

Actual Operating Cost 

New Columns Available in Programs Tab of Portfolios

In version 9.12, if the COST_CAPITALIZATION_ENABLED server.conf 
parameter is set to true to enable separate tracking of capital and operating 
costs, the following new columns are available to all users to add to the 
Programs tab of any portfolio: 

Approved Capital Budget 

Approved Operating Budget 

Forecast Capital Cost 

Forecast Operating Cost 

Actual Capital Cost 

Actual Operating Cost 

If a particular program in a portfolio does not have capitalization enabled in its 
financial summary settings, its forecast and actual costs are shown entirely as 
operating costs and its capital costs are shown as 0.
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New Columns Available in Proposals/Projects/Assets Tab of Portfolios

In version 9.12, if the COST_CAPITALIZATION_ENABLED server.conf 
parameter is set to true to enable separate tracking of capital and operating 
costs, the following new columns are available to all users to add to the 
Proposals/Projects/Assets tab of any portfolio: 

Approved Capital Budget 

Approved Operating Budget 

Forecast Capital Cost 

Forecast Operating Cost 

Actual Capital Cost 

Actual Operating Cost 

If a particular proposal, project, or asset in a portfolio does not have 
capitalization enabled in its financial summary settings, its forecast and actual 
costs are shown entirely as operating costs and its capital costs are shown as 0.

In addition, the following column names have been changed:

Total Cost is renamed Projected Cost. 

Total Benefit is renamed Projected Benefit. 

As with Total Cost and Total Benefit in prior versions, Projected Cost and 
Projected Benefit are available only if the Fiscal Year is set to Total so that all 
years are included. They are calculated as the sum of the following:

For each previous month, actual values where reported (that is, where not 
blank or zero), otherwise forecast values

For the current month, the higher of the forecast value and (if reported) 
the actual value

For each future month, the forecast values

For information about adding columns to the Proposals/Projects/Assets tab of 
a portfolio, see the HP Portfolio Management User’s Guide or the analogous 
capability added for version 9.12 for scenario comparisons, as described in 
Ways to Change Appearance of Scenario Content in Scenario Comparisons 
on page 41.
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Change to Exporting Portfolios to Microsoft Excel

Prior to version 9.12, when a user exported a portfolio to Microsoft Excel, all 
of the available columns on all of the tabs were exported in a pre-determined 
order, whether the columns were displayed or not. 

In version 9.12, only the columns selected for display are exported to Excel, in 
the same order as they are displayed. In other words, the Excel file reflects any 
changes a user has made to the columns selected for display and to the column 
layout. 

New Columns Available in Scenario Content Table

Version 9.12 introduces new columns that all users can add to the scenario 
content table in any particular scenario comparison. Some of the new columns 
are available only if the COST_CAPITALIZATION_ENABLED server.conf 
parameter is set to true to enable separate tracking of capital and operating 
costs, as indicated in the following list of the new columns:

Approved Budget 

Approved Capital Budget (if cost capitalization is enabled)

Approved Operating Budget (if cost capitalization is enabled)

Forecast Cost 

Forecast Capital Cost (if cost capitalization is enabled)

Forecast Operating Cost (if cost capitalization is enabled)

Actual Cost 

Actual Capital Cost (if cost capitalization is enabled)

Actual Operating Cost (if cost capitalization is enabled)

Forecast Benefit 

Actual Benefit 

In addition, the following column names have been changed:

NPV is renamed Net Present Value. 

Custom Value is renamed Custom Field Value. 
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Total Cost is renamed Projected Cost. 

Total Benefit is renamed Projected Benefit. 

Projected Cost and Projected Benefit are calculated as the sum of the 
following:

For each previous month, actual values where reported (that is, where not 
blank or zero), otherwise forecast values

For the current month, the higher of the forecast value and (if reported) 
the actual value

For each future month, the forecast values

For information about adding columns to the scenario content table, see Ways 
to Change Appearance of Scenario Content in Scenario Comparisons.

Ways to Change Appearance of Scenario Content in Scenario Comparisons

In version 9.12, users can change the Scenario Content table in scenario 
comparisons in the following ways (similar to existing functionality for 
portfolios), and the changes are retained after they log out and log back in to 
PPM Center:

To rearrange columns, click and drag a column heading to the desired 
position.

To resize a column, click and drag the dividing line between its column 
heading and the adjacent column heading.

To hide a table column, right-click any column heading, select Columns, 
and then click (deselect) the name of the column to be hidden.

To display a column that is not displayed, right-click any column heading, 
select Columns, and then click (select) the name of the column to be 
displayed.

For the following options, instead of clicking or right-clicking a column heading as 
described, users can click the drop-down arrow that appears at the right of any 
column heading when they move the mouse there. 
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To base the sort order of the rows on the values in a column, click that 
column heading, or right-click in the column heading and click Sort 
Ascending or Sort Descending. 

Right-click a column heading and click Freeze Column "<column name>" 
to:

o Move that column as far to the left as possible but to the right of any 
other previously frozen columns

o Prevent that column from being moved by clicking and dragging its 
heading

o Freeze the width of that column when horizontal scrolling is used for 
other columns 

Once a column is frozen, the user can right-click the column heading and 
click Unfreeze Column "<column name>", which moves the column to the 
immediate right of any other frozen columns.

Relocated Add Content Button and New Remove Content Button in Scenario 
Comparisons

In scenario comparisons, the Add Content button has been moved to the banner 
in the Scenario Content section, from its former location at the bottom left of 
the scenario content list. Also, a Remove Content button has been added to the 
banner, and it becomes available when one or more items in the content list are 
selected.

New Update Scenarios Button

A new Update Scenarios button appears in the banner in the Scenario Content 
section. Clicking this button saves any changes the user has made to the 
selection of items to include or exclude from any scenarios, and it updates the 
graphs on all the tabs above the Scenario Content section accordingly. Clicking 
this button does not save any changes the user made to the basic information 
fields above the graphs, such as Comparison Name and Description. 
42 Chapter 2



Exporting Scenario Content to Microsoft Excel

An Export to Excel link has been added at the upper left of the Scenario 
Content section. Clicking this link exports to Microsoft Excel the basic 
information fields (at the top of the scenario comparison) and the displayed 
columns of the scenario content table (including indication of any dependency 
violations). 

Only the displayed columns are exported to Excel, in the order they are 
displayed. In other words, the Excel file reflects any changes a user has made 
to the columns selected for display and to the column layout. 

The View Content List link at the bottom of the Scenario Content section has 
been removed. The content list that was displayed by clicking this link had an 
Export to PDF link that is superseded by the Export to Excel link.

Filtering by Portfolio in Analyze Current Portfolio Portlet and Page 

On the Analyze Current Portfolio portlet (formerly the Current Portfolio Map 
portlet) and the Analyze Current Portfolio page, a new filter has been added to 
select the portfolios to display in the bubble chart. The new filter field is named 
Include items from these portfolios (including subportfolios) in graph. 

Users can select one or more portfolios from the associated Selected portfolios 
auto-complete field. In the auto-complete, portfolio names, parent portfolio 
names (where applicable), and portfolio managers are displayed to assist the 
user with selection.

The auto-complete automatically excludes portfolios that already have any of 
their content (proposals, projects, assets, or subportfolios) in the bubble chart. 
In addition, if a user tries to simultaneously add both a portfolio and any of that 
portfolio’s content where none had been added to the bubble chart previously, 
only the portfolio is added as a bubble. In these ways, the bubble chart never 
represents duplicate content among its bubbles.
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“Budget” Changed to “Projected Cost” in Analyze Current Portfolio Portlet and 
Page 

On the Analyze Current Portfolio portlet (formerly the Current Portfolio Map 
portlet) and the Analyze Current Portfolio page, the options formerly labelled 
Budget have been renamed Projected Cost for the following fields:

Horizontal Axis 

Vertical Axis 

Size of bubble indicates 

Also, the field name Budget total greater than ... and less than ... has been 
changed to Projected Cost total greater than ... and less than ... 

Projected cost is the sum of the following:

For prior periods, actual costs where reported (that is, where not blank or 
zero), otherwise forecast costs

For the current period, the higher of forecast costs and (if reported) 
actual costs

For future periods, forecast costs
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HP Project Management

Project Tasks Indicate an Exception When User Does Not Specify % Complete 
If Required

In version 9.12, the Exceptions / Warnings tab on the Task Details page shows 
an exception indicating that some resources on a task have not entered 
% Complete if both of the following conditions are met:

Require resources to enter % Complete along with actual effort option is 
selected on the project’s Cost and Effort policy. 

A user logs and saves time on a time sheet (or elsewhere) for the task but 
leaves % Complete as 0.

“Planned” Column Changed to “Forecast” in Project Cost Summary Portlet

For consistency with other changes in PPM Center, the column heading 
Planned has been changed to Forecast in the Project Cost Summary portlet.

The exception appears on the Task Details page only after the Exception Rule 
Service runs. For this type of exception, the service runs according to the setting of 
the EXCEPTION_ENGINE_WAKE_UP_TIME server.conf parameter (once a day at 
1:00 a.m. by default). For more information, see the Installation and Administration 
Guide. 
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HP Program Management

New Columns Available in Program Overview Page

In version 9.12, the following new columns are available to all users to add to 
programs listed on the Program Overview page:

Forecast Benefit 

Actual Benefit 

In version 9.12, if the COST_CAPITALIZATION_ENABLED server.conf 
parameter is set to true and if the financial summary settings for the program 
also enable separate tracking of capital and operating costs, the following 
columns are available to all users to add to the Program Overview page: 

Approved Budget (subordinate to Capital Cost in the list of selectable 
columns)

Approved Budget (subordinate to Operating Cost in the list of selectable 
columns)

On the other hand, if the COST_CAPITALIZATION_ENABLED server.conf 
parameter is set to false or if the financial summary settings for the program 
disable separate tracking of capital and operating costs, the following column 
is available to all users to add to the Program Overview page:

Approved Budget 

In addition, the following column names have been changed on the Program 
Overview page:

In the Program Costs section, Planned is renamed Forecast. 

In the Content section:

o Planned Labor is renamed Forecast Labor. 

o Planned Non-Labor is renamed Forecast Non-Labor. 

o Planned Total is renamed Forecast Total. 
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“Planned” Column Changed to “Forecast” in Program Cost Summary Portlet

For consistency with other changes in programs, the column heading Planned 
has been changed to Forecast in the Program Cost Summary portlet.

New Options to Group and Ungroup Programs by Column Values

In the Content section of the Program Overview page, users can organize the 
rows by grouping them under headings that match the various values in any 
particular column. To do so, users right-click in the column heading for the 
column with the values that are to become groupings, and then click 
Group by <column name>. 

After the groupings (headings) are established, an additional Ungroup option 
appears when users right-click any column. Clicking Ungroup removes the 
headings. 

Exporting Programs to Microsoft Excel

Prior to version 9.12, when a user exported a program to Microsoft Excel, all 
of the available columns in the Content section were exported in a 
pre-determined order, whether they were displayed or not. 

In version 9.12, when a user clicks the Export to Excel link at the upper right of 
the Program Overview page, only the displayed columns in the Content section 
are exported to Excel, in the order they are displayed. In other words, the Excel 
file reflects any changes a user has made to the columns selected for display 
and to the column layout. 
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HP Time Management

Identification of Out-of-Sync Actuals Data Upon Upgrade

The pre-validation process for upgrade to version 9.12 determines whether 
actuals data in HP Time Management and HP Project Management are out of 
sync and whether actuals data in HP Time Management and HP Demand 
Management are out of sync. For more information, see Out-of-Sync Actuals 
Data on page 19.

Automatic Saving of Time Sheets to Prevent Data Inconsistencies

Some aspects of time sheet operation have been changed in version 9.12 to 
improve the user experience and prevent data inconsistencies within PPM 
Center. Users can save their time sheet data by “explicitly” clicking Save or 
Save & Submit. In addition, in version 9.12, time sheets are automatically 
(“implicitly”) saved to the database when users do any of the following:

Add a new line (work item) to a time sheet

Remove a line from a time sheet (whether or not the line has data) 

Save any line details

Group or ungroup the work items on the time sheet

If users take any of these actions, then any valid time entries (“actuals”) they 
have previously typed in a time sheet but not yet explicitly saved are 
automatically saved to the database.

In addition, when users open the Effort Breakdown window from the My 
Tasks portlet, enter actuals, and click Save, the actuals are saved to the 
database immediately. Prior to version 9.12, the Save button was named Done 
and clicking Done did not save the effort breakdown actuals to the database. 
For more information, see Improvements to My Tasks Portlet and Edit Effort 
Breakdown Page on page 55.
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“Automatic Saving of Time Sheets” Dialog for Users (Displayed Once)

In version 9.12, the first time each user opens any time sheet, a message is 
displayed describing the implicit saving of the time sheet. After the message is 
displayed to a a user once, it is not displayed to that user again for any time 
sheet. 

However, for instances of PPM Center that support multiple languages, the 
message is displayed only to users who select English when they log in.

Administrators can prevent this message from ever appearing for any user by 
using the Administration Console to change the new                                     
TM_ENABLE_SHOW_WHATS_NEW server.conf parameter from true to false. 

Administration of Time Sheet Activities at the Request-Type Level

In version 9.12, as described in the following sections, administrators can 
control whether users must specify activities for requests of particular request 
types when they add those requests to their time sheets. Administrators can 
specify which activities are available to users on a request-type basis, and can 
specify a default activity. Implications for copying time sheets are also 
discussed.

Requiring Users to Specify Activities for Requests of Particular Request Types

In time sheet policies, administrators can already require users to specify 
activities for all requests on their time sheets. In version 9.12, administrators 
can instead require users to specify activities on time sheet lines for requests of 
particular request types if the following prerequisites are met:

An administrator has enabled the capability by setting the new                
TM_ENABLE_REQ_ACTIVITY_CONTROLS server.conf parameter to true 
(most conveniently set by using the Administration Console). The default 
setting is false. 

In the PPM Workbench, on the Resources tab of the request type, the     
Use Time Management to track actuals option is selected. 

To enable the ability to require users to specify activities for a particular 
request type:
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1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Open Workbench. 

The PPM Workbench opens.

3. From the shortcut bar, select Demand Mgmt > Request Types. 

4. Click List to list the request types.

5. Select the request type of interest and click Open. 

6. Click the Resources tab. 

7. Make sure the Use Time Management to track actuals option (checkbox) is 
selected.

The bottom left side of the Resources tab has the options related to 
requiring activities. In the following figure, options have been chosen that 
enable all the buttons and fields described in the following step and the 
section Specifying Which Activities Are Available to Users and Defaults at 
the Request-Type Level on page 51.
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8. Select the Activity is required for time logged against requests (checkbox) 
option.

Users are then required to specify activities for requests of this type before 
they can submit their time sheets. An error message is displayed if they do 
not do so. 

Specifying Which Activities Are Available to Users and Defaults at the Request-Type 
Level

When users are required to specify activities on time sheet lines for requests of 
a particular type as described in Requiring Users to Specify Activities for 
Requests of Particular Request Types, administrators can control which 
activities are available to users. 

On the Resources tab of a request type in the PPM Workbench, when the 
Activity is required for time logged against requests option (checkbox) is 
selected, subordinate options become available. By default Allow all activities 
is selected, but administrators can select Allow specific activities and use the 
Add and Remove buttons to select specific activities. Then, on time sheets 
users can add only those specific activities to requests of that request type. 

Administrators can optionally specify the Default Value field for the activity, 
whether all activities or only specific activities are allowed. If only specific 
activities are allowed, the values in the auto-complete for the Default Value 
field are limited to those specific activities. If the Default Value field is 
specified, that activity appears as the default for all requests of that request 

On the Activities tab of time sheet policies in the PPM Workbench, administrators 
can require that users specify activities on time sheets for requests of all types, and 
that setting takes precedence. That is, if the time sheet policy requires entry of activi-
ties for requests, users must enter activities for all requests in order to submit their 
time sheets, regardless of the setting of the new Activity is required for time logged 
against requests option in any request type. 
On the other hand, if a time sheet policy does not require that users specify activities 
for requests on their time sheets, selecting the Activity is required for time logged 
against requests option in the request type requires all users to enter activities on 
time sheets for that request type.
In both cases described above, only activities that are enabled and configured to use 
for requests (on the Create Activity or Edit Activity page) are available to users to add 
to requests on their time sheets.
New Features in PPM Center 9.12 51



type on all time sheets for all users. Users can still click Line Details on time 
sheets to edit the activities on their time sheet lines as usual.

Copying Requests with Disallowed Activities to New Time Sheets

A user can copy an existing time sheet or, if the                                             
TM_DISABLE_INCLUDING_LAST_TS_ITEMS server.conf parameter is set to 
false, a user can create a new time sheet that includes items from his or her 
previous time sheet. 

Assuming the TM_ENABLE_REQ_ACTIVITY_CONTROLS server.conf parameter 
is set to true, consider the following sequence of events:

1. A time sheet is created with a request line that includes one or more 
specifically allowed activities. (Multiple activities for a time sheet line 
appear in separate rows in a time sheet.)

2. Some of those activities are later removed from the set of allowed activities 
(that is, they are disallowed) on the associated request type.

3. A user copies the time sheet.

In this scenario, depending on the activities, the request line is copied to the 
new time sheet with or without activities as follows:

When the existing time sheet includes a request line with one or more 
activities and all of those activities were later disallowed, no activity is 
copied to the request line on the new time sheet, that is, the activity for the 
copied line is blank.

At the time a user adds an activity to a time sheet line, HP Time Management displays 
the available activities as they are currently configured on the Resources tab of the 
request type. If that configuration has changed since the user last added activities to 
any time sheet, the user sees the new set of activities. If an activity a user previously 
selected for a request on a time sheet has since been removed from the set of allowed 
specific activities on the Resources tab, that activity can no longer be added to any 
request of that type, but it remains on the time sheet and does not cause an error 
when the time sheet is saved or submitted.
In any case, only activities that are enabled and configured to use for requests (on the 
Create Activity or Edit Activity page) are available to configure on the Resources tab 
of request types so that users can then add them to requests on their time sheets.
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When the existing time sheet includes a request line that has multiple 
activities and some but not all of those activities were later disallowed, the 
copied request line on the new time sheet includes separate rows for each 
of the activities that remain allowed.

If the TM_ENABLE_REQ_ACTIVITY_CONTROLS server.conf parameter is set to 
false, all activities are copied to the lines in the new time sheet.

Highlighting of Non-Working Days and Holidays on Time Sheets

For time sheets on which time is logged on a daily basis, the columns for 
non-working days and holidays can be highlighted in color in version 9.12. 
Holidays reflect the user’s regional calendar. By default, this option is not 
enabled. To enable it, an administrator must set the new                  
HIGHLIGHT_NONWORKING_DAYS_IN_TIMESHEET server.conf parameter to 
true (most conveniently set by using the Administration Console).

Renamed Buttons on Line Details Window

The Line Details window, which has the Charge Codes/Activities,      
Approvals/Transactions Details, Notes, and User Data tabs, had Apply, OK, and 
Cancel buttons in prior versions of PPM Center. In version 9.12, the window 
has more appropriately named buttons—Save and Cancel. 

New Time Sheet Notes Show “(Pending Save)” Until Time Sheet Is Saved

In version 9.12, when a user adds a note to a time sheet, the time stamp column 
for Notes shows (Pending Save) for that note until the user saves the time sheet, 
either explicitly by clicking Save or Save & Submit, or implicitly as described 
in Automatic Saving of Time Sheets to Prevent Data Inconsistencies 
on page 48. When the user saves the time sheet, the time stamp for the note is 
updated to that time.
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Improved Error Management

As in prior versions of PPM Center, on time sheets users can specify and try to 
save or submit actuals that cause errors such as:

Time sheet policy violations

Invalid data values such as:

o Values that would result in negative total actual effort for a project, a 
task, or a request, when summed across the user’s time sheets. 

o Values for % Complete that are not in the range 0–100.

o Negative values for Estimated Remaining Effort. 

o Actuals for a task for which the user has previously entered time in   
HP Project Management—any particular user can use only time sheets 
or only HP Project Management to log time against any particular task.

In these cases, version 9.12 introduces the following changes:

The time sheet page is not reloaded on the screen when the errors occur, so 
users see faster presentation of error messages. 

Error messages regarding data values are presented separately from error 
messages for time sheet policy violations. Users must correct the data value 
errors before the policy violation messages are displayed. (As in prior 
versions of PPM Center, policy violations are shown only when users 
submit their time sheets.) 

If a project requires users to enter % Complete and a user has not done so, 
the requirement is indicated on the time sheet only when users submit the 
time sheet, not when they just save it.
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Improvements to My Tasks Portlet and Edit Effort Breakdown Page 

Prior to version 9.12, to log and save time from the My Tasks portlet, users 
opened the Effort Breakdown window, logged time, clicked Done to return to 
the portlet, and clicked Save on the portlet.

In version 9.12, the Done button on the Effort Breakdown window has been 
renamed Save, and clicking it saves the updates directly to the database, 
calculates % Complete and Estimated Remaining Effort for tasks and projects, 
and then returns the user to the My Tasks portlet.

In addition, from the My Tasks portlet, if a user selects a new time sheet in the 
Use Time Sheet field and clicks Edit Effort Breakdown or any value in the 
Actual Effort (hrs) column, the Effort Breakdown window opens and the time 
sheet is automatically created for the user. Prior to version 9.12, the time sheet 
was not automatically created until the user clicked Done on the Effort 
Breakdown window and Save on the My Tasks portlet.

HP APM for PPM

HP APM for PPM (HP APM) is a new module that runs on top of PPM Center 
version 9.12. Two new licenses for HP APM are available with PPM Center 
version 9.12: Application Portfolio Analyst and Application Portfolio User. 
However, these HP APM licenses must be purchased separately before they 
can be assigned to users. For more information, contact your HP sales 
representative or go to http://www.hp.com/go/appportfoliomgmt.

Integration with Microsoft Project 2010

The Plug-in for PPM is integrated with Microsoft Project 2010. While the 
functionality of the Plug-in for PPM remains the same, you may need to adapt 
to some new features in Microsoft Project 2010.

The new features in Microsoft Project 2010 that affect how the Plug-in for 
PPM integrates with it include: task creation mode and the user interface.
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Client-Side Requirements

The following software is required on the client:

Microsoft Project 2010

Microsoft .NET Framework version 3.5 or later

Visual Studio Tools for Office (VSTO) version 3.0 (must be installed by a 
system administrator)

Microsoft Office 2010 Primary Interop Assemblies (PIA) for Microsoft 
Project 2010 (must be installed by a system administrator)

Task Creation Mode

In Microsoft Project 2010, users can create tasks in two different modes: Auto 
Scheduled or Manually Scheduled. To successfully integrate tasks between 
Microsoft Project 2010 and PPM Center, all Microsoft Project 2010 tasks must 
be created in Auto Scheduled mode.

If a task is created in Auto Scheduled mode, data in task date and duration 
fields are validated by Microsoft Project and all tasks can be successfully 
integrated with PPM Center.

If a task is created in Manually Scheduled mode, data in task date and duration 
fields are not validated by Microsoft Project. PPM Center considers this data to 
be invalid and does not integrate the data. To successfully integrate all task 
data, the task must be changed to Auto Scheduled mode.

To change a task's mode, update the Task Mode field.

To set the default task creation mode for new tasks that are added to an existing 
project, click on the New Tasks menu at the bottom of the work plan window 
and select Auto Scheduled. 

To set the default task creation mode for new projects, go to the File tab and 
select Options. Select Schedule and then set the New tasks created field to Auto 
Scheduled.
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User Interface

The user interface has been changed in Microsoft Project 2010. Instead of the 
initial drop-down menus, the interface uses tabbed sections.

The location of the Plug-in for PPM menus has changed and can be found as 
follows:

The HP PPM Center menu is located in the Add-Ins tabbed area.

The custom Changed Actuals tool can be found in the View tab and by 
selecting the Tables drop-down menu.

The custom filters can be found in the View tab and by selecting the Filter 
drop-down menu.

Updates to HP Deployment Management Extension for Oracle 
E-Business Suite and HP GL Migrator to Support Oracle 
E-Business Suite Release 12

A patch to the HP Deployment Management Extension for Oracle E-Business 
Suite and a new version of HP GL Migrator provide support for Oracle 
E-Business Suite Release 12.

For detailed information about supportability of the new HP GL Migrator 
version 9.12 with various releases of Oracle E-Business Suite and with various 
versions of PPM Center and HP Object Migrator, see the latest System 
Requirements and Compatibility Matrix for PPM Center version 9.1x.

For detailed information about HP GL Migrator version 9.12, including 
installation and upgrade procedures, see the HP GL Migrator Guide for 
version 9.12.

A specific product installation or upgrade sequence must be followed when 
using PPM Center version 9.1x, as described in Product Installation Sequence 
with PPM Center Version 9.1x on page 59.
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FSG Functionality Provided in HP GL Migrator Version 9.12

The Migrate FSG Row/Col Sets program migrates user selected FSG Row/Col 
Sets from a source database to a destination database. The migration is 
accompanied by an output file displaying all migrated entities along with the 
status or error codes associated with each record in migration. This program 
was previously included with HP Object Migrator version 7.5. For more 
information, see the HP GL Migrator Guide for version 9.12.

New Object Types Provided in Extension Patch 

As described in Product Installation Sequence with PPM Center Version 9.1x, 
a patch for the HP Deployment Management Extension for Oracle E-Business 
Suite must be installed. The patch installs the following new PPM Center 
object types that must be used to support migrations for Oracle E-Business 
Suite Release 12:

GL 912 :Budget Organisation

GL 912 :Consolidations

GL 912 :Cross Validation Rules

GL 912 :FSG Row/Col Sets

GL 912 :Journal Categories

GL 912 :Journal Entry Sources

GL 912 :Mass Allocation/Budget

GL 912 :Summary Templates

These new object types are analogous to existing object types that do not have 
the “GL 912 :” prefix, except that the GL 912 :FSG Row/Col Sets object type 
is provided in HP GL Migrator version 9.12 for the first time (see FSG 
Functionality Provided in HP GL Migrator Version 9.12).

The new object types are backward compatible with Oracle E-Business Suite 
Release 11i, and installing them does not overwrite any existing object types.
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Product Installation Sequence with PPM Center Version 9.1x

To prepare to deploy HP GL Migrator version 9.12 and associated 
prerequisities, download patch PPMC_00098 for HP Deployment 
Management Extension for Oracle E-Business Suite, which bundles the 
following files:

The following zip files for HP GL Migrator version 9.12:

o CLGM_912.zip 

o CLGM_UPG_912.zip 

The following zip files for HP Object Migrator version 7.5:

o CLM_75.zip 

o CLM_75_tar.gz 

o CLM_UPG75.zip 

o CLM_UPG75_tar.gz 

The following jar file for the HP Deployment Management Extension for 
Oracle E-Business Suite patch:

ppm-910-OracleApps912.jar 

The following jar file for the HP Deployment Management Extension for 
Oracle Technology version 9.10:

ppm-910-OracleTech.jar 

Starting with PPM Center version 9.1x (9.10 with or without an associated 
service pack) as a basis, the following product installations or upgrades must 
be performed in the following sequence to support using the HP Deployment 
Management Extension for Oracle E-Business Suite and HP GL Migrator with 
Oracle E-Business Suite Release 12:

1. HP Object Migrator version 7.5, if not already installed. 

See the HP Object Migrator Guide for version 7.5.

2. HP GL Migrator version 9.12. 

See the HP GL Migrator Guide for version 9.12.
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3. PPM Center version 9.1x, if not already installed. 

See the Installation and Administration Guide for version 9.10 and service 
pack Release Notes as appropriate.

4. HP Deployment Management Extension for Oracle E-Business Suite 
version 9.10, if not already installed. 

See the HP Deployment Management Extension for Oracle E-Business 
Suite Guide for version 9.10.

5. HP Deployment Management Extension for Oracle E-Business Suite patch 
PPMC_00098 to allow the HP Deployment Management Extension for 
Oracle E-Business Suite version 9.10 and HP GL Migrator version 9.12 to 
support Oracle E-Business Suite Release 12.

The HP Deployment Management Extension for Oracle Technology can be 
installed at any time after PPM Center version 9.1x is installed.

For this patch, you must use the following installation command:

sh kDeploy.sh -i OracleApps912 
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HP Demand Management

New Table Component

In PPM Center version 9.12, table component is implemented using a new way 
to improve usability.

In addition to seamless support for the existing functionalities, the new table 
component also offers the following new functionalities:

New Table Component Layout

Switching between Original and New Table Component Layouts

Editing Table Component Directly on Request Pages

o Resizing table columns

o In-line row adding and In-line row deleting

o Copying and pasting row(s)

o Moving row(s) up or down

o In-line row editing

o Warning prompt when leaving current page without saving the 
modified table component

Showing Total of a Table Component Column in Real-time

Quick Navigation through Table Rows

The new table component is supported on the following pages:

Create New Request page

Request Details page

Look-ahead page
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Supported Validations

Table component fields support validations of the following component types:

Text field

Drop-down list

Radio buttons (yes/no)

Auto-complete list 

Text area

Date field (short, medium, and long)

Web Address (URL)

Password field

Link

For more information about validations, see the Commands, Tokens, and 
Validations Guide and Reference.

Special Note for Link and Web Address (URL) Component Types

When you use <!--HTML--> for Link and Web Address (URL) component 
types, make sure not to use <a></a> tags as they are not allowed. Link and Web 
Address (URL) components are <a></a> tags in Web UI, you cannot embed 
<a></a> tags within <a></a> tags. 

<!--HTML--> is designed for advanced users and you should use tags that 
affects font and color only. For example, the script below is valid:

<!--HTML--><font color='red'>PPM</font> 
<!--HTML--><b>PPM</b> 

The script below is not allowed for Link and URL:

<!--HTML--><a href='http://hp.com'>HP</a>

Note that link description is also not allowed.
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New Table Component Layout

The new table component looks similar to the follows when you have just 
created a new request:

You can click Edit to switch to Edit mode directly, and proceed to edit the table 
by adding rows, filling in data, and performing other operations.

The new table component in Edit mode:

The new table component in View mode:
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Switching between Original and New Table Component Layouts

With PPM Center version 9.12, the new table component layout is applied by 
default. However, you may choose to switch back to the original table 
component layout by configuring the newly introduced server.conf 
parameter listed in Table 2-1.

Editing Table Component Directly on Request Pages

With the new table component implemented, you can edit the table component 
directly on the following pages:

Create New Request page

Request Details page

Request look-ahead page

To enter Edit mode, simply click Edit in the table component. 

Note that the Edit button is only available to users with edit access grant to 
requests or table component.

For detailed information about access grants, see the Security Model Guide and 
Reference.

Resizing table columns

You can resize width of table columns in both View mode and Edit mode by 
dragging column borders in the table. 

When you resize table column width, the table width is also resized 
automatically.

Table 2-1. New server.conf parameter introduced 

Parameter name Description, Usage Default and 
Valid Values

TABLE_COMP_
USE_LEGACY

Determines whether the original layout of 
the table component is used. If set to true, 
the original layout will be applied.

Default: false
Valid values: 
true, false
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In-line row adding

Click Add Row icon  to add or insert new rows directly in the table 
component.

When you click , a new row is added or inserted to the table immediately 
below the currently selected row, and the focus shifts to the newly added row 
with the new row being selected automatically.

In-line row deleting

You can delete rows from the table component directly.

To delete rows from the table component, 

1. Select the row to delete, or click additional rows while holding down Shift 
or Ctrl key to help select multiple continuous or non-continuous rows.

When a single row is selected, it is highlighted and becomes editable. 
When a second row is selected, the editable row becomes non-editable.

2. Click Delete Selected Rows icon . 

A warning message pops up asking for your confirmation.

3. Click OK if you are sure you want to delete the selected rows.

4. Click Save Draft or Save on the page. This ensures that the data in the 
deleted rows are removed.

Copying and pasting row(s)

The new table component supports copying and pasting of selected row(s). 

After clicking Edit button in the table component to switch to Edit mode, the 
Copy and Paste icons become visible.

Selecting a row in the table component enables the Copy icon , then clicking 
Copy icon enables the Paste icon .

Copying and pasting row(s) follows the following behaviors: 

Save Draft button is available if you set the server.conf parameter  
ALLOW_SAVE_REQUEST_DRAFT to true.
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By clicking Copy icon, the row(s) of your current selection are 
remembered, including data in the cells and cell styles (such as editable, 
required, visible, CSS style, and default value as defined by UI rules). You 
can click Paste repeatedly to paste the selected row(s) with their data and 
cell styles to desired locations in the table component until you select 
another row or another set of rows to copy. 

When a single row is selected, if you click Copy and Paste directly, the row 
is inserted immediately below the currently selected row. If you click 
Copy, then select a second row and click Paste, the row is inserted 
immediately below the second row you selected. In another word, you can 
select a single row and insert it below any row in the table.

When multiple rows are selected (you can click additional rows to select 
them while holding down Shift or Ctrl key to help select multiple rows), if 
you click Copy and Paste, the selected rows are always pasted continuously 
below the last row in the table component. If you click Copy, then select 
another row in the table component and click Paste, the previously selected 
multiple rows are pasted continuously, immediately below the row of your 
current selection. 

Moving row(s) up or down

The new table component supports moving row(s) up or down in the table. 
You can select a single row or multiple consecutive rows to move up or down 
in the table component.

The Move Up icon  and Move Down icon  become visible in the table 
component when you switch to Edit mode by clicking Edit.

To move up or move down a single row, select the desired row and click  or 
.

To move up or move down multiple consecutive rows, click additional rows to 
select them while holding down the Shift key, then click  or .

After you have finished moving up or down row(s), be sure to click Save Draft 
or Save to save the changes.

Note that the Move Up icon  and Move Down icon  are disabled in the 
following situations:
66 Chapter 2



The Move Up icon  is disabled when the first row in the table component 
is selected.

The Move Down icon  is disabled when the last row in the table 
component is selected.

Both icons are disabled when multiple non-continuous rows are selected.

There are no entries in the table.

In-line row editing

All validations supported by table component can be set to editable in PPM 
Workbench. For the list of supported validations, see Supported Validations 
on page 62. 

For validations that are set to editable in PPM Workbench, relevant table cells 
in the table component are editable and you can edit them directly. 

When you click a row in the table component, it becomes highlighted and 
editable. You can navigate the cells in an editable row by pressing the Tab key.

After you have finished editing cells and rows in the table component, click 
Save Draft or Save on the page to save the changes.

If any required fields (marked with a red star) are left empty, clicking Save 
Draft or Save will prompt a warning similar to the follows, reminding you to 
provide values for required fields before you can save the table component 
successfully, and the first required and focusable field will be focused. 
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Warning prompt when leaving current page without saving the modified table component

If a user is leaving the current page without saving the modified table 
component, a warning message will pop up asking for confirmation. 

Showing Total of a Table Component Column in Real-time

The new table component supports displaying total for a numeric column if 
you set Display Total attribute for the column to Yes in PPM Workbench.

The Total field is visible in the table component as the last row when all 
rows display.

o The Total value is re-calculated and displayed in real-time.

o Supports showing the Total row on Printing Page.

o Supports showing the Total row on exported Excel spreadsheet.

The Total row is invisible in the following situations,

o When you are not showing all entries in the table.

o When there are no entries in the table.

o When there is no column with Display Total attribute.
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Supports total token

For example, the Total Effort field in the following screenshot references 
the total token [REQD.T.CONTACT_INFO.TC.P.HOURS.TOTAL]:
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Quick Navigation through Table Rows 

The new table component supports displaying current table entries and total 
row count in real-time. You can choose to show all entries or a certain number 
of entries in the table component.

When there are more than 5 entries, the Show: M of N Entries field appears to 
the right of the table component menu icons, where M is the number of entries 
currently displayed, N is the total number of entries in the table. For example,

Depending on the total row count in the table, options available for M 
would be 5, 10, 20, 40, 80, ..., All.

When you add, delete, copy and paste, move up or down rows, the table 
component refreshes Show: M of N Entries status in real-time.

When you change Show: M of N Entries, you refresh the table component 
only. The rest of the request page is not refreshed. 

The Show: M of N Entries status is remembered per session.

When you set M to ALL, M will always display ALL, and the table 
component automatically expands to show all entries when you add, delete, 
or copy and paste rows.

With M as an integer, when you add, delete, copy and paste, or move up or 
down rows, it always displays an integer even when M = N.

Other Changes

With the new table component layout, there is no need to configure the 
Form Layout tab anymore, though it is still available. 

Now you can resize column and table width, move table rows up or down 
directly in the table component on a request page.
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When one field on a request page is dependent on another field in the table 
component, UI rule(s) are triggered and the focus (indicated with single 
light blue boarder lines around the table component) is lost if you click 
outside the table component; While on a request page with the original 
table component layout, the UI rule(s) are triggered by clicking Done.

In the following example, the Total Effort field references the Total token 
[REQD.T.CONTACT_INFO.TC.P.HOURS.TOTAL]:

o Before you click outside the table component, the Total Effort field 
value is not updated, and the single light blue boarder lines around the 
table indicate that the focus is on the table component: 

o After you click outside the table component, the Total Effort field value 
is updated as a result of triggered SQL rule, and the table component 
focus is lost as the light blue boarder line turn gray.
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Considerations for Using Rules in Table Component

The new table component supports using simple and advanced SQL rules and 
UI rules on the following two rule events:

Apply on creation

Apply on field change

You can use SQL rules and UI rules in the same way you use them on request 
level. For details about configuring advanced SQL rules and UI rules, see the 
HP Demand Management Configuration Guide.

However, note the following considerations when you configure SQL rules 
and/or UI rules for table component:

Set Process subsequent rules? option to Yes or No for different 
validations.

Dependencies field is not required for Apply on creation rule event, but 
required for Apply on field change rule event.

Dependencies field supports the following validations:

o Text field

o Auto-complete list

o Drop-down list

o Date field (short, medium, and long)

Results field supports the following validations: 

o Text field

o Text area

o Auto-complete list

o Drop-down list

o Radio buttons (yes/no)

o Date field (short, medium, and long)
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o Web Address (URL)

o Link

UI rules support the following JavaScript functions: 

o setFieldRequired ()

o setFieldEditable ()

o setFieldVisible ()

o showMessage ()

o setFieldStyle ()

For more information about these JavaScript functions, see the HP 
Demand Management Configuration Guide or access the Request Rules 
JavaScript Function Help by clicking the  icon next to the Logic field 
in Rules window of the Validations Workbench.

You can set table component as a dependency to trigger request type rules.

If a field’s Display attribute is set to No or the field is set invisible by its 
status dependency, you can not make it visible on the Web UI by using UI 
rules.

When using SQL rule(s) on text field with Apply on creation rule event, 
make sure not to use strings “~^~^~” and/or “~&~&~” in any text field as 
they are reserved.

When SQL rule(s) with Apply on creation rule event are triggered to 
override default value of a table component column, the default value may 
still display for a very short period of time (say 0.5 second) due to server 
speed.

For any validation (with the exception of Text validation), if you set the 
Display Only attribute to Yes for a field, then using UI rule 
setFieldEditable(true) will not make the field editable. 

To modify CSS styles, locate and access the RequestRulesUserCSS.css 
file in the following directory: /opt/ppm/[instance name]/server/
[instance name]/deploy/itg.war/web/knta/crt/css/.
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3 Enhancements, Integrations, Certifications, 
and Fixes in PPM Center 9.12
This section includes information about the enhancements, integrations, 
certifications, and fixes in PPM Center version 9.12.

Enhancements

The following enhancements are included in PPM Center version 9.12:

Display of Project Number in Project Overview Page

Display of Project Number in Time Sheet Lines

Approval of Submitted Time Sheets for Future Periods

User Control of Vertical Size of Time Breakdown Tables on Time Sheets

New Report: Purge Empty Time Sheet Lines

Configurable Access Grants for Request Creators

New Option for Notifications: Prevent any email notifications regarding 
this staffing profile

New Rule Event: Apply on Copy

Improved Search Result in Microsoft Project

PPM Center Accessibility Improvements

Special Command ksc_copy_request Enhancement

Detecting Multicast Routing and Configuration Issues for a Server Cluster

Improved Startup Checks
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SQL Debugging for All Product Areas

Accessing Services Exceptions Details

Enabling Debugging On a Per-User Basis

Improved Services Audit Results Page

Accessing Application Exception Details

Identifying Connection Issues

Updating a Microsoft Project Work Plan Hierarchy Integrated with HP 
Project Management

Display of Project Number in Project Overview Page

In version 9.12, to help users distinguish similarly named projects, the project 
title on the Project Overview page displays the project number (the request ID 
of the project) as well as the project name, in the format:

Project: <project number> <project name> 

For example: Project: 12345 Whirlwind 

See also Display of Project Number in Time Sheet Lines.

Display of Project Number in Time Sheet Lines

In version 9.12, to help users distinguish similarly named projects, time sheet 
lines for projects display the project number (the request ID of the project) 
below the project name, in the format:

<project name>  
Project: <project number> 

For example:

Whirlwind 
Project: 12345 

See also Display of Project Number in Project Overview Page.
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Approval of Submitted Time Sheets for Future Periods

In version 9.12, submitted time sheets that cover future time periods appear on 
the Approve Time page and in the Approve Time Sheets portlet.

User Control of Vertical Size of Time Breakdown Tables on Time Sheets

In the Time Breakdown table in time sheets, users specify the amount of time 
they spent on various work items. The table has one time sheet line for each 
work item (and the time sheet line uses multiple rows if it has multiple 
activities). In previous versions of PPM Center (except version 8.03), the 
vertical size of this table is a fixed number of pixels. As a result, users who 
have monitors with a vertical resolution of more than 1024 pixels sometimes 
see considerable white space below the table on the time sheet page. If that 
white space were available for time sheet lines, users could see more of those 
lines at one time without scrolling the table.

In version 9.12 (as in version 8.03), each user can control the vertical size of 
the tables in his or her time sheets. To do so, the administrator must set the new 
server.conf parameter named TM_ENABLE_GRID_RESIZE_CONTROL and set it 
to true (it is most conveniently set by using the Administration Console).

When the administrator enables this capability, all users see three new 
mutually exclusive options on all of their time sheets, as buttons to the right of 
the Group | Ungroup Items options. 

From left to right, the buttons have the following appearance and 
corresponding tooltips (mouseovers):

One horizontal line, with the tooltip Small

Two horizontal lines, with the tooltip Medium

Three horizontal lines, with the tooltip Large

The button (option) the user selects controls the vertical size (number of 
vertical pixels) available for displaying the Time Breakdown table, for all of 
that user’s time sheets, existing and new. The option affects all of the tabs of 
the table, and it persists until the user changes it. 
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The default option for each user is Small, which results in the same vertical 
table size as previous versions of PPM Center. Users who select Medium or 
Large might see more time sheet lines as soon as the page is loaded (that is, 
without scrolling the table), and they might see less white space below the 
table.

New Report: Purge Empty Time Sheet Lines

The Purge Empty Time Sheet Lines report purges empty time sheet lines from 
the database. 

An empty time sheet line is defined as a line in which no actual effort has been 
entered. This does not mean a time sheet line that has a total effort of 0 because 
you are allowed to enter negative time as effort.

Creating a Purge Empty Time Sheet Lines Report

After you install PPM Center version 9.12, the Purge Empty Time Sheet Lines 
report is available under the Administrative category by clicking Create > 
Report menu.

To keep the data growth under control, HP recommends that you run this report 
periodically. Optionally, you can prevent resources from submitting empty time sheet 
lines by using time sheet policies. For more information about how to specify the level 
of enforcement for empty lines, see the HP Time Management Configuration Guide.

This report only removes empty time sheet lines from times sheets that are in one 
of the following states: 
- Closed 
- Frozen 
- Canceled
This report is restricted to users having a User Administration license.
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To create and submit a Purge Empty Time Sheet Lines report, follow these 
steps:

1. Log on to PPM Center.

2. From the menu bar, select Create > Report. 

The Submit New Report page opens.

3. From the Select Report by Category section, select Administrative from the 
Report Category drop-down list. 

A list of all administrative reports appears.

4. Click Purge Empty Time Sheet Lines in the list. 

The Submit Report: Purge Empty Time Sheet Lines window opens. 

5. To define the report results you want, type or change information in the 
fields under the Report Parameters section. 

For more information, see the Report Parameters section.

6. To run the report at a later time, on a periodic basis, or provide a brief 
notification once the report is finished, expand the Scheduling section, and 
then type or change the information in this section according to the task 
you want to accomplish. 

For more information, see the Reports Guide and Reference.

7. To add a notification that has more comprehensive features than those 
available with Send email to, expand the Advanced Notifications section, 
and then configure the advanced notification settings according to your 
requirement. 

For more information, see the Reports Guide and Reference.

8. Click Submit. 

The report will run immediately, at a later time, or on a periodic basis. This 
depends on your settings in the Scheduling section.
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Report Parameters

This report has four parameters (as shown in Figure 3-1). These parameters are 
described in Table 3-1. 

Figure 3-1. Report parameters

Table 3-1. Purge Empty Time Sheets Lines field descriptions  (page 1 of 2)

Field Name 
(*Required) Description Default Value

 * Purge Line in Time 
Sheets created 
before

Specifies the time threshold of the 
purge.
Only time sheets with period end 
dates prior to this date will have 
empty lines deleted.

Blank
When you open the 
calendar, the current 
date is highlighted.

Report Only Indicates whether or not to 
generate a report without deleting 
the eligible empty time sheet 
lines.
If you set this field to Yes, no lines 
will be deleted. In this case, only a 
report of the empty lines that are 
eligible to delete is generated. 

No, which means all 
eligible empty time 
sheet lines are deleted 
after the report 
completes.
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Report Output

The output of this report includes:

Report parameters

The number of time sheet lines that were purged for each period 
(categorized by period type), work item type, and time sheet status

The total number of time sheet lines that were purged

Figure 3-2 shows an example of the report output.

Work Item Types Specifies which work item types 
are eligible to have empty lines 
deleted.

Blank, which means 
this report processes 
time sheet lines of all 
work item types.

Time Sheet Statuses Specifies the states of time sheets 
to process.
Only time sheets in the specified 
states will have empty lines 
deleted.
Choices include:

Closed
Canceled
Frozen 

Blank, which means 
this report processes 
empty lines for time 
sheets in all the 
following states:

Closed
Canceled
Frozen 

Table 3-1. Purge Empty Time Sheets Lines field descriptions  (page 2 of 2)

Field Name 
(*Required) Description Default Value
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Figure 3-2. Report output

Configurable Access Grants for Request Creators

In PPM Center version 9.12, the View and Edit access grants for the creator of 
a request become configurable. Therefore, you can restrict the creator’s 
permissions on a request by configuring these access grants. 

This enhancement is typically used in scenarios like the following:

The request creator is assigned a new role that should not have enough 
permission to view or edit the requests he or she created.

You delegate the creation of a request to someone who should not be able 
to view or edit the request after it is created.
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To configure the View and Edit access grants for the creator of a request, 
follow these steps:

1. Open PPM Workbench, and then select Demand Mgmt > Request Types.

The Request Type Workbench opens.

2. Open the corresponding request type.

The Request Type window opens.

3. Click the User Access tab. Note that the View and Edit access grants for 
the Created By participant are configurable. 

4. Select or clear the check boxes for these access grants according to your 
business needs.

By default, the View and Edit access grants are selected.

If you uncheck these two access grants, the request creator cannot view or 
edit the request unless other security settings provide the creator with the 
View and Edit access grants to the request.

Limitation

Currently, this enhancement is only available for PPM Center version 9.12 and 
version 8.03. Request types migrated from other versions do not support this 
enhancement.
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New Option for Notifications: Prevent any email notifications regarding this 
staffing profile

A new option Prevent any email notifications regarding this staffing profile is 
available on the Configuration Notifications page of a staffing profile.

This new option is intended for staffing profiles linked to confidential projects. 
The option enables you to prevent any email notifications about the staffing 
profile from being sent out. Therefore, checking the option protects the 
confidential information about the staffing profile and the corresponding 
project.

For example, by checking this option, you disable the email notifications that 
the system generates when resource requests are sent to resource pools.

By default, this option is unchecked. Checking this new option disables all the other 
options on this page.

These automatically-generated email notifications cannot be disabled by any original 
options on the Configuration Notifications page. With the new option checked, only 
users having the appropriate permissions, such as the staffing profile manager, the 
resource pool manager, and the project manager can view the resource requests after 
they log on to the system.
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New Rule Event: Apply on Copy

The Apply on copy rule event is available in PPM Center version 9.12. When 
you create a rule by using this rule event for a request type, the rule will be 
triggered when the requests of that type are copied.

Consider the following scenario for the general usage of the Apply on copy rule 
event:

You create request rules for a request type to achieve dynamic field changes. 
Requests of this type are frequently copied by multiple PPM users. The rules 
are expected to be triggered when the users copy the requests.

In this scenario, you can set the rule event of your request rules to Apply on 
copy.

Creating Rules With the “Apply on copy” Rule Event

After you install PPM Center version 9.12, the Apply on copy rule event will be 
available in the Rule Event list of the Rules Window panel in PPM 
Workbench.

To make the rule be triggered when the corresponding requests are copied, 
select the Apply on copy rule event in the Rule Event list. 

This enhancement only affects the rule event selection step for the request rule 
creation. The other steps remain the same. For detailed steps about how to 
create request type rules, see the Request Type Rules section of the HP 
Demand Management Configuration Guide.
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Triggering “Apply On Copy” Rules

After you create a rule with the Apply on copy rule event for a request type, the 
rule will be triggered when you (or other users) copy the requests of that type.

To copy a request, click Make a Copy above the Header section on the detail 
page for the request.

For detailed steps about how to copy a request, see the Creating Requests by 
Copying Requests section of the HP Demand Management User’s Guide.

Improved Search Result in Microsoft Project

In Microsoft Project, the project search result is presented in a more user-
friendly manner where only projects for which you are the project manager are 
returned. Therefore, all the projects returned in the search result are accessible, 
meaning that you can open these projects from PPM Center, and send them to 
PPM Center.

The Apply on copy rule event is supported in both the simple defaults and the 
advanced rule types.
When selecting the Apply on copy rule event, you are able to configure field 
dependencies. This feature is not supported in the Apply on creation rule event. 
If a request type contains rules of the Apply on copy rule event and rules of the 
Apply on creation rule event, only the Apply on copy rules are triggered when 
users copy the requests of that type.

To search projects in Microsoft Project, you must have the following access grants:
Project Mgmt: Edit Projects
Project Mgmt: Synchronize Work Plans
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PPM Center Accessibility Improvements

PPM Center version 8.03 introduced several enhancements to improve the 
accessibility of PPM Center for people with disabilities. The enhancements are 
primarily in the area of improved navigation for easier use of PPM Center with 
assistive technologies, such as screen readers.

Now the Site Map and Skip Navigation links are available on all PPM Center 
pages, which are configurable through the new server.conf parameters listed 
in Table 3-2. 

Navigation enhancements introduced to PPM Center pages include: 

Create Request page and View Request page (including the request 
look-ahead page)

o Improved navigation to various sections of the request and workflow 
section, via headings.

o Provided meaningful names for links on the page and for frames within 
autocomplete dialogs.

o Added titles to fields and buttons, including workflow buttons.

o Added navigable support to all autocomplete dialogs.

o Added accessibility support for field-level and section-level help.

Table 3-2. New server.conf parameters introduced 

Parameter Description

ENABLE_SITE_MAP 
Enables the Site Map link in the header of 
each page, when set to true.
Default: false

ENABLE_SKIP_NAVIGATION 
Enables the Skip Navigation link in the 
header of each page, when set to true.
Default: false
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Search Request page and Advanced Search page

o Improved navigation to various sections of the page via headings.

o Provided meaningful names for links on the page and for frames within 
autocomplete dialogs.

o Added titles to fields and buttons.

o Added navigable support to all autocomplete dialogs.

o Added support to identify rows and columns within table components.

o Added support for navigation within the Choose Columns section.

Search Request Results page

o Improved navigation to various sections of the page via headings.

o Provided meaningful names for links on the page.

o Added support to identify rows and columns within table components.

View Reports page

o Added support to identify rows and columns within table components.

Special Command ksc_copy_request Enhancement

The special command ksc_copy_request is enhanced with two additional 
parameters introduced in PPM Center version 9.12, so that you can,

Specify the creator of the copied requests;

Map fields between source and target requests.

Table 3-3 lists the new parameters introduced.
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Table 3-3. New ksc_copy_request parameters introduced 

Parameter Description

USER_ID Specifies creator user ID of the new request.

VALIDATION_NAME

Specifies a validation to store copied fields with different 
tokens.
The value of the destination token will be replaced by the 
value of the source token.
The source token, source visible token, token type, and 
destination token are stored in the user data of validation 
values. You can configure multiple validation values to 
store multiple pairs of source and target fields.
For information about configuring user data for validation 
values to store field token mappings between source 
and target requests, see Enabling User Data Tab for 
Validations.
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Enabling User Data Tab for Validations

In order to use the enhanced special command ksc_copy_request for the 
purpose of copying request, you need to create a validation of Auto Complete 
List component type and validated by List, then enable the User Data tab for 
the validation value by defining a user data for it. 

Create a Validation

To configure a validation,

1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Open Workbench.

The PPM Workbench opens.

3. From the shortcut bar, select Configuration > Validations.

The Validation Workbench opens.

4. Click New Validation.

The Validation window opens.

5. Provide the following information:

Name: Name of the new validation. For example, IT Request 
Copying Map.

Reference Code: Accept the default value.

Enabled: Select the checkbox.

Component Type: Auto Complete List.

Validated By: List

For more information about configuring validations, see the Commands, 
Tokens, and Validations Guide and Reference.

6. In the Validation Values section, click New to add a validation value.

The Add Validation Value window opens.

7. Provide the information for the validation value.
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8. Click OK.

Enable User Data Tab for Validations

To define a user data and enable the User Data tab for a validation,

1. From the PPM Workbench shortcut bar, select Configuration > User Data.

The User Data Workbench opens.

2. Click New. 

The User Data Context window opens to the Fields tab.

3. Click User Data Type auto-complete.

The User Data Type field displays the value Validation Value User Data, the 
Context Field field displays the value Validation Name, and the Scope field 
displays Context.

4. Click the Context Value auto-complete, and select the validation you just 
created in Create a Validation. In this example, IT Request Copying Map.

5. On the Fields tab, click New.
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6. Create four fields by strictly following the pairing order below:

7. Click OK.

The user data is defined for validation IT Request Copying Map.

8. (Optional) Go to Validation Workbench and open the validation IT Request 
Copying Map.

Open the validation value, the User Data tab is now enabled in the 
Validation Value window.

Field Prompt Token User Data Col.

source token SOURCE_TOKEN USER_DATA1

source visible token SOURCE_VISIBLE_TOKEN USER_DATA2

token type TOKEN_TYPE USER_DATA3

destination token DESITINATION_TOKEN USER_DATA4

You can use different names for field prompts, but be sure that USER_DATA1 
is paired to source token, USER_DATA2 to source visible token, USER_
DATA3 to token type, and USER_DATA4 to destination token.
For token type, if you want to use both TOKEN and SQL, you may use drop 
down list as the component type and include TOKEN and SQL options in its 
validation.
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Creating Multiple Field Pairs

The user data for one validation value stores one pair of source and target 
fields. If you need to copy multiple request fields, you can add and configure 
more validations values to specify and store multiple source and target field 
tokens.

Taking validation IT Request Copying Map as an example, to create multiple 
field pairs, 

1. In the Validation Workbench, open the validation IT Request Copying Map.

The Validation: IT Request Copying Map window opens.

2. In the Validation Values section, click New.

The Add Validation Value window opens to Value Information tab.

3. Provide the information for the validation value on the Value Information 
tab.

For more information about Value Information tab, see the Commands, 
Tokens, and Validations Guide and Reference.
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4. Click User Data tab, provide token values of source and target request 
fields for the following fields:

For example, if you want to copy the value from field Field123 to field 
Dest456,

o When token type is TOKEN, 

Field Prompt Description

source token

Invisible token of the source field to be copied from. 
Value example:

When token type is TOKEN:  
[REQD.P.FIELD_SOURCE];
When token type is SQL:  
select '[REQD.P.FIELD_SOURCE]' from dual

source visible 
token

Visible token of the source field to be copied from. 
Value example:

When token type is TOKEN:  
[REQD.VP.FIELD_SOURCE];
When token type is SQL:  
select '[REQD.VP.FIELD_SOURCE]' from dual

token type
Specifies supported token type. Valid value: TOKEN or SQL.
Note: Only TOKEN and SQL are supported.

destination token

Token of the destination field to be copied to. 
Value example:

When token type is TOKEN:  
REQD.P.FIELD_DESTINATION;
When token type is SQL:  
REQD.P.FIELD_DESTINATION.

Note: No square brackets for the destination token value.
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o When token type is SQL,

5. Click Add.

6. Repeat step 2 through step 5 to add more validation values.

Using Special Command ksc_copy_request

When you have configured a validation for the purpose of copying request, you 
are ready to create a request with the special command ksc_copy_request 
configured in a workflow to copy any specified request, with the original 
creator ID and the request fields.

A special command example is as follows:

ksc_copy_request FROM_REQUEST_ID="[REQ.REQUEST_ID]" 
USER_ID="[USER_ID]" VALIDATION_NAME="[VALIDATION_NAME]"
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Detecting Multicast Routing and Configuration Issues for a Server Cluster

In earlier PPM Center versions, if multicast traffic could not pass between two 
nodes in a server cluster, the nodes ran in isolation and no warning was issued. 
The only way to determine whether the nodes were communicating was to use 
the JGroups send and receive test utilities.

Now, PPM Center logs clear warnings in the server logs if multicast traffic has 
not been detected from a node after a specified time interval has elapsed, even 
though the node can be reached on its JMS connection factory and the  
PPM_SERVER_INSTANCE table indicates that the node is running. You can 
configure the amount of time that must pass before PPM Center logs warnings 
by setting the new MULTICAST_WARNING_MINUTES server configuration 
parameter.

Node behavior is monitored somewhat differently on the MULTICAST_PORT  
and APP_SERVER_MULTICAST_PORT ports. To provide system administrators 
with better visibility into multicast behavior, server logging was improved as 
follows:

The APP_SERVER_MULTICAST_PORT port (used to coordinate cluster nodes) 
logs the following warning if no traffic has been received since either the 
current node was started, or since other nodes were started:

No multicast traffic has been received on the APP_SERVER_
MULTICAST_PORT port since this node was started, even though 
other nodes in the cluster appear to be active. Please check 
your multicast routing and/or configuration, the APP_SERVER_
MULTICAST_PORT parameter(in server.conf), or your firewall 
settings.

After data first comes in on the port, PPM Center logs the following 
message just once:

First data received on APP_SERVER_MULTICAST_PORT.

The MULTICAST_PORT (used to monitor the cluster) tracks incoming 
messages from each node individually. After a given node (X) is first heard 
from on the port, PPM Center logs the following message to the server log 
just once: 

Node X is reachable on MULTICAST_PORT.
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If a node is not heard from on the MULTICAST_PORT port, PPM Center logs 
the following message:

No multicast traffic has been heard from node X on the 
MULTICAST_PORT port for over 3 minutes, even though the node 
appears to be up. Please check your multicast routing and/or 
configuration, the APP_SERVER_MULTICAST_PORT parameter(in 
server.conf), or your firewall settings.

You can disable the multicast monitoring feature by setting the MULTICAST_
WARNING_MINUTES server configuration parameter to zero or less. HP strongly 
recommends that you not disable the feature unless HP Software Support 
specifically requests that you do so.

Improved Startup Checks

To help catch common configuration and deployment issues, PPM Center now 
performs basic startup checks before starting. These checks include:

Making sure that essential server.conf parameters are present.

Making sure that none of the ports required by PPM Center are already 
bound by other processes.

Making sure that all ports used by the nodes on a given physical server 
have unique values.

A summary of all issues found during the startup checks is traced out into the 
server log of the node being started. If PPM Center is running as a Windows 
service, an error is added to the Windows event log asking you to refer to the 
server log when errors are found. In some rare cases that the server logs could 
not provide useful details, we recommend that you start PPM Center in the 
console mode by using the kstart.sh script, and then troubleshoot the 
configuration and deployment issues. After you fix these issues, you can start 
PPM Center as a Windows service again.

Because of these new startup checks, you may encounter more configuration errors in 
9.12 (and beyond) that prevent a PPM Server from starting (whereas a successful 
start was allowed on a previous version).
Enhancements, Integrations, Certifications, and Fixes in PPM Center 9.12 97



Errors fall into two categories:

Critical errors (Error messages): These errors relate to the node being 
started. PPM Center will refuse to start if there are any critical errors.

Non-critical errors (Warning messages): These errors relate to other 
nodes in server.conf than the one being started. It is highly recommended 
to fix such errors, however they will not prevent the startup. All nodes in 
the server.conf file are checked when any one node is started.

Bypassing the Startup Checks

The com.kintana.core.server.BYPASS_STARTUP_CHECKS parameter is 
introduced in version 9.12 in the server.conf file. By default, this parameter 
is set to false.

You can bypass the startup checks by setting this parameter to true:
com.kintana.core.server.BYPASS_STARTUP_CHECKS=true

Comprehensive Logging During PPM Server Startup

PPM Center version 9.12 includes a significant number of improvements to the 
application startup process, from both a logging and configuration validation 
standpoint. One of the goals of the improvements is to provide customers with 
as much information as possible about the validity of the configuration of their 
clustered environments.

Displaying Failed Executions at Startup

To enable the display of failed server executions at startup, make sure that the 
FAIL_EXECUTIONS_ON_STARTUP server configuration parameter is set to true 
in the server.conf file. All executions that were interrupted during the last 
PPM Center shut-down are marked as failed.

This parameter should only be used under advisement from PPM customer support 
engineers, and if there is a clear and well-understood reason for doing so.
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Displaying Configuration Parameters at Startup

You can now enable the display (and logging) of all PPM Center server 
configuration parameters used during startup. To enable this feature, set the 
SHOW_PARAMETERS_AT_STARTUP server configuration parameter to true.

Adjusting the Server Log Level

Server startup logs indicate what the server is doing at each step of the startup 
process (including the successful start of each web context). By default, when 
the startup check catches a configuration or deployment issue, only a error or 
warning message will be generated in the server logs. You can modify the 
logging level to get more details by adding the following entries in the 
logging.conf file.
com.kintana.core.logging.SYSTEM_THRESHOLD = INFO
com.kintana.core.logging.PRODUCT_FUNCTION_LOGGING_LEVEL = 
com.kintana.core.server.ServerStartupSanity, INFO

SQL Debugging for All Product Areas

If you turn on SQL debugging, PPM Center now collects statistics for the 
following legacy product areas:

HP Demand Management web pages

HP Deployment Management web pages

The debugging console display includes information about the SQL statements 
executed by the legacy code. The web pages of the legacy areas now display 
the debugging console.

These parameters are designed for advanced troubleshooting. We do not suggest 
modifying these parameters without advisement from PPM customer support 
engineers.
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Accessing Services Exceptions Details

In earlier PPM Center versions, exceptions thrown by background services 
were not immediately visible to users, even though they were recorded in the 
logs. Now, on the Services Audit Results page, you can see whether any 
services have thrown exceptions.

If a service has encountered one or more exceptions or errors during its last 50 
runs, a red icon ( ! ) is displayed to the left of the service name on the Services 
Audit Results page. You can change the threshold for displaying the icon by 
changing the value for the SERVICE_RECORDS_RETAIN_COUNT server 
configuration parameter in the server.conf file.
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To view details about exceptions a service has encountered, click the service 
name. The Search Exceptions page opens and displays a list of the exceptions.

The Search Exceptions page provides the following information:

Presence or absence of exceptions during a particular service run.

Name of the node on which the service was run

Time the service run started

Time the service run finished

Duration of the run, in seconds

Any additional information provided by the service. All services by default 
provide the memory footprint during the start and end of the service. This 
information is useful to troubleshoot any issues related to memory 
consumption by a service run.

To enable this functionality, add the LOG_EXCEPTIONS_TO_DB server 
configuration parameter to the server.conf file and set its value to true.

Purging Exceptions Thrown by Services

Whenever a service run is deleted from the system, the exceptions related to 
that service run are also removed. By default, the system retains the 50 most 
recent service run records. You can change this by setting a new value for the 
SERVICE_RECORDS_RETAIN_COUNT server configuration parameter in the 
server.conf file.
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Enabling Debugging On a Per-User Basis

With PPM Center 8.03, you can turn on the debugging console and set a server 
logging threshold on a per-user basis.

To enable turning on the debugging console for individual users, add the SHOW_
DEBUGGING_CONSOLE_PER_USER server configuration parameter to the 
server.conf file, and set it to true. After you do, a user logged on to PPM 
Center can toggle the debugging console by pressing and holding the ALT key 
and clicking the HP logo, which is located above the menu bar.

If you customize the logo using a copy of the web/knta/global/Header.jsp 
file, to use this feature, make sure that you customize the copy of the 
Header.jsp file included in the PPM Center 8.03 bundle.

PPM Center supports the following log levels.

To enable debug logging to the serverLog.txt file for a specific user:

1. Set the ENABLE_DEBUGGING_PER_USER server configuration parameter to 
true.

2. Open the logging.conf file in a text editor, and then set the  
USER_THRESHOLD parameter as follows:

USER_THRESHOLD = <PPM_Username>, <Log_Level>

Log Level Description

DEBUG Print fatal, status, error, warning information and debug log 
(used in debugging)

INFO Print fatal, status, error, warning and information log 

WARN Print fatal, status, error and warning

ERROR Print fatal, status, and error log (default)

STATUS Print fatal and status messages (Not recommended)

FATAL Print only fatal messages (Not recommended)
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3. To configure finer-grained logging than that specified by the SYSTEM_
THRESHOLD parameter, add the following to the logging.conf file:

com.kintana.core.logging.USER_THRESHOLD = <Username>,  
<Log_Level>

The logging.conf file is read periodically, so there is no need to restart the 
PPM Server(s) to enable debug logging specific to the user.

Logging occurs only for that particular user.

To enable the debug console for multiple users, add USER_THRESHOLD values 
(on separate lines).

Example:

USER_THRESHOLD = gchu, DEBUG
USER_THRESHOLD = pchapin, DEBUG
USER_THRESHOLD = bkordon, DEBUG

If the log level value meets the threshold criteria of either the USER_THRESHOLD 
(set for that user) or the SYSTEM_THRESHOLD, then the message is logged.

Example 1
SYSTEM_THRESHOLD = ERROR
USER_THRESHOLD = ddalton, DEBUG

In Example 1, for a user logged in as ddalton, the system logs all DEBUG and 
higher (INFO, WARN, ERROR, STATUS and FATAL) messages. For any 
other user, the system logs only ERROR, STATUS and FATAL messages.

Example 2
SYSTEM_THRESHOLD = DEBUG
USER_THRESHOLD = ddalton, ERROR

In Example 2, the system logs all messages for all users. In this case, the  
USER_THRESHOLD value (ERROR) set for ddalton has no effect.
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Improved Services Audit Results Page

PPM Center version 8.03 improves the Services Audit Results page by adding 
the Last Run Node column. 

The value on this column represents the node on which the service ran the last 
time. If the service is currently running when you access this page, the value 
indicates the node on which the service is running. A dash (-) character 
indicates that the corresponding service has been triggered, but the service has 
not run because it does not have any data to process.

Additionally, the column “Last Run Time” is renamed to “Last Completed 
Run.” Similarly, “Next Scheduled Run Time” is renamed to “Next Scheduled 
Run.”

Accessing Application Exception Details

Previously, exceptions thrown by PPM Center background services were not 
immediately visible to PPM Center users, even though they were recorded in 
the logs. With this release, if an exception occurs, the user sees an error 
message that displays a GUID number and advises the user to contact the PPM 
Center administrator. The PPM Center administrator can then get detailed 
information about the exception from the new Search Exceptions page.

This column is designed for services that are enabled. For services that are disabled, 
a grayed-out dash (-) character will be noted on this column.

To access the Search Exceptions page, you must have an Administrator license and 
the “Server Tools: Execute admin tools” access grant.
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To enable this functionality, set the LOG_EXCEPTIONS_TO_DB server 
configuration parameter value to true.

To access and use the Search Exceptions page:

1. Log on to PPM Center.

2. From the menu bar, select Search > Administrative > Exceptions.

The Search Exceptions page opens.

3. In the View Details for Exception GUID field, enter the GUID provided in 
the error message.
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4. Click Go.

The Exception details page opens.

The Exception details page displays the following information:

Field Description

User
Full name of the logged-in user who encountered this 
exception. This field is empty if the exception was 
thrown by a background service.

GUID
GUID identifier for this exception. Most web 
exceptions are tagged with a GUID. Background 
service exceptions usually do not have a GUID.

Name Name of the exception.

URL URL of the page that encountered this exception.
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Purging Exceptions (Other than Services Exceptions)

Exceptions (except for services-related exceptions) older than 14 days are 
automatically purged by default. You can control the frequency with which 
exceptions are purged by setting a new value for the EXCEPTIONS_RETAIN_
PERIOD server configuration parameter in the server.conf file.

Identifying Connection Issues

The new Connection details page enables you to identify suspect connections 
that are leaking. To access the Connection details page, you must have an 
administrator license and the “Server Tools: Execute admin tools” access 
grant.

To enable this feature, set the ENABLE_CONNECTION_CORRELATION server 
configuration parameter to true.

To access the Connection details page:

1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > View connection 
correlation.

Reason Reason the exception occurred. For background 
service exceptions, this can be an error message.

Node name Name of the node on which the exception occurred.

Generated Time Time at which the exception occurred.

Exception Stack 
trace Stack trace for the exception.

Field Description
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The table on the left portion of the page displays the stack trace for each 
connection recorded when the connection was acquired from the pool.

To display the stack trace associated with the connection at the time it was 
acquired, click the corresponding connection entry.

Updating a Microsoft Project Work Plan Hierarchy Integrated with HP Project 
Management

If a Microsoft Project work plan is integrated with HP Project Management, in 
shared control mode, Microsoft Project controls the work plan. However, some 
changes to the work plan hierarchy that are allowed in a Microsoft Project are 
not allowed in HP Project Management. 

If you convert a leaf task with actuals to a summary task in Microsoft Project, 
in shared control mode, integration with the HP Project Management work 
plan fails. Converting a leaf task with actuals to a summary task is not allowed 
in HP Project Management as it may result in invalid data in HP Time 
Management.

If you experience an integration error related to the modification of the work 
plan hierarchy, use an existing backup copy as a starting point from which to 
reapply your most recent edits. See “Backing Up Microsoft Project Files” in 

Because this feature involves some database overhead, HP recommends that you 
use it only to troubleshoot connection leak issues.
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the HP Project Management User’s Guide for more information about 
backups.

Integrations

The following integrations are included in PPM Center version 9.12:

Lightweight Single Sign-On Authentication (LW-SSO) Support

SLICK Configuration Tool

CMQC for Quality Center 11.0

Importing New Service Manager Web Service Objects to Enable PPM 
Center Integration with Service Manager

Administration Tools Enhancements

Importing Requests from XML Files

Attaching Impact Analysis Report for CIs to a Request in PDF format

Lightweight Single Sign-On Authentication (LW-SSO) Support

LW-SSO support is available with PPM Center version 9.12 for PPM Center 
integrations with other HP software products. 

This section includes the following information:

LW-SSO Concepts and References

o LW-SSO Concepts and References

o LW-SSO System Requirements

o LW-SSO Security Warnings

o LW-SSO Known Issues

o LW-SSO Limitations

Configuring PPM Center for LW-SSO Support
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LW-SSO Concepts and References

LW-SSO Authentication Overview

LW-SSO is a method of access control that enables a user to log on once and 
gain access to the resources of multiple software systems without being 
prompted to log on again. The applications inside the configured group of 
software systems trust the authentication, and there is no need for further 
authentication when moving from one application to another.

The information in this section applies to LW-SSO version 2.3.

LW-SSO Token expiration

The LW-SSO Token’s expiration value determines the application's session 
validity. Therefore, its expiration value should be at least the same value as 
that of the application session expiration value.

Recommended configuration of the LW-SSO Token expiration

Each application using LW-SSO should configure token expiration. The 
recommended value is 60 minutes. For an application that does not require a 
high level of security, it is possible to configure a value of 300 minutes.

GMT Time

All applications participate in an LW - SSO integration must use the same 
GMT time with a maximum difference of 15 minutes.

Multi-domain Functionality

Multi-domain functionality requires that all applications participating in 
LW-SSO integration configure the trustedHosts settings (or the 
protectedDomains settings), if they are required to integrate with applications 
in different DNS domains. In addition, they must also add the correct domain 
in the lwsso element of the configuration.

Get SecurityToken for URL functionality

To receive information sent as SecurityToken for URL from other applications, 
the host application should configure the correct domain in the lwsso element 
of the configuration.
110 Chapter 3



LW-SSO System Requirements

The following table lists LW-SSO configuration requirements:

Product Version Comments 

Java 1.5 and higher  

HTTP Servlets API 2.1 and higher  

Internet Explorer 6.0 and higher Browser should enable HTTP 
session cookie and HTTP 302 
Redirect functionality.

FireFox 2.0 and higher Browser should enable HTTP 
session cookie and HTTP 302 
Redirect functionality.

JBoss 
authentications 

JBoss 4.0.3 
JBoss 4.3.0 

Tomcat 
authentications 

Standalone Tomcat 
5.0.28 
Standalone Tomcat 
5.5.20

Acegi 
authentications 

Acegi 0.9.0 
Acegi 1.0.4 

Spring Security 
Authentication 

Spring Security 2.0.4  

Web Services 
engines 

Axis 1 - 1.4 
Axis 2 - 1.2 
AX-WS-RI 2.1.1
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LW-SSO Security Warnings

This section describes security warnings that are relevant to the LW-SSO 
configuration:

Confidential initString parameter in LW-SSO. LW-SSO uses 
Symmetric Encryption to validate and create a LW-SSO token. The 
initString parameter within the configuration is used for initialization of 
the secret key. An application creates a token, and each application that 
uses the same initString parameter validates the token.

Enable LW-SSO only if required. LW-SSO should be disabled unless it 
is specifically required.

Level of authentication security. The Application that uses the weakest 
authentication framework and issues a LW-SSO token that is trusted by 
other integrated applications, determines the level of authentication 
security for all the applications. 

It is recommended that only applications using strong and secure 
authentication frameworks issue an LW-SSO token. 

Symmetric encryption implications. LW-SSO uses symmetric 
cryptography for issuing and validating LW-SSO tokens. Therefore, any 
application using LW-SSO can issue a token to be trusted by all other 
applications sharing the same initString parameter. This potential risk is 
relevant when an application sharing the initString either resides, or is 
accessible from, an untrusted location.

User mapping (Synchronization). The LW-SSO framework does not 
ensure user mapping between the integrated applications. Therefore, the 
integrated application must monitor user mapping. It is recommended that 
you share the same user registry (as LDAP/AD) among all integrated 
applications.

It is not possible to use LW-SSO without setting the initString parameter. 
The initString parameter is confidential information and should be treated 
as such in terms of publishing, transporting, and persistency. 
The initString should be shared only between applications integrating with 
each other using LW-SSO. 
The initString parameter should have a minimum length of 12 characters. 
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Failure to map users may cause security breaches and negative application 
behavior. For example, the same user name may be assigned to different 
real users in the various applications. 

In addition, in cases where a user logs onto an application (AppA) and then 
accesses a second application (AppB) that uses container or application 
authentication, the failure to map the user will force the user to manually 
log on to AppB and enter a user name. If the user enters a different user 
name than was used to log on to AppA, the following behavior can arise: If 
the user subsequently accesses a third application (AppC) from AppA or 
AppB, then they will access it using the user names that were used to log 
on to AppA or AppB respectively. 

Identity Manager. Used for authentication purposes, all unprotected 
resources in the Identity Manager must be configured as nonsecureURLs 
settings in the LW-SSO configuration file. 

LW-SSO Demo mode

o The Demo mode should be used for demonstrative purposes only. 

o The Demo mode should only be used in unsecured networks.

o The Demo mode must not be used in production. Any combination on 
the Demo mode with the production mode should not be used. 

LW-SSO Known Issues

This section describes known issues for LW-SSO authentication.

Security context. The LW-SSO security context supports only one 
attribute value per attribute name.

Therefore, when the SAML2 token sends more than one value for the same 
attribute name, only one value is accepted by the LW-SSO framework.

Similarly, if the IdM token is configured to send more than one value for 
the same attribute name, only one value is accepted by the LW-SSO 
framework.
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Multi domain logout functionality when using Internet Explorer 7. 
Multi domain logout functionality may fail when using Internet Explorer 7 
and when the application is invoking more then three consecutive HTTP 
302 redirect verbs in the logout procedure. 

In this case, Internet Explorer 7 may mishandle the HTTP 302 redirect 
response and display an Internet Explorer cannot display the 
webpage error page instead.

As a workaround, we recommend that, if possible, you reduce the number 
of application redirect commands in the logout sequence.

LW-SSO Limitations

Note the following limitations when working with LW-SSO authentication:

Client Access to the Application

If a domain is defined in the LW-SSO configuration:

o The application’s clients must access the application with a Fully 
Qualified Domain Name (FQDN) in the login URL. For example,  
http://myserver.companydomain.com/WebApp 

o LW-SSO cannot support URLs with an IP address, for example,  
http://192.168.12.13/WebApp 

o LW-SSO cannot support URLs without a domain, for example,  
http://myserver/WebApp 

If a domain is not defined in the LW-SSO configuration: The client can 
access the application without a FQDN in the login URL. Note that in this 
case a LW-SSO session cookie will be created specifically for a single 
machine without any domain information, and therefore will not be 
delegated by the browser to another, and will not pass to other computers 
located in the same DNS domain. This means that SSO will not work in the 
same Domain.

LW-SSO framework integration. Applications can leverage and use 
LW-SSO capabilities only if integrated within the LW-SSO framework in 
advance. 
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Multi domain support

o Multi domain functionality is based on the HTTP referer. Therefore, 
LW-SSO supports links from one application to another and does not 
support typing a URL into a browser window, except when both 
applications are in the same domain. 

o The first cross domain link using HTTP POST is not supported

Multi domain functionality does not support the first HTTP POST 
request to a second application (only the HTTP GET request is 
supported). For example, if your application has an HTTP link to a 
second application, an HTTP GET request is supported, but an HTTP 
FORM request is not supported. All requests after the first can be either 
HTTP POST or HTTP GET. 

o LW-SSO Token size

The size of information that LW-SSO can transfer from one application 
in one domain to another application on another domain is limited to 15 
Groups/Roles/Attributes (note that each item may be an average of 15 
characters long). 

o Linking from Protected (HTTPS) to non protected (HTTP) in a Multi 
domain scenario

Multi domain functionality does not work when linking from a 
protected (HTTPS) to a non protected (HTTP) page. This is a browser 
limitation where the referer header is not sent when linking from a 
protected to a non-protected resource. For an example, see  
http://support.microsoft.com/support/kb/articles/Q178/0/66.ASP 

o Third-Party cookie behavior in Internet Explorer:

Microsoft Internet Explorer 6 contains a module that supports the 
“Platform for Privacy Preferences (P3P) Project”, meaning that cookies 
coming from a Third Party domain are blocked by default in the 
Internet security zone. Session cookies are also considered Third Party 
cookies by Internet Explorer, and therefore are blocked, causing 
LW-SSO to stop working. For details, see  
http://support.microsoft.com/kb/323752/en-us. 
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To solve this issue, add the launched application (or a DNS domain 
subset as *.mydomian.com) to the Intranet/Trusted zone on your 
computer (in Microsoft Internet Explorer, select Menu > Tools > 
Internet Options > Security > Local Intranet > Sites > Advanced), which 
causes the cookies to be accepted.

SAML2 token

o Logout functionality is not supported when the SAML2 token is used.

Therefore, if the SAML2 token is used to access a second application, 
then a user who logs out in the first application will not be logged out in 
the second application. 

o The SAML2 token’s expiration is not reflected in the application’s 
session management.

Therefore, if the SAML2 token is used to access a second application, 
then each application’s session management will be handled 
independently of each other. 

JAAS Realm. The JAAS Realm in Tomcat is not supported

Using spaces in Tomcat directories. Using spaces in Tomcat directories 
is not supported.

It is not possible to use LW-SSO when a Tomcat installation path (folders) 
includes spaces (for example, Program Files) and the LW-SSO 
configuration file is located in the common\classes Tomcat folder. 

Load balancer configuration. A load balancer deployed with LW-SSO 
must be configured to use sticky sessions.

Demo mode. In Demo mode, LW-SSO supports links from one application 
to another but does not support typing a URL into a browser window due to 
an HTTP referer header absence in this case.

The LW-SSO session cookie is only one of the cookies used by the Third 
Party applications that are blocked.
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Configuring PPM Center for LW-SSO Support

To configure PPM Center support for LW-SSO, 

1. Add the parameters described in the following table into the server.conf 
file and configure them.

Read LW-SSO Security Warnings on page 112 before you configure the LW-SSO UI.

Parameter Description

ENABLE_LW_SSO_UI 
Enables LW-SSO UI when set to true.
Default: false

LW_SSO_DOMAIN Specifies LW-SSO domain, for example, 
xyz.com

LW_SSO_INIT_STRING

Specifies the string value for the initString 
parameter. 
For more information about the initString 
parameter, see LW-SSO Security Warnings 
on page 112.

LW_SSO_EXPIRATION_
PERIOD

Specifies LW-SSO token expiration period in 
minutes. For example, 60. 

LW_SSO_TRUSTED_
DOMAIN

Specifies one or more LW-SSO trusted 
domains. Use semicolon (;) to separate multiple 
domains. For example, xyz.come;abc.net

LW_SSO_CLEAR_COOKIE

When set to true, specifies that PPM Center 
needs to clear LW-SSO token when user logs 
out of PPM Center.
Default: true
Note: It is always recommended to set the 
parameter to true for security purpose. 
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2. Run kUpdateHtml.sh.

3. Stop, and then restart the server.

SLICK Configuration Tool

The SLICK configuration tool is available with PPM Center version 9.12. 
Running this tool automatically configures PPM Center support for HP Slick 
1.6 for you. 

To run the SLICK configuration tool, 

1. Create a blank .properties configuration file.

2. Include the following parameters in the .properties configuration file.

Special parameters

o FIELD_MAPPING_FILE=<SM_RFC_field_mapping_file_path>

For example, 

FIELD_MAPPING_FILE=C:/temp/slick/
sm-rfc-mapping.xml.sample

The SM RFC field mapping file will be copied to <PPM_HOME>/
conf/smrfc directory by the Slick configuration tool. If there 
already exists a mapping file, it will be replaced.

o ENCODE_BASE64=false

For more information, see 

ENABLE_LW_SSO_WEB_
SERVICE 

For integration of PPM Center Tasks with 
Service Manager RFCs only.
Specifies that PPM Center always uses current 
user to call Service Manager Web service when 
set to true.
Default: false.

Parameter Description
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server.conf parameters

Include the following server.conf parameters in the .properties 
file. The values of which will replace the ones in the server.conf file:
 
com.kintana.core.server.SM_RFC_INTEGRATION_ENABLED
com.kintana.core.server.SM_USERNAME
com.kintana.core.server.SM_URL
com.kintana.core.server.SM_WEB_URL
com.kintana.core.server.SM_PASSWORD
com.kintana.core.server.ENABLE_WEB_SERVICES
com.kintana.core.server.SERVICE_LIST_SOURCE
com.kintana.core.server.UCMDB_WS_USER
com.kintana.core.server.UCMDB_WS_PASSWORD
com.kintana.core.server.SERVICE_LIST_UCMDB_CI_TYPE
com.kintana.core.server.SERVICE_LIST_UCMDB_CI_MAPPINGS
com.kintana.core.server.SERVICE_LIST_UCMDB_WS_MAX_CI_
NUMBER
com.kintana.core.server.SERVICE_LIST_UCMDB_CACHE_TIMEOUT
com.kintana.core.server.UCMDB_WS_MAX_CONNECTION_NUMBER
com.kintana.core.server.UCMDB_SERVER_URL
com.kintana.core.server.UCMDB_SERVER_VERSION
com.kintana.core.server.UCMDB_SSL_KEYSTORE_PATH
com.kintana.core.server.ENABLE_LW_SSO_UI
com.kintana.core.server.LW_SSO_DOMAIN
com.kintana.core.server.LW_SSO_INIT_STRING
com.kintana.core.server.LW_SSO_EXPIRATION_PERIOD
com.kintana.core.server.LW_SSO_TRUSTED_DOMAIN
com.kintana.core.server.LW_SSO_CLEAR_COOKIE
com.kintana.core.server.ENABLE_LW_SSO_WEB_SERVICE

3. Run the following command to run the SLICK tool,

sh kSLICKConf.sh c:\temp\slick\test.properties

Every time you run this shell command, it creates a backup copy of the 
server.conf file before it modifies the file. 

You can check the log file it generates in <PPM_HOME>/logs/slick 
directory for details. The log file name follows slick_conf_<YYYYMMDD-
HHMMSS.serial_number>.log pattern, for example, slick_conf_
20110221-162200.420.log.

4. Stop, then restart the server.

Be sure to encrypt the values for password parameters SM_PASSWORD and 
UCMDB_WS_PASSWORD if their values are clear text.
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CMQC for Quality Center 11.0

To configure CMQC support for Quality Center version 11.0, 

1. Add the two new parameters introduced with PPM Center version 9.12 
listed in Table 3-4 to the server.conf file:

2. Obtain the latest CMQC patch installation bundle (ppm-912-CMQC.jar), 
and then deploy it on top of CMQC version 9.10 by following the 
instructions described in the HP Center Management for Quality Center 
Guide.

Table 3-4. Newly introduced server.conf parameters 

Parameter Description

CMQC_QC_VERSION Specifies Quality Center version for CMQC 
solution. In this case, 11.

CMQC_INIT_STRING

The value for initString parameter for CMQC 
solution, for example, 
INI:s4OF+cwwevEkcnJ9zWHwpE8ktxfl1pb5y
8QoENFQLs8=

You can get the value from Quality Center server. 
The initString value is stored in a properties 
file (ALM\jboss\server\default\deploy\
20qcbin.war\WEB-INF\siteadmin.xml) or 
an XML configuration file (ALM\conf\
qcConfigFile.properties) on the server 
where Quality Center is installed. 

Make sure that you have installed the PPM Center 9.12 service pack file before 
you deploy the CMQC patch bundle.
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Importing New Service Manager Web Service Objects to Enable PPM Center 
Integration with Service Manager 

This integration enhancement improves the integration solution by offering 
new Web services objects with PPM Center for users to import to enable the 
integration, instead of modifying the existing Service Manager Web service 
objects.

To configure Service Manager for the integration, 

1. Follow the instructions in the Configuring HP Service Manager for 
Integration with PPM Center section of the HP Solution Integrations 
Guide, but skip the following WSDL Configuration-related steps:

o step d on page 97

o step 2 on page 98

o step d on page 100

2. Then, set up Change Management Web service for the integration with 
PPM Center by importing the unload file provided with PPM Center. 

The unload file is located at:
<PPM_Home>\conf\sdi\serviceManagerFiles\
PPMIntALMWebService.unl

where, <PPM_Home> represents the path where the PPM Center instance is 
installed. For example: xyzserver/E/PPMServer.

If you already integrated Service Manager with PPM Center, copy and rename two 
Web service objects in Service Manager as follows to make sure that the integration 
will continue to work:

Change -> ChangePPMIntALM
ChangeTask -> ChangeTaskPPMIntALM
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Administration Tools Enhancements

The following administration tools enhancements are implemented:

Browsing and Downloading <PPM_Home> Directory Files from 
Administration Console

Administration Console SQL Runner

Gathering Support Information

Running kSupport Tool from Administration Console

Managing Hotfixes

Browsing and Downloading <PPM_Home> Directory Files from Administration Console

As a PPM Center administrator, you can now browse and download  
<PPM_Home> directory files from the Administration Console with the new File 
Browser tool. 

The Administration Console File Browser tool is available to any PPM 
Administrator with the access grants listed in Table 3-5.

For details about how to configure access grants, see the Installation and 
Administration Guide. 

Table 3-5. Required server tools access grants 

Access Grant Permissions

Sys Admin: Server Tools: 
Execute Admin Tools

Lets the user access the Administration Console and 
the server tools.

Sys Admin: Server Tools: 
Execute File Browser

New server tools access grant, enables the File 
Browser menu Browse PPM Server files in the 
Administration Console and lets the user browse and 
download PPM Server files. Without this access grant, 
the File Browser menu is invisible.

Users can view contents of all the files in <PPM_Home> in read-only mode once they 
have access to the File Browser, HP recommends that you provide the Server Tools: 
Execute File Browser access grant only to selected PPM Center administrators.
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When initially accessed, the File Browser displays all files and folders located 
in the <PPM_Home> directory:

You can click on any file to download it, or click on any folder to view its 
contents.

When displaying a folder’s contents, you can select one or more files or 
folders and download them as a Zip file by clicking Download selected 
file(s) as .Zip available at the bottom of the pane. 

The folder hierarchy in the zip file will be rebuilt relatively to the  
<PPM_Home> directory. Empty folders in the Zip file will contain an empty 
file so that empty folders are not removed automatically from the Zip file. 
These empty files are created dynamically when the Zip file is generated 
and are not present in the PPM Application Server file system.

File information displayed includes name, size, permissions (R for read, W 
for write, X for execute), and last modification date.

You can sort the files and folders displayed by clicking a column header. 
Click twice on the same column header to reverse the sorting order. A 
small vertical arrow will be displayed in the column header currently used 
as the sorting criterion.

The <PPM_Home>/security directory is not accessible through the File Browser 
and is not listed in the contents of <PPM_Home> as it contains the sensitive private key 
used for SSL encryption. You must connect directly to the PPM Server machine to 
access this folder.
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Note that when sorting files and folders, the folders are always displayed 
before the files, independently of the sorting criterion.

Also, unless you are viewing the <PPM_Home> folder, a [..] folder is 
displayed at the beginning of the list to let the user access the parent folder.

To navigate to other folders, click one of the three bookmarks on top of the 
File Browser, or click any element of the breadcrumbs representing the 
current folder (path is relative to <PPM_Home>).

When PPM Center is configured in cluster mode, the File Browser only displays the 
files of the <PPM_Home> directory that contain the PPM Center instance to which 
you are currently connected to.
If you want to access another <PPM_Home> of the cluster, you must manually 
connect to a PPM Center instance hosted in this <PPM_Home>> folder.
When zipping files and folders, you can only select files and folders located in the 
same folder. If you switch to another folder while some items are selected, the 
selected items are not included in the generated zip file.
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Cluster Configuration Considerations

When PPM Center is configured as a server cluster and there are multiple 
PPM Center instances in the same <PPM_Home>, you can access all the files 
of all the PPM Center instances located under the same <PPM_Home> folder 
as the instance you are connected to.

When selecting Logs or HotFix links in the bookmarks, you must manually 
choose the PPM instance you want to access. The folder is automatically 
displayed when the instance is selected.

Performance Concerns

The files listing can take many seconds if there are many thousands of files to 
list in the folder which contents are displayed, for example, the  
<PPM_Home>/cache folder, where images of PPM Charts are saved and only 
deleted after 7 days by default.

Note that there is no significant performance or memory impact on the PPM 
Server if you decide to download the entire contents of <PPM_Home> as a 
zipped file. This is a safe (though time-consuming) operation, but some 
temporary files might not be included in the resulting zip file if, for example, 
they are locked when you try to include them in the Zip file.

Administration Console SQL Runner

In earlier PPM Center versions, you could use the SQL Runner from the PPM 
Workbench to run queries directly against the PPM Center database schema. In 
PPM Center version 9.12, you access an enhanced SQL Runner through the 
Administration Console

To use the Administration Console version SQL Runner, you must have the 
access grants listed in Table 3-6, otherwise the SQL Runner menu is not visible 
to you in the Administration Console. 
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For information about configuring access grants, see the Installation and 
Administration Guide.

To access the Administration Console version SQL Runner feature:

1. Log on to PPM Center as an Administrator.

2. From the Open menu, select Administration > Administration Console. 

3. Under Administration Console actions, expand Administration Task, and 
then click SQL Runner.

Notable Enhancements with Administration Console SQL Runner

Though the main functionalities of SQL Runner is identical in the PPM 
WorkBench and Administration Console versions, there are some notable 
enhancements in the Administration Console.

SQL Runner enhancements in the Administration Console are as follows:

You can run SQL Statements that end with a semicolon (;). 

Results rows are numbered, and can be sorted and grouped within the 
results table by right-clicking the column headers.

Table 3-6. Required server tools access grant 

Access Grant Permissions

Sys Admin: Server Tools: 
Execute Admin Tools

Lets the user access the Administration Console and 
the server tools.

Sys Admin: Server Tools: 
Execute SQL Runner

Enables the SQL Runner menu in the Administration 
Console and lets the user run SQL queries from the 
Administration Console. Without this access grant, the 
SQL Runner menu is invisible.
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The Server Roundtrip duration represents the time spent between the PPM 
Application Server and the PPM Database, whereas in Workbench, it 
measures time spent between the PPM Workbench client and the PPM 
Server). However, in both cases, it is a good way to measure network 
latency.

For the same reason, the Ping DB button in Administration Console tests 
the speed between only the PPM Server and the database. Since a Web 
Interface is used here, the time spent between the web client and PPM 
Server is ignored.

You can now export the data to CSV format (by clicking the Open as CSV 
button, located to the right of the SQL Statement text area).

You can not ping the server by clicking Ping Server. This is not necessary 
with the Administration Console version SQL Runner since it runs on the 
PPM Server.

You can select the text in any cell of the results table and copy it to the 
clipboard.

Columns are automatically sized to accommodate their contents (and the 
column headers).
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If the maximum width of a column is reached but at least one of the records 
is truncated, the values in this column are shown as tooltip text when 
hovering.

Limitations

The same limitations with PPM WorkBench version of SQL Runner also apply 
to the Administration Console version of SQL Runner:

You can only run SELECT SQL Statements.

You can view a maximum of 1000 records. If more than 1000 records are 
retrieved, only the first 1000 are displayed.

The results do not include the contents of the BLOB and CLOB columns.

If a very large number of columns are retrieved, it may take a few seconds 
before the results are displayed.

When exporting the results to text or CSV format, the sorting and grouping 
of results is discarded, and only the raw results are exported.
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Gathering Support Information

As a PPM Center administrator, you can run the kSupport.sh script or access 
Administration Console version of the kSupport tool to gather the following 
information: 

Run SQL scripts provided by the HP Software Support team to gather 
specific database information for troubleshooting purpose. 

In Custom mode, a new option is now available, you can select it in order 
to collect specific database information for troubleshooting purpose. Then, 
you can choose to browse for the source SQL script file or the folder that 
contains SQL files (with .sql extension, case-insensitive) to run, or 
choose to enter manually or paste SQL script in a text area to run. In the 
server information collection summary page, you will be notified the 
number of SQL commands that are prohibited from running.

All of the SQL scripts you select to run are copied into the <kSupport_
Zip_ File>/ppmc/data directory, and the SQL script content you entered 
or pasted in the text area is concatenated into a CSV-formatted file named 
runsqls<Time_Stamp>.sql in the <kSupport_Zip_File>/ppmc/data 
directory.

You can run the kSupport tool in silent mode to gather specific database 
information in addition to the default information set.

To run SQL scripts in silent mode:
sh kSupport.sh -silent [-runsql <SQL_File_Path>]

List invalid PPM Center schema objects and invalid database indexes in 
the kSupport output database.html file. 

After you run the kSupport tool, two new sections are added in the 
<kSupport_zip_file>/ppmc/database.html file:

If the resulting SQL file is larger than 100 MB, a java.lang.OutOfMemory error 
may be logged in the <PPM_Home>/bin/support/ppmc/ksupport.log file. 
To correct the problem, split the source SQL script into multiple files, and then run 
them again in batches.
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o Selecting invalid objects in DB section lists object types and object 
names of all invalid objects in the database. Objects of the following 
types are listed: 

- SEQUENCE 
- PROCEDURE 
- PACKAGE 
- PACKAGE BODY 
- TRIGGER 
- TABLE 
- INDEX 
- VIEW 
- FUNCTION

o Selecting invalid indexes in DB section lists invalid database indexes. 
For example, some INDEX objects are of UNUSABLE status in user_
indexes but of VALID status in all_objects. 

Collect stinger.xml file into the conf folder of the kSupport output zip 
file.

Collect Bill of Materials (BOM) Information by performing BOM check.

The resulting Bill of Materials Information page contains three sections:

o Files missing - Files that should exist but missing.

o Files unwanted - Files that are not shipped with PPM. 

o Files changed - Files that are different from the ones shipped with 
PPM.

You can access the Bill of Materials Information page in the following 
ways:

o Locate and open the <kSupport_zip_file>/ppmc/index.html file, 
and then click Bill of Materials Information link.Or,

o Locate and open the <kSupport_zip_file>/ppmc/
md5filelist.html file.
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Running kSupport Tool from Administration Console

With PPM Center version 9.12, kSupport tool functionality is enhanced. You 
can now run the kSupport tool from the Administration Console.

To access the Administration Console version kSupport tool,

1. Log on to PPM Center as an Administrator.

2. From the Open menu, select Administration > Administration Console. 

3. Under the Administration Console actions, expand Support Task, and then 
click Generate Support Information.

Make sure that the size of SQL commands you enter in the text area does not exceed 
1 MB.
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Managing Hotfixes

As a PPM Center administrator, you can now use the support tools to deploy 
hotfixes and view hotfix deployment information. 

Deploying hotfixes with kDeploy.sh

To deploy a hotfix, run the following command:

sh kDeploy.sh -hotfix <Deployment_Hotfix>

where, 

-hotfix is the new parameter added to the kDeploy.sh script for 
deploying hotfixes

<Deployment_Hotfix> is the hotfix bundle name.

For example, if the bundle name is

912-debug-QCIM1L12345.jar

or

912-debug-QCIM1L12345-QCCR1L12346.jar

Then the corresponding deployment command is

sh kDeploy.sh -hotfix 912-debug-QCIM1L12345.jar

or

sh kDeploy.sh -hotfix 912-debug-QCIM1L12345-QCCR1L12346.jar
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Viewing hotfix deployment information

To view the hotfix deployment information collected, 

1. After running the kSupport tool, locate the link Patches Information in the 
resulting <kSupport_zip_file>/ppm/index.html file. 

2. Click the Patches Information link to open the patches.html file. The 
patches.html file contains the following sections:

o Selecting current PPM Center version

o Selecting patches applied info in current PPM Center version

o Selecting all the files that exist in the PPM Center file system

o Selecting all the other files applied in the current PPM Center instance, 
including SQL files and entities (packages, request types, requests and 
so on) that have been imported

o Selecting detailed information of patches that deployed in current PPM 
Center version

3. Check details under the section(s) you are interested in.
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Importing Requests from XML Files

With PPM Center version 9.12, this new feature is implemented for importing 
requests from XML files as well as exporting requests to XML files. This 
solution allows you to produce XML files electronically, helping you to 
complete any processes that may require requests in XML version.

With this feature, you will be able to perform the following tasks:

Importing Requests from XML Files

Exporting Requests to XML Files

Exporting Requests by Running the Special Command

New Settings Introduced

To implement the feature, some new settings are introduced.

Access Grant

A new access grant described below is added to enable users to import requests 
from XML files.

Table 3-7. New access grant introduced 

Access Grant Permissions

Demand Mgmt: Import 
Request XML

Enables the user to have the access to import 
requests from XML files.
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Validations

Table 3-8 lists three new validations introduced.

New Special Command

A new special command is introduced to help generate exported file for use by 
PPM Center report.

For details about how to use the special command, see Exporting Requests by 
Running the Special Command on page 148.

Report Type

A new report type (REFERENCE) Export Request Report is added.

Table 3-8. New validations introduced 

Validation Name Description

XML Exportable Request 
Template

Returns a list of XSLT templates that can be used 
for exporting requests to.

XML Exportable Request 
Template By Request Type

Non-configurable system level validation. Returns 
a list of XSLT templates based on a specific 
request type. 

XML Importable Request 
Template

Returns a list of XSLT templates that can be used 
for importing requests from.

Table 3-9. New special command introduced 

Special Command Description

ksc_export_request_as_xml

A system special command, used to export a request 
in either of the following two modes: 

Report mode, exports a request to report when the 
special command is set to true.
Request mode, exports a request and the URL of 
the exported file is updated to a field for the 
request when the special command is set to 
false.
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Importing Requests from XML Files

A new menu Import Request from XML is provided to import XML files as 
requests in PPM Center. The web page takes a XML file as well as the XSLT 
template as input, and imports the specified XML file to create a new request 
or update an existing request. 

Only users with the Demand Mgmt: Import Request XML access grant can 
perform the import task.

Configure an XML Importable Request Template

An XSLT template is necessary for importing XML files to create new 
requests or update existing requests. 

XSLT Template is a standard XSL file that is used to convert a XML file of 
user-defined format to an XML data file of PPM format as PPM Center can 
accept PPM format XML data file only. 

Developing an XSL File

If you want to import a request from an XML file with your own format, you 
need to develop an XSL file to convert the user-defined format file to a PPM 
format XML data file. 

You may refer to the following XSD file to develop your own XSL file: 

<?xml version="1.0" encoding="utf-8"?>
<xs:schema attributeFormDefault="unqualified" elementFormDefault="qualified" 
xmlns:xs="http://www.w3.org/2001/XMLSchema">
  <xs:element name="requests">
    <xs:complexType>
      <xs:sequence>
        <xs:element minOccurs="0" maxOccurs="unbounded" name="request">
          <xs:complexType>
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            <xs:sequence>
              <xs:element minOccurs="1" maxOccurs="1" name="requestType" 

type="xs:string"/>
              <xs:element minOccurs="0" maxOccurs="unbounded" name="field">
                <xs:complexType>
                  <xs:sequence>
                    <xs:element minOccurs="0" name="token" type="xs:string"/>
                    <xs:element minOccurs="0" name="tableValue">
                      <xs:complexType>
                        <xs:sequence>
                          <xs:element minOccurs="0" maxOccurs="unbounded" 

name="tableColumn">
                            <xs:complexType>
                              <xs:sequence>
                                <xs:element minOccurs="0" name="columnToken" 

type="xs:string"/>
                                <xs:element minOccurs="0" maxOccurs="unbounded" 

name="cellValue" type="xs:string"/>
                              </xs:sequence>
                            </xs:complexType>
                          </xs:element>
                        </xs:sequence>
                      </xs:complexType>
                    </xs:element>
                    <xs:element minOccurs="0" name="value" type="xs:string"/>
                  </xs:sequence>
                </xs:complexType>
              </xs:element>
            </xs:sequence>
          </xs:complexType>
        </xs:element>
      </xs:sequence>
      <xs:attribute name="date_format" type="xs:string" use="optional"/>
    </xs:complexType>
  </xs:element>
</xs:schema> 

If you import a request from an XML file without providing any XSL template, 
you need to ensure that your XML file conform with the format of PPM XML 
data file.

This XSD file defines the XML format accepted by PPM Center’s generic request 
import operation. When you develop an XSL template, make ensure that the XML file 
generated using the XSL template conforms to the format defined by the XSD file. Do 
not use this file as a template directly. 
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Configure an XSLT Template

When exporting a request, you can define an XSLT template to convert the raw 
data XML file to the desired format, such as XML, HTML, Text, and CSV. 
The XSLT template is a standard XSL file, it can convert the raw XML data 
file in PPM format. 

For more technical details about the format of PPM XML data file, see the 
XSD file described in Developing an XSL File on page 136.

To configure an XSLT template,

1. Log on to PPM Center.

2. On the Open menu, click Administration > Open Workbench.

The PPM Workbench opens.

3. On the shortcut bar, click Configuration > Validations.

The Validation Workbench opens.

4. Click List, then locate and open the XML Importable Request Template 
validation.

The Validation: XML Importable Request Template window opens.

5. Click New.

The Add Validation Value dialogue box opens to Value Information tab.

6. On the Value Information tab, provide values for required Code and 
Meaning fields and optional field Desc as necessary. 

The value of Meaning field will be displayed in the drop-down list for XSLT 
Template field on the Import Request from XML page.

7. To use this new template, for the Enabled? field, leave it selected.

8. If you want to set this new template default, select the checkbox for Default 
field. Otherwise, leave it empty.

For more information about the fields in the Add Validation Value 
dialogue box, see the Configuring Static List Validations section of the 
Commands, Tokens, and Validations Guide and Reference.
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9. Click the User Data tab.

10. Click Add.

The Add Document dialog box opens.

11. Do the following:

a. Click Browse to locate and select the XSLT file you want to add. 
Normally it is the file you developed in Developing an XSL File 
on page 136.

b. In the Description field, you can type a short description for the XSLT 
file.

c. click Add.

12. To add more values and keep the Add Validation Value window open, 
click Add.

13. To save your changes and close the window, click OK.
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Import an XML File to Create a New Request

To import an XML file to create a new request,

1. Log on to PPM Center.

2. On the Open menu, click Demand Management > Import Request From 
XML. 

The Import Request from XML page opens.

3. For XML File to Import field, click Browse to locate and select the XML file 
you want to import.

4. For XSLT Template field, click the drop-down button to select the XSLT 
template you want to associate with the imported XML file. 

XSLT templates are configured in PPM Workbench by admin user. For 
information about configuring XSLT templates, see Configure an XML 
Importable Request Template on page 136.

5. Select Create a new request. 

6. (Optional) If it is the first time for you to import an XML file, you may 
want to run a test before you perform the formal import. In this case, click 
Test button.
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It tests if the XML file can be imported successfully. 

If the test result page shows “Test completed successfully”, 
proceed to step 7. 

If “Error parsing the incoming xml file...”, troubleshoot the 
cause and make sure the XML is ready for import.

7. Click Import button. 

8. Check the import result and the ID of the new request created. 

9. Click Back to return to the Import Request from XML page.

Import an XML File to Update an Existing Request

To import an XML file to update an existing request,

1. Log on to PPM Center.

2. On the Open menu, click Demand Management > Import Request From 
XML. 

The Import Request from XML page opens.

3. For XML File to Import field, click Browse to locate and select the XML file 
you want to import.

4. For XSLT Template field, click the drop-down button to select the XSLT 
template you want to associate with the imported XML file. 

XSLT templates are configured in PPM Workbench by admin user. For 
information about configuring XSLT templates, see Configure an XML 
Importable Request Template.

5. Select Update an existing request. 

This enables Request ID field. 

6. For Request ID field, click the selector icon. 

A “Test/Import completed successfully” message will be displayed 
even when the XML imported does not match the XSL template selected, but no 
corresponding request ID will be generated and the log will show “pass:0”. 
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The popup window lists all available choices. Enter search filter(s) to 
locate the desired request ID or select a value from the list. 

7. (Optional) If it is the first time for you to import an XML file, you may 
want to run a test before you perform the formal import. In this case, click 
Test button.

It tests if the XML file can be imported successfully. 

If the test result page shows “Test completed successfully”, 
proceed to step 8. 

If “Error parsing the incoming xml file...”, troubleshoot the 
cause and make sure the XML is ready for import.

8. Click Import button. 

9. Check the import result and the ID of the new request created. 

10. Click Back to return to the Import Request from XML page.

A “Test/Import completed successfully” message will be displayed 
even when the XML imported does not match the XSL template selected, but no 
corresponding request ID will be generated and the log will show “pass:0”.
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Exporting Requests to XML Files

Exporting a request to an XML file of a specific format involves the following 
tasks,

1. Enable Report Type (REFERENCE) Export Request Report

2. Configure an XML Exportable Request Template

3. Export a Request to an XML File in Specific Format

Enable Report Type (REFERENCE) Export Request Report

To facilitate exporting a request to XML of a specific format, a new report type 
(REFERENCE) Export Request Report is added. This report type enables you to 
export a request report to a specific format.

To enable the report type,

1. Log on to PPM Center and launch the PPM Workbench.

2. On the shortcut bar, click Configuration > Report Types.

The Report Type Workbench opens.

3. Click List, then locate and select report type (REFERENCE) Export Request 
Report.

4. Click Copy.

The Copy Report Type window opens.

5. Type a Report Type Name. For example, Sample Report.

6. Click Copy to continue.

7. When prompted, click Yes.
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The Report Type: <Report Type Name> window opens.

8. For the Enabled? field, select Yes.

9. Configure other fields or options as necessary.

10. Click OK.

Configure an XML Exportable Request Template

To configure a specific format template for exporting a request to,

1. From the Validations Workbench, select validation XML Exportable 
Request Template.

2. Click New.

The Add Validation Value dialogue box opens to Value Information tab.

3. On the Value Information tab, provide values for required Code and 
Meaning fields and optional field Desc as necessary. 

The value of Meaning field will be displayed in the drop-down list for XSLT 
Template field on the Import Request from XML page.

4. To use this new template, for the Enabled? field, leave it selected.

5. If you want to set this new template default, select the checkbox for Default 
field. Otherwise, leave it empty.
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For more information about the fields in the Add Validation Value 
dialogue box, see the Configuring Static List Validations section of the 
Commands, Tokens, and Validations Guide and Reference.

6. Click the User Data tab.

7. Do the following:

a. In the Request Type ID field, select a request type ID using the auto-
complete icon.

b. In the Content Type field, you can type a short description of the 
request type.

c. For XSLT File field, click Add.

The Add Document dialog box opens.

i. Click Browse to locate and select the XSLT file you want to add.

ii. In the Description field, you can type a short description for the 
XSLT file.

iii. click Add.

8. To add more values and keep the Add Validation Value window open, 
click Add.

9. To save your changes and close the window, click OK.
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Export a Request to an XML File in Specific Format

To create a report and export a request to XML in specific format,

1. Log on to PPM Center.

2. On the Open menu, click Reports > Create Report.

The Submit New Report page opens.

3. From the Select Report by Category section:

For Report Category, select the appropriate category.

Click the link for the newly created report type.

The Submit Report: <Report Name> window opens.

4. Under the Report Parameters section, 

a. In the Request ID field, specify a request number by using the selector 
icon.
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b. In the Template field, select the template you created in Configure an 
XML Exportable Request Template on page 144.

5. Click Submit.

The Submit Report window opens. The status is refreshed until the report is 
complete.

6. The completed XML report is displayed in a separate window.
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Exporting Requests by Running the Special Command

In general, a request is exported via the PPM Center report. A new special 
command (ksc_export_request_as_xml) is introduced to generate the 
exported file for the report. Setting true indicates report mode.

Report mode example:

ksc_export_request_as_xml [P.TARGET_REQUEST] “[P.TEMPLATE]” 
true [RP.REPORT_SUBMISSION_ID] 

where, 

[P.TARGET_REQUEST] - ID of the request to be exported.

[P.TEMPLATE]  - The template code.

true - Report mode, indicates that the result is exported to report.

[RP.REPORT_SUBMISSION_ID] - Report submission ID.

You can also use this special command in request mode by integrating it into 
your own workflows. In this case, the special command generates the exported 
file and pastes the URL of the exported file to a corresponding field on a 
specified request. A URL field is necessary for this mode because it shows 
more readable file name while referring to the full address of the exported file. 

Request mode example:

ksc_export_request_as_xml [P.TARGET_REQUEST] “[P.TEMPLATE]” 
false [REQ.REQUEST_ID] [REQD.P.RESULT]

where, 

[P.TARGET_REQUEST] - ID of the request to be exported.

[P.TEMPLATE]  - The template code.

false - Non-report mode, indicates that the URL of the exported file is 
updated to an appropriate field of the request.

[REQ.REQUEST_ID] - ID of the request that contains URL of the exported file.

[REQD.P.RESULT] - The field token that contains the URL of the exported file.
148 Chapter 3



Attaching Impact Analysis Report for CIs to a Request in PDF format

In addition to viewing Universal CMDB Impact Analysis Report online by 
clicking the Launch HP Universal CMDB Impact Analysis button on the request 
page, you can also attach a Universal CMDB Impact Analysis Report for CIs 
in PDF format to requests in PPM Center.

When you use the special command in a workflow to export a request, make sure to 
set Workflow Scope to Requests in the corresponding execution step. Otherwise 
you will not get an exported file successfully.

This integration solution applies to Universal CMDB version 8.06 only.
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New and Modified Settings

To enable this integration, the following settings are modified or introduced:

Universal CMDB Impact Analysis field group: This field group is modified 
to include a new field Report. When the field group is enabled for a request 
type, an Impact Analysis Report field for report attachment will be added to 
any request you create based on the request type.

ksc_download_ucmdb_impactreport: A new system special command 
added for downloading the Universal CMDB Impact Analysis Report. 

The following three optional values are available for advanced 
configuration purpose. You can append them to the special command, 
which will offer you the flexibility of setting filters for the report to be 
generated on the request page. 

o -CATEGORY "<value>"

o -SEVERITY "<value>"

o -LANG "<value>"

If no values are set for the command, the values in server.conf will take 
effect. If no values are found in the server.conf file, the following 
Universal CMDB built-in default values will take effect:

Examples:

o To invoke the special command directly without any parameters:

ksc_download_ucmdb_impactreport

o To invoke the special command with parameters:

ksc_download_ucmdb_impactreport -CATEGORY "change" -
SEVERITY "plan" -LANG "fr"

Parameter Value

Category Change

Severity New

Lang en
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o To invoke the special command with token parameters:

ksc_download_ucmdb_impactreport -CATEGORY "[REQD.P.<token 
name>]"

New server.conf parameters

Table 3-10 lists new parameters that are added to the server.conf 
configuration file to enable the integration.

 

The parameter names listed in this table are shortened versions of the actual 
names, all of which start with the string com.kintana.core.server. For 
example, the full name of the CMQC_SUPPORT_REQUEST_ID parameter is 
com.kintana.core.server.CMQC_SUPPORT_REQUEST_ID. To add a 
parameter to the server.conf file, you must use its full name.

Table 3-10. New server.conf parameters 

Parameter Name Brief Description

IMPACT_ANALYSIS_
REPORT_CATEGORY

Sets default category value for the impact analysis 
report, for example, change or operation.

IMPACT_ANALYSIS_
REPORT_SEVERITY

Sets default severity value for the impact analysis 
report, for example, MINOR(3). For available values, 
see Table 3-11.

IMPACT_ANALYSIS_
REPORT_LANGUAGE

Sets default language code, for example, fr. For 
supported languages and codes, see Table 3-12.

ONLINE_IMPACT_
ANALYSIS_REPORT

Enable or disable online impact analysis report. By 
default, it is enabled.

Table 3-11. Universal CMDB category and severity parameters (page 1 of 2)

Category
Severity

ID Code

Change

0 NO CHANGE

1 PLAN

2 NEW

3 CANCEL
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Operation

0 NORMAL

1 WARNING(1)

2 WARNING(2)

3 MINOR(3)

4 MINOR(4)

5 MINOR(5)

6 MINOR(6)

7 MAJOR(7)

8 MAJOR(8)

9 CRITICAL

Table 3-12. Languages supported for the Impact Analysis Report 

Description Code

GERMAN de

ENGLISH en 

SPANISH es

FRENCH fr

ITALIAN it

JAPANESE ja

KOREAN ko

BRAZILIAN PORTUGUESE pt

RUSSIAN ru

SIMPLIFIED CHINESE zh

Table 3-11. Universal CMDB category and severity parameters (page 2 of 2)

Category
Severity

ID Code
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Basic Configuration Example

For a basic configuration, default values will be used.

1. In PPM Workbench, create a new request header type by going to Demand 
Mgmt > Request Header Type > New Request Header Type. Enable 
Universal CMDB Impact Analysis field group, and set Display attribute for 
both Report and CI List fields to Yes.

2. Create a new request type using the request header type you just created. 
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3. Create a workflow execution step that invokes the special command for 
downloading Universal CMDB Impact Analysis Report: ksc_download_
ucmdb_impactreport.

a. In PPM Workbench, click Configuration > Workflows.

b. In the Workflow Step Sources window, under Workflow Step Sources, 
select Executions, and click New. The Execution window opens.

c. Provide a name for the execution step, select Workflow Step Commands 
for Execution Type field, and click New Cmd. In the New Command 
window, enter the new system special command, and click OK. 

d. Save the Execution step.
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4. Create a new workflow.

a. In the Workflow Workbench window, click New Workflow. In the 
Workflow window that opens, provide a name, and select Requests for 
the Workflow Scope field, and select Yes for Enabled.

b. Go to Layout tab, drag the workflow execution step you just created to 
the Layout window, set Security, configure the transitions. 

c. Save the workflow.

5. In PPM Center, create a Universal CMDB request based on the request 
type you created in step 2 on page 153. 

a. For Workflow field, select the workflow you created earlier. 

b. Under Universal CMDB Impact Analysis section, click Select 
Configuration Items and add CIs for which you need to generate a 
report.
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c. Provide values for other fields as necessary and submit the request. 

6. Open the request and click Execute Now to execute the command.

7. The Impact Analysis Report is attached to the request in PDF format, with 
automatically generated file name of <YYYYMMDDHHMMSS>.pdf.

8. You may click the PDF report link to view the report.
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Advanced Configuration Example

You can choose to pass optional category, severity, and language 
parameters for Universal CMDB Impact Analysis Report to the system special 
command. You can also pass them by token.

1. Create new validations for request type field options.

a. Category
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b. Severity

(Optional) You can create an auto-complete list to implement severity 
cascade on the basis of the above ucmdbSeverity validation.
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c. Language

2. Create a Universal CMDB request type, with three request type fields for 
Category, Severity, and Language.
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3. Create a workflow execution step that invokes the special command for 
downloading Universal CMDB Impact Analysis Report with advanced 
options: 
ksc_download_ucmdb_impactreport -CATEGORY 
"[REQD.P.CATEGORY]" -SEVERITY "[REQD.P.SEVERITY]" -LANG 
"[REQD.P.LANGUAGE]"

4. Create a workflow with the above workflow execution step, configure the 
workflow transitions, and save the workflow.

Enter the command manually. Copying and pasting the command may introduce 
unwanted characters, which may result in potential execution error.
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5. In PPM Center, create a Universal CMDB request using the request type 
you just created. For Workflow field, select the one you created earlier. 
Select configuration items in order to generate an impact analysis report, 
and submit the request.

6. Open the request, execute the first workflow execution step.
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7. Go to the Request Type Fields section of the request, set desired values for 
Category, Severity, and Language fields as filters for the report to be 
generated, then click Execute Now to execute the second workflow 
execution step. 

8. The impact analysis report is attached to Impact Analysis Report field, with 
automatically generated file name of <YYYYMMDDHHMMSS>.pdf.

9. You may click the PDF file link to view the report.

10. (Optional) To generate a report for more CIs, you can click the Redo CI 
Selection workflow step in the Available Actions section to run the 
workflow again.
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Certifications

The following certifications are included in PPM Center version 9.12:

Microsoft Windows Server 2008 R1 SP2, Standard and Enterprise Edition 
(both 32- and 64-bit) as PPM Center server platforms

Microsoft Windows Server 2008 R2, Standard and Enterprise Edition 
(64-bit) as PPM Center server platforms

Microsoft Hyper-V running Microsoft Windows 2008 SP2 Enterprise 
Edition (32-bit) and Red Hat Enterprise Linux AS 4.0 (64-bit) platforms as 
a virtualization server platform

Oracle 11.2.0.2.0 (RAC and Non-RAC) support for all PPM Server 
platforms

HP Service Manager version 9.21 support for PPM Center integrations 
with HP Service Manager (ALM and SM RFC)

HP Quality Center version 11.00 and HP Application Lifecycle 
Management 11.00 support for CMQC solution:

Support for HP Universal CMDB versions 8.06, 9.02, and 9.03 when used 
for impact analysis of PPM Center requests (using ALM) and for service 
portfolio

Support for use of HP Deployment Management Extension for Oracle 
E-Business Suite with Oracle E-Business Suite version 12.1.3 (requires 
patch PPMC_00098 for the Extension)

Support for Microsoft Office Project 2010 

64-bit JDK support for 64-bit Microsoft 2008 R2 Enterprise Edition and 
64-bit Red Hat Enterprise Linux AS 5.0, Updates 1 through 6

Support for tightening the access to the following packages for public roles 
in Oracle:

o HTTPURITYPE

o UTL_INADDR

o ALL_SOURCE

For details, see the System Requirements and Compatibility Matrix.
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Fixes

The following fixes are included in PPM Center version 9.12:

CM Tools

Costing

Tracking Number Problem Description

4621511734 A NullPointerException that resembles the following is generated in the 
server log file when you shut down the PPM Server.
server:JBoss Shutdown Hook:com.kintana.core.server:2010/10/
25-17:06:59.404 MSD: java.lang.NullPointerException
at 
com.kintana.core.server.cluster.MulticastAgent.send(Multicas
tAgent.java:175)
at 
com.kintana.core.server.cluster.MulticastAgent.send(Multicas
tAgent.java:182)
at 
com.kintana.core.server.ISIntegrityServerImpl.cleanupForShut
down(ISIntegrityServerImpl.java:1005)
at 
com.kintana.core.web.listener.ServerStartListener.contextDes
troyed(ServerStartListener.java:69)
(QCCR1L29039)

Tracking Number Problem Description

4627341892 You have a proposal or asset that is saved as a draft before being submitted. When 
you try to defect the proposal or asset, the following error message occurs:
Error 500: Unknown error
(QCCR1L40565)

4628543623 Performance issues occur when you try to delete an entity in the Financial 
Management module. In PPM Center version 9.12, the corresponding SQL 
statements are optimized to improve the performance. (QCCR1L41034)
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4625598236 If you open the Project Settings page when the Cost and Effort policy is locked, and 
click on Save or Done, the Financial Management settings for the project get reset 
to default values. (The ACTUAL_ROLLUP_CODE field in the FM_FORECAST_
ACTUALS table is set to MANUAL.) (QCCR1L40549)

4615317678 A program manager receives the following error message when clicking Add 
Forecast and Actuals on an editable financial summary for a program:
The following is a stack trace of the exception:
com.kintana.core.server.RuntimeBaseException
(QCCR1L39690)

4618543179 If the system has a large number of records in the Pending Cost Rollup table, the 
Project Planned Values Update service could cause a high memory consumption, 
resulting in the “Out of Memory” error. (QCCR1L39777)

4615481812 As pending rollups tables keep growing, the notifications cleanup service could 
cause the “Out of Memory” error on a services node. When this problem occurs, the 
following error is generated in the server log:
spRuntimeContext[/itg.war]:org.jboss.web.localhost.Engine:2010/06/02-
23:18:01.872 BST: StandardContext[/itg]Background compile failed
server:Cost Rollup Service:SystemOut:2010/06/02-23:18:01.875 BST: Exception 
in thread "ContainerBackgroundProcessor[StandardEngine[jboss.web]]" 
Exception in thread 
"ContainerBackgroundProcessor[StandardEngine[jboss.web]]" Exception in 
thread "Cost Rollup Service"
server:FX Rate Update Service:com.kintana.services:2010/06/02-23:18:01.875 
BST: java.lang.OutOfMemoryError at 
oracle.sql.CharacterSetFactoryThin.make(CharacterSetFactoryThin.java:111) at 
oracle.sql.CharacterSet.make(CharacterSet.java:441)

(QCCR1L39736)

4619456592 In Financial Web services, the result of the searchCostRules operation misses 
one record.
This problem occurs if more than 1,000 records are expected to return. 
(QCCR1L39745)

4620103913 On the Add Cost Line page, if you fill a user data field with any keyword containing 
the ampersand (&) character, it is converted to “&amp;”. (QCCR1L39749)

4617749271 You enable the tracking of capitalized costs for a project. However, when you try to 
add a position to the corresponding staffing profile, the Expense Type options are 
disabled (grayed out). This problem occurs if the Cost and Effort policy is locked. 
(QCCR1L39750)

4617988793 When you change the Display Only attribute of a Forecast Line text field user data 
from "Never" to "Always", the text field does not display any value even if there is 
data in the User Data column in the database. (QCCR1L39757)

Tracking Number Problem Description
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4619493829 You enter forecast values, and then save the change. However, the forecast values 
displayed in the financial summary could be inconsistent with the values you 
entered.
This problem occurs if you click the Save and Done buttons multiple times. 
(QCCR1L39760)

4622039783 If a staffing profile is required during the project creation process, the forecasted 
labor costs from the staffing profile do not appear in the Financial Summary. This 
problem occurs even if you enable the “Calculated forecasted labor costs from the 
staffing profile” option. (QCCR1L39899)

4622238693 After you click OK in a cost line, values in the Financial Summary Cost user data 
fields could be:

Changed to zero.
Displayed in an unexpected format.

(QCCR1L39903)

4616924994 If you disable a project resource, his or her actuals submitted and approved through 
the time sheets will not be rolled up to the corresponding project. Therefore, the 
system will show less actuals than expected for the project. (QCCR1L39711)

3603716263 If a project has tasks with a deep hierarchy (for example, four or more levels deep), 
the Cost Rollup Service does not calculate the Cost Performance Index (CPI) and 
Scheduled Performance Index (SPI) values correctly for the project. 
(QCCR1L39667)

Tracking Number Problem Description
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Dashboard

4610830017 The following error messages occur on your services node at the beginning of every 
hour:
Error Message 1:
Cost Rate Rule Update Service:org.hibernate.LazyInitializationException:2010/
02/17
-11:00:13.621 CST: failed to lazily initialize a collection of role: 
com.mercury.itg.core.cost.impl.CostRuleImpl.costRates, no session or session 
was closed

Error Message 2:
Cost Rate Rule Update Service:com.mercury.itg.core.cost.util.CostUtils:2010/
02/17-
11:00:13.374 CST: Unable to synchronize staffing profile with budget, 
staffing profile id = 30227

(QCCR1L39811)

4622041074 The project labor cost does not calculate on the financial summary. This problem 
occurs when the project is created from another project. When a project spawns a 
new project, the synchronization setting between the financial summary and the 
staffing profile is not carried over to the new project.
(QCCR1L39900)

Tracking Number Problem Description

Tracking Number Problem Description

4626080315 When you import and export dashboard entities between different environments, 
one or more (OOTB) portlets in the dashboard may lose some settings. 
(QCCR1L40546)

4628536037 After upgrading to 9.10, the graph type portlets, such as bar charts, bubble charts, 
do not display dollar amounts correctly. For example, the bubble chart in version 
7.5 shows numbers like $5,000,000.00, and $10,000,000.00. However, in version 
9.10, the same numbers in a bubble chart are displayed as 5E7, and 1E8. 
(QCCR1L41195)

4606703773 You receive the following error message when clicking the Back button on a drill-
down portlet:
Cannot load this portlet's data due to a misconfigured SQL 
Query. (KNTA-10836) Please contact your administrator with 
the following information:
--The following error is thrown by the database:
ORA-00907: missing right parenthesis
(QCCR1L24482)
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4618644890, 
4614316964, 
4618427650, 
4617151876, 
4627312248

In PPM Center 8.00 Service Pack 1, you receive the following error message when 
trying to open the Project Summary page for a project:
Cannot forward after response has been committed
This problem occurs when PPM Center is integrated with an external Web server 
and has generic single sign-on enabled. (QCCR1L41048)

4607749400 Health indicators are not correctly displayed when you export a dashboard page to 
PDF. This problem occurs if HTTPS is used between your browser and the Web 
server. (QCCR1L29336)

4617973018 You export a portlet to PDF. However, the font size in the exported PDF file gets 
smaller because long texts are not wrapped. This issue makes the information very 
hard to read. (QCCR1L39770)

4619019727 The following error occurs when you deploy PPM Center version 8.02:
SQLM: ORA-20011: The following error occured -2292 : ORA-02292: integrity 
constraint (ITGADM.DSH_AUTH_GROUP_FK2) violated - child record found at dsh_
portlet_defs_801_SP1_2.sql
ORA-06512: at line 148 

(QCCR1L39753)

4604650751 After creating a Pivot Table portlet on an instance that has a language pack 
installed, you find that the numbers in the portlet are still displayed in the US 
format. (A comma (,) is used as the group separator, and a period (.) is used as the 
decimal separator.)
If you change the display style of the portlet from Pivot Table to List, the numbers 
use the expected format. (QCCR1L39685)

4609079435 One or more tokens in a validation could be unparseable. This problem make the 
PPM Module Migrator fails to migrate custom modules. (QCCR1L39697)

4613257346 Your portlet data source has more than one columns with the Currency column 
type. However, when viewing the portlet, you find only one of the columns has the 
currency symbol. (QCCR1L39705)

4613768652 You receive the following error message when importing a portlet definition:
Dashboard object import failed: (KNTA-11145)  Message name: 
MIG_DASHBOARD_IMPORT_FAILED
This problem occurs if the data source of the portlet definition has more than one 
columns. (QCCR1L39696)

4617758606; 
4613768652

You have a portlet definition that contains JavaScript to calculate the column value 
and the tooltip value. However, when you import the portlet definition, the 
calculated values for the column and tooltip are missing. (QCCR1L39698)

Tracking Number Problem Description
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4620128479; 
4619450282

After PPM Center version 8.02 is deployed on a server with multiple PPM nodes, 
the dashboard.war file is not exploded on all the nodes in the cluster. 
(QCCR1L39751)

4611904940 No portlet is displayed in the Choose Portlets section of the PDF Settings page 
when you try to export a dashboard page to PDF. The generated PDF file is blank.
This problem occurs if you select a portlet, instead of the corresponding dashboard 
page, on the Personalize Dashboard page before the export. (QCCR1L39887)

4603578806 The following error message appears in the server log when users open a bar/pie 
chart portlet:
cannot deal with property named annotation
(QCCR1L39936)

2605186572 Portlet navigation (the back and forward arrows on the top right corner of the 
details page) cannot navigate to the items that are not listed on the current page. 
For example, you create a Request List portlet that contains 10 requests, and you 
configure the portlet to display 5 requests per page. In this case, by using the 
portlet navigation, you can only access the first 5 requests. (QCCR1L39668)

4608734916 After you export portlets containing cells that have large data, the data in the 
exported spreadsheets will be incorrectly displayed as a string of pound signs 
(#####). (QCCR1L39763)

4615005593 If PPM Center is integrated with EMC Documentum (DCTM), when documents 
attached to a project, a request or other entities in PPM Center are saved into the 
DCTM repository, corresponding folders will be created for them in the repository, 
and the project type name, project name or request type name will become a part 
of the folder name. However, the slash character ("/") is not allowed in the DCTM 
repository folder names. So, if the project type name, project name or request type 
name contains slash character(s), the documents attached to them will fail to be 
saved into the repository. (QCCR1L39681) 

Tracking Number Problem Description
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Documentation

Global ID Problem Description

4623622085 ENABLE_INTERFACE_CLEANUP parameter is deleted from the server.conf 
file, but the Open Interface Guide and Reference version 9.10 still refers to it on 
pages 34, 41, 57, 61, 82, 102, and 129.
All occurrences of the ENABLE_INTERFACE_CLEANUP parameter should be 
removed from the guide. (QCCR1L39575)

4617369649 Reference to the KCRT_FG_PFM_PROJECT_INT table should have been 
removed from the page 64 and pages 139~141 of the Open Interface Guide and 
Reference version 9.10 since the Open Interface does not support creation of 
projects starting from PPM version 7.0. (QCCR1L39568)

4612023243 Table description for FM_EXCHANGE_RATES table needs to be updated in 
version 9.10 of the Data Model Guide. (QCCR1L39565)

N/A Entity Relationship Diagrams in the guide need to be cleaned up. (QCCR1L39114)

4627341495 PM_PROGRAM_PROJECTS table is removed from PPM Center 9.10 schema and 
PGM_PROGRAM_CONTENT table is used for Program-Project relation, but the 
HP Program Management interface diagram in the Data Model Guide still shows 
PM_PROGRAM_PROJECTS table. (QCCR1L40543)

4624879873 Issue with maximum length of VARCHAR2 values in Data Type column of PPM 
Center database data tables, which should be character-length instead of 
byte-length. (QCCR1L39400)

4624752377 Unused PPM Center table KNTA_APP_SERVER_DETAILS documented in 
version 9.10 of the Data Model Guide. (QCCR1L37467)

4624586252 Need better documentation on how to customize menu options in version 9.10 of 
the Customizing the Standard Interface guide.
For information about adding and changing a menu item, see New Information for 
Customizing the Standard Interface on page 220. (QCCR1L41618)

N/A Microsoft Windows Server 2008 R2 (both 32- and 64-bit) is not yet certified as PPM 
Server platform for PPM Center versions 9.10 and 9.11. However, the System 
Requirements and Compatibility Matrix guide of version 9.10 indicates support for it 
on page 23. (QCCR1L41409)
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HP Demand Management

Tracking Number Problem Description

4624064175 For a date field with the component type Date Field (Long), the selection ranges 
from January 1970. However, if you manually enter a date, the system does not fire 
any event to validate the value entered when you tab out from the field. For 
example, in the date field, you can enter "21 December 0210", which is not a valid 
value. (QCCR1L29829)

4614999929 On the advanced search page of a request type, the order of fields in the layout 
differs from the order of fields in the layout created in workbench. (QCCR1L26644)

4622689292 In version 9.11, field-level security does not function at the request header type 
level. (QCCR1L29693)

4624748715 You use field level security to specify the users that are allowed to view or edit a 
certain field in a request type. However, if a user has the Edit All Requests access 
grant, the user will be able to view and edit that field even if the user does not 
belong to the group of users you specified in field level security. (QCCR1L39388)

4621511247 When you enter values in a text area table component from a request directly, the 
changes are successfully saved with the following notification message:
Changes have been made and will be applied upon save. Total 
number of rows after save:1 Entry
However, if the text area field is required and you enter values on the reconfirming 
page, the text in the notification message will be displayed incorrectly as the 
following:
Changes have been made and will be applied upon save. Total 
number of rows after save:1 ???ENTRY_TXT??? 
(QCCR1L28808)

4623436863 The Assignment Queue portlet has no preferences in PPM Center version 9.1x. 
(QCCR1L29598)

4622452489 The value you entered in the Assigned to field is not added to the Resources 
section of a request. This problem occurs when the following conditions are true:

The Assign to field is required for a certain status.
You enter value for the Assigned to field via the Reconfirm page.

(QCCR1L29317)

4622570183 You add a resource to the Resources section of a request and enter the scheduled 
effort for the resource. When submitting this request, you receive the 
NumberFormatException error. (QCCR1L29515)
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4000957858 Inconsistent Request Type naming convention, description for Creation Action 
Name field is not correct on page 159 if version 9.10 of the HP Demand 
Management Configuration Guide.
The description is revised to the follows: 
Optional. You may just leave it empty.
You may also provide a value for it, which is displayed under the Create Based On 
Desired Action section as Most Recently Created on the Create New Request page 
instead of the request type name itself. (QCCR1L39092)

4619003101 The fact that UI-rule will not be triggered upon field change in an execution step in 
the Workflow should be documented.
The following note is added to the document under the Important Considerations 
for Configuring Advanced UI Rules section:
Using special commands, for example, ksc_store, in a workflow execution step 
to change field value will not trigger rules. (QCCR1L39776)

4620003610

4619765121

The HP Demand Management Configuration Guide needs an example for using 
PL/SQL function in a rule.
Examples for using PL/SQL function in a rule are added as Appendix B to the 
document. See details in the updated HP Demand Management Configuration 
Guide of version 9.10. (QCCR1L28369, QCCR1L39740)

4605299889 If you create an advanced rule using Apply on creation rule event, you can add a 
Dependencies field, although the field may not work actually. 
Now the issue is fixed and the Dependencies field works properly on Apply on 
creation rule. (QCCR1L39691)

4607698640 ORA-06502: PL/SQL: numeric or value error: character string buffer too small 
{KCRT_AUDIT-3031} (KNTA-10498)
As a result to the fix, the following text on p164 of HP Demand Management 
Configuration Guide can be removed:
The total number of fields in a request type cannot exceed 359 if you enabled any 
one of the following attributes in any field:

Notes History
Transaction History

(QCCR1L39874)
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N/A When applying advanced rules on requests with "Printable Version" and the Print 
function, the previewed and printed data does not match with what is displayed on 
the screen. 
Now rules can be executed on the printable version of Request Details, but with the 
following limitations: 

Only SQL rules and UI Rule setFieldVisible()will be executed.
Only Apply on page load rule event is supported.
The printable version should be opened from Request Details page instead of by 
entering the URL address directly.

(QCCR1L39873)

4624457868 Two request types or request header types have almost the same field prompt 
except that one contains a colon (:), but the other does not (such as "Approval:" 
and "Approval"), or field prompts only have differences in cases (such as 
"Approval" and "approval"). In this case, you receive the following error message 
when updating the value of these fields in the corresponding requests:
ORA-01427: single-row subquery returns more than one row ORA-06512: at 
"KINTANA.KCRT_AUDIT", line 1321 ORA-06512: at "KINTANA.KCRT_REQUEST_DET_
AUDIT_34115_1", line 81 ORA-04088: error during execution of trigger 

(QCCR1L39993)

4614577718 When a field in the Request List portlet has a token with more than 28 characters, 
the column for that field does not show any data. (QCCR1L39710)

4616146232 PPM Center does not perform any authorization over the Web service operations 
to get, update and delete a request. Therefore, by using Web services, users can 
execute the operations that they are not allowed to perform in user interfaces. 
(QCCR1L39694)

4616220046 A proposal contains a table component that has a field with the Auto Complete List 
validation. After you create a project from the proposal, the data in the Auto 
Complete List field is not copied to the project. (QCCR1L39788)

4614758147 The ksc_copy_request special command returns the following error when trying 
to copy a request that is used in multiple languages:
com.kintana.core.openapi.OpenAPIException: Request with ID 0 was not found 
in the system.  Import was not performed.

(QCCR1L39764)
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4616011831 If a request that has a financial summary throws the following exception when 
being saved, some tables in the database will be locked.
QuartzScheduler_scheduler-livpswapppm1.r1-
core.r1.aig.net1279415976242_
ClusterManager:org.springframework.scheduling.quartz.LocalDa
taSourceJobStore:2010/07/24-23:18:53.067 EDT: ClusterManager: 
Error managing cluster: Failure obtaining db row lock: ORA-
00060: deadlock detected while waiting for resource
(QCCR1L39767)

4618092273 You create a workflow by copying the DEM - Database Refresh workflow. 
However, you receive the following error message when reaching the SLA_CLOSE 
and SET_REJECTED phases.
REQUEST_SATISFIED_ON="<Date> <Time>", "<Date> <Time>"
ERROR while setting Token.
The token attempting to be stored is invalid. Please verify that the token 
name is correct. (KNTA - 10234) 

(QCCR1L39738)

4615712813 For a Decision step with “Decisions Required” field marked as “All,” you will receive 
a “No Recipients” error in the transaction details of the request. This problem 
happens if the step is in a sub-workflow. (QCCR1L39739)

4619492465 After you cancel a project by click the Cancel Request button at the bottom of the 
project, the corresponding work plan is still active. And you cannot cancel this 
active work plan. (QCCR1L39742)

4613270587 After clicking the selector icon for the Request Type field on Search Requests 
page, the popup window displays all available request types, which need to be 
restricted to authorized users only. (QCCR1L26752)

4619123939 The following error occurs when you try to exporting requests by using the  
ksc_export_request special command in a workflow step:
com.mercury.itg.ws.dm.integration. ksc_export_request
java.lang.ClassNotFoundException: 
com.mercury.itg.ws.dm.integration.DMOutboundWSImpl
at 
org.apache.catalina.loader.WebappClassLoader.loadClass(WebappClassLoader.jav
a:1355)
at 
org.apache.catalina.loader.WebappClassLoader.loadClass(WebappClassLoader.jav
a:1201)
at java.lang.ClassLoader.loadClassInternal(ClassLoader.java:320)
at java.lang.Class.forName0(Native Method)
at java.lang.Class.forName(Class.java:169)

(QCCR1L39743)

4614265052 On a request page, field names in different sections, which have the same number 
of columns, are not vertically aligned. This issue also occurs in the corresponding 
field values. (QCCR1L39701)
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4605299889 You create a UI rule that is supposed to be triggered when two Date/Time fields are 
not equal. However this UI rule is also triggered if the two Date/Time fields are 
empty. (QCCR1L39691)

4618252264 You create a rule that is supposed to be triggered when the Date/Time value in one 
field is before the Date/Time value in another field. However, the system does not 
take the Time part into account when comparing the two fields. As a result, if the 
two fields have the same Date value, the rule is never triggered. (QCCR1L39766)

4608078383 Setting the default Workflow for a request types in the PPM Workbench does not 
take effect in PPM Center 8.00. After you save the changes, the original default 
workflow still exists. (QCCR1L39699)

4612731559 You set the Note field as a required field on several transitions. After you enter a 
value to the Note field, if you go back through that transition, the field is still 
populated with what you previously entered. In this case, you can continue the 
transitions without entering any value to the Note field. (QCCR1L39693)

4619456196 You edit the preferences of a Request List portlet by using the Query Builder. 
However, you receive the following warning message when you try to add a new 
entry by clicking the auto complete list button on the Query Builder Search Terms - 
New Entry window:
You must provide a value for the field "" to complete the validation.

(QCCR1L29628)

4610102616 Zero truncation and extra note problems occur in the following scenario:
You have a Text Field validation whose data mask is set to Numeric with two 
decimal places. You create a field by using this validation, and enable Notes 
History for the field.
On a request that contains this field, you change the value of the field to a number 
with two decimal places, and the last decimal place is zero (For example, you 
change it to 123.40).
After clicking Save, you notice that the last zero is truncated (For example, 123.4). 
In Notes History, an entry that resembles the following appears (The last zero still 
exists):
<Date>, <Year> <Time> <Time Zone> <Field Name> changed from 123.33 to 
123.40
When you open the request, and save it again without any change, the following 
entry appears in the Notes History (The last zero is truncated):
<Date>, <Year> <Time> <Time Zone> <Field Name> changed from 123.40 to 
123.4. (QCCR1L39762)
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1604111433; 
4616489577

You receive the java.lang.NumberFormatException.forInputString 
error message when trying to delete a saved search that has a single quotation 
mark (‘) or an ampersand (&) in the name. (QCCR1L39885)

4600168340 In PPM Center 7.5 SP6 or earlier versions, you are not allowed to enter more than 
200 characters in the Allowed Request Types field on the Properties tab of a 
workflow step.
After you install PPM Center version 9.12, you will be able to enter up to 4,000 
characters in the field. (QCCR1L39882)

4607698640 Saving a request type in which auditing is enabled for a large number of fields 
causes the following error message:
ORA-06502: PL/SQL: numeric or value error: character string buffer too small 
{KCRT_AUDIT-2061} (KNTA-10498).

(QCCR1L39874)

4611127066 After a new project manager is added to a project, the related tokens for existing 
project issues or risks are not updated. As a result, the new project manager does 
not have access to the project issues or risks that are created before he or she is 
added to the project. (QCCR1L39889)

4601699501 After you upgrade PPM Center to version 7.5 SP4, you may receive an error 
message when searching for requests. This problem occurs when the search result 
tries to display the fields that have field-level security configured. (QCCR1L39879)

4618903458 When you receive an email by using the Mobility Access feature, the width of the 
action buttons stretches across the window, and only the part having texts is 
clickable.
This problem occurs in one of the following conditions.

The email client is Outlook 2007.
The email client is Outlook 2003, and the Internet Explorer version is 7 or higher.

(QCCR1L39931)

4607078110 No validation of user access grants is performed when users access the 
DrillDownPortlet JSP directly.
After you install PPM Center version 9.12, PPM Center will validate the access 
grants when a user tries to access the drill down portlet JSP, and if the user does 
not have the proper access grant, a message is returned, stating that the 
requested portlet does not exist. (QCCR1L27579)

4605139123 When trying to add an entry to a table component, if you click Done multiple times 
after clicking Add, you will receive a java.lang.NullPointerException 
error. In this case, duplicated rows are added to the table. (QCCR1L39875)
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4602190050 Special characters in the target requests are not displayed correctly if you use the 
following Web services special command to export requests:
ksc_export_request "" RequestTypeName false http://
InstanceIP:Port/itgtrue true true aev-core.xsl
This problem still exists after you change the character set in the XML declaration 
of the XSL stylesheet. (QCCR1L39870)

4615855098 When you try to assign the value of a customized date field from the child request 
to the parent request by using Web Services, an error that resembles the following 
occurs in the execution log of the child request:
Setting the value of REQ.PLANNED_FINISH_DATE
org.apache.axis2.AxisFault: An error occured when updating request fields at 
org.apache.axis2.description.OutInAxisOperationClient.send(OutInAxisOperatio
n.java:271) at 
org.apache.axis2.description.OutInAxisOperationClient.execute(OutInAxisOpera
tion.java:202)
at 
com.mercury.itg.ws.dm.client.DemandServiceStub.setRequestFields(DemandServic
eStub.java:899)
at 
quicksilver.ws.dm.SetRequestSimpleField.setRequestFields(SetRequestSimpleFie
ld.java:118)
at 
quicksilver.ws.dm.SetRequestSimpleField.main(SetRequestSimpleField.java:89)

The parent request may display the wrong value. (QCCR1L39930

4600388484 The following error message occurs when the total length of a note is greater than 
or equals to 4,000 characters:
ORA-06502: PL/SQL: numeric or value error: character string buffer too small
ORA-06512: at "KINTANA.KNTA_NOTE_UTIL", line 124

(QCCR1L39692)

N/A Extend the size of RULE_SQL from 2000 to 4000 characters. (QCCR1L39792)

N/A An upgrade script in PPM Center 9.10 sets the DEFAULT_CONST_VALUE 
column width of table KNTA_PARAM_SET_FIELDS_NLS from 4000 to 200. 
Consequently, an error occurs when saving default request type with the 
DEFAULT_CONST_VALUE value greater than 200 characters. (QCCR1L39162)
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Deployment Management

Tracking Number Problem Description

4619161578 You receive the following error message when trying to migrate a request type:
An HP internal error has occurred. Please contact HP Project 
and Portfolio Management support if the problem persists. 
(KNTA-10023)
However, this error message does not explain the reason why the migration fails. In 
PPM Center version 9.12, the system will return a more instructive error message. 
(QCCR1L28051)

1605000160 The KDLV_DELETED_PACKAGES table shows incorrect details for the user who 
deleted a package. In this table, the DELETED_BY entry records the value of the 
LAST_UPDATED_BY entry, which causes the audit trail information to incorrectly 
show the last person that modified the package as the person who deleted the 
package. (QCCR1L39669)

4609685757; 
4615095375

After a workflow, which is created under a non-English language, is migrated to a 
new environment, the message body of a step notification does not display the 
correct content. (QCCR1L39678)

4618312726 Database connections cannot be automatically released, which causes packages to 
be locked with the following error message:
Package <Package ID> is being updated by another database session. (KNTA-
10026).
When this problem occurs, you have to restart PPM Center.
(QCCR1L39755)

4612733954; 
4612552709; 
3605705030

You migrate a workflow which includes one sub workflow to another instance, and 
set the “Replace existing sub workflow” option to Yes in object type PPM Workflow 
Migrator. In this case, the migration log shows that the migration completes 
successfully. However, the sub workflow is not replaced. (QCCR1L39883)
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Deployment Management Extension for Oracle E-Business Suite

Integrations

Tracking Number Problem Description

4627796820 With PPM Center version 9.10 and Java version 1.6_18 or later, after installing the 
HP Deployment Management Extension for Oracle E-Business Suite version 9.10, 
the PPM Workbench could not be opened and a message including “The extension 
panel failed to load...(KNTA-10392)” was displayed. The issue was fixed in the 
manifest file in the Oracle E-Business Suite client jar file. To obtain the fix, 
download and install patch PPMC_00098. (QCCR1L40599)

Tracking Number Problem Description

4622741045 You manually install the PPM Plug-in for Microsoft Project for PPM Center version 
9.11. However, upon connection to PPM Center from the plug-in, you receive a 
message that states a new version (6.0.0002) is available and should be installed. 
The message doesn't disappear after re-installing the plug-in from PPM Center. 
(QCCR1L29391)

4629230483 Sending a PPM Center project to Microsoft Project (in PPM Controlled Mode) fails 
when the following conditions are true:

There are both external predecessors and non external predecessors in the 
PPM Project Task.
The first predecessor of the task is an external predecessor.

(QCCR1L41460)

4626503849 You send a work plan from Microsoft Project to a PPM Center version 9.1x project 
that does not have a work plan and chooses not to include the actual. In this case, 
you will receive the following error message when you want to view the task details 
(double-click a task on the PPM Work Plan view) in PPM Center:
An Error has Occurred
An unknown exception has occurred. Please reload the page you 
were editing and try again.
The following is a stack trace of the exception:
com.kintana.core.server.RuntimeBaseException:
An HP internal error has occurred. Please contact HP Project 
and Portfolio Management support if the problem persists. 
(KNTA-10023)
(QCCR1L40589)
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4622859069 In Microsoft Project, after you import a work plan from PPM Center, all predecessor 
and successor relations are missing. This problem can occur when the system is 
set to use a language that doesn't use commas as standard list separators, such 
as Russian, and French. (QCCR1L29394)

N/A When saving a change in Service Manager, the system will perform validation. If it 
fails, the change in the form will not be saved. 
However, Service Manager still sends update request to PPM even when the 
validation fails, and the PPM-SM RFC integration log will override the notification 
message "Please provide Closure Comments" and display "Update RFC 
finished" instead.
To address the issue, the javascript to be added in step 8 (page 258) of the 
Configuring the Integration of PPM Center Tasks and Service Manager RFCs 
section of the HP Solution Integrations Guide is modified from:
system.library.HPPPMSMIntegration.integratePPM();

to the follows:
if(vars.$L_exit!="bad.val") 

system.library.HPPPMSMIntegration.integratePPM();

(QCCR1L41320)

4616498330 The java.lang.NumberFormatException error occurs when you try to upload 
work plans from Microsoft Project to PPM Center. This problem occurs when the 
following conditions are true:

Your system uses a language that uses comma (,) instead of a period (.) as a 
decimal separator, such as French.
The hoursPerDay field in Microsoft Project is a decimal value.

When this problem occurs, a comma (,), instead of a period (.), is used as a 
decimal separator. (QCCR1L28378)

4620514041 After you import a work plan from Microsoft Project into a PPM project work plan, 
all activities are presented in the PPM work plan. However, after you set the status 
of the work plan root level task to “Active,” all activities that were previously 
displayed on the work plan are cleared.
Additionally, if you modify the activity of the root level task, all the sub tasks’ 
activities are changed to the same as the root level task’s activity. (QCCR1L39756)

4614609342 You integrate PPM Center with Microsoft Project 2007. However, the Microsoft 
Project Plug-in for PPM may fail to load when you launch Microsoft Project 2007, 
which eventually causes an "Out Of Memory" error. (QCCR1L39960)
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4604114864 You create a proposal that has an attachment stored in the EMC Documentum 
repository. However, after you promote the proposal to a project, some users could 
not save the project or continue the workflow. (QCCR1L39686)

4613801498 You integrate PPM Center with EMC Documentum. Sporadically, you may receive 
the HTTP 500 error when creating or working through a request. (QCCR1L29331)

4616560386 You integrate PPM Center 8.00 with EMC Documentum. You receive an error 
message that resembles the following when checking out a document for the 
second time.
[DM_SYSOBJECT_E_CANT_SAVE_IMMU
TABLE]error:  "Cannot save <document name>since it is 
immutable."; ERRORCODE: 100; NEXT: null.
(QCCR1L39895)

4609665268 If the base currency is set to a non-US dollar currency, such as Swedish Krona 
(SEK), you may receive a NumberFormatException error when viewing the 
Project List portlet. (QCCR1L39688)

4619450405 You group the dashboard pages by setting the GROUP.PRIVATE.PUBLIC.PAGES 
server parameter to TRUE. In this case, if you create a module that contains 
multiple pages, the module does not appear in the dashboard menu. 
(QCCR1L39737)

4615363665 When you click Select Configuration Items from the out-of-the-box Universal 
CMDB field group, the CI selector applet is launched in a very small window.
In PPM Center version 9.12, the window size is increased. (QCCR1L39891)

4609759519 Assigned efforts are not distributed evenly in the Resource Usage view in PPM 
Center when the work plan is imported from Microsoft Project and the working 
hours configuration does not use the default settings. (QCCR1L39876)

4606232348 If you send an MSP project to PPM Center, the MSP actuals information is 
imported to PPM Center. This behavior causes different actuals between the time 
management report and the Actuals view.
PPM Center version 9.12 provides options for you to include or exclude actuals 
information in an MSP project when sending the project to PPM Center. 
(QCCR1L39896)

4615238656 If you set the "Transfer actual information" setting to Actual Efforts, PPM Center 
transfers estimated remaining effort (ERE) to Microsoft Project even when the ERE 
tracking is turned off in PPM Center.
PPM Center version 9.12 transfers ERE to Microsoft Project only when the ERE 
tracking is turned on. (QCCR1L39901)
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Platform

Tracking Number Problem Description

4624903164 On an AIX server, one slow thread that takes a long time to close the connection 
may block all the other threads from opening new connections. This problem causes 
Intermittent failures, such as logon failures, on clustered nodes. (QCCR1L41031)

N/A PPM installer fails with the following error message when deploying the KTMG_
CONFIGURABLE_FILTERS.zip package:
Install failed with message below, please exit the 
installation now.
Completing the database creation...
(QCCR1L29033)

4624752377 The unused table KNTA_APP_SERVER_DETAILS exists in PPM Center, which may 
cause confusion. Starting with PPM Center version 9.12, this table will be removed. 
(QCCR1L37467)

4617394723 Server properties collection is not thread safe. You can observe this problem by 
creating multiple projects simultaneously from different proposals. When you do 
this, various error messages will occur. (QCCR1L40154)

4617557434 You can use the at character (@) in the search box to search for the following 
entities: 

Projects
Programs
Staffing profiles
Tasks

However, to search for a request, you have to use the pound character (#).
Starting with PPM Center version 9.12, you can use the at character (@) to define a 
search for a request.
(QCCR1L27407)

4617762640 You logon to PPM Center with the Portuguese language. However, when you switch 
between the Project Summary tab and the Project Details tab on the Project 
Overview page, some boilerplate texts may change to English. (QCCR1L29485)

4624752377 The PPM table KNTA_APP_SERVER_DETAILS is included in the Data Model 
Guide but there are no data in it. 
The table is dropped from PPM Center schema since it is not used, and also 
removed from the updated Data Model Guide. (QCCR1L37467)
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4626744911 An exception correlation occurs when you open projects in PPM Center. When this 
problem occurs, the following message is generated in the server log file:
Exception Correlation: GUID=41D899F3-615F-2207-C024-B6FDA6398AFB
at 
com.kintana.core.web.filter.ControlFilter.applyFilter(ControlFilter.java:911
)
at 
com.kintana.core.web.filter.ControlFilter.doFilter(ControlFilter.java:1334)
at com.mercury.itg.servlet.I18NFilter.doFilter(I18NFilter.java:40)
at com.kintana.core.web.filter.Log4jFilter.applyFilter(Log4jFilter.java:49)
at com.kintana.core.web.filter.BaseFilter.doFilter(BaseFilter.java:59)
Caused by: org.apache.jasper.JasperException: /web/knta/dsh/portlet/
PortletHeader.jsp(61,50) Attribute value localeCtrl.getCSSFileName("/itg/web/
knta/dsh/css/PortletSpacing.css",request) is quoted with " which must be 
escaped when used within the value
at 
com.mercury.itg.common.web.PortletTilesRequestProcessor.process(PortletTiles
RequestProcessor.java:53)
at 
com.mercury.itg.servlet.ActionMonitorFilter.doFilter(ActionMonitorFilter.jav
a:86)
at 
com.mercury.itg.servlet.HibernateSessionFilter.doFilter(HibernateSessionFilt
er.java:79)

(QCCR1L40115)

4609464207 You set the JSP_RECOMPILE_ENABLED to TRUE in the server.conf file. However, 
when the server is running, changes to JSP files are not picked up as expected. You 
still have to restart the server to make the JSP changes visible. (QCCR1L39709)

4609547007; 
4615258145

When the server log rotation size specified by the ROTATE_LOG_SIZE parameter is 
reached, the existing serverLog.txt file is not renamed for archiving, and no new log 
file is created. Instead, the system clears the original serverLog.txt file.
This problem occurs when you start PPM as a service. (QCCR1L39741)

4608655631 A deadlock issue happens when you update tasks while the Cost Rollup service is 
running. (QCCR1L39752)

4611621428 In a field of the Text Validation 4000, the number of characters that you can enter is 
less than 4000 if multi-byte characters are used. (QCCR1L39890)

4622527565 You receive the following error message when submitting a copied scheduled report 
that has notifications:
This page had the following error:
 An HP internal error has occurred. Please contact HP Project and Portfolio 
Management support if the problem persists. (KNTA-10023)
An HP internal error has occurred. Please contact HP Project and Portfolio 
Management support if the problem persists. (KNTA-10023)
nested detail:DB Package error:
ORA-01407: cannot update ("MITG"."KNTA_NOTIFICATIONS"."ENABLE_EMAIL_
APPROVALS") to NULL {KNTA_NOTIFICATIONS_TH-400} (KNTA-10498)

(QCCR1L39942)
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N/A A thread synchronization error in the Tomcat class loader may lead to a race 
condition. This can cause PPM Center version 7.5 SP4 running on AIX 5.3 to crash 
with the following error:
java.lang.IllegalArgumentException: Package org.apache.axis2.client already 
defined.  at java.lang.ClassLoader.definePackage

(QCCR1L29321)

4619268125 You experience a delay in the PPM Workbench synchronization between multiple 
instances. The workbench changes made on one instance are not presented in a 
timely manner when you view the workbench settings from the second instance. 
(QCCR1L29146)

4614806479 PPM Center may process scheduled tasks that are not actually due. Therefore, you 
may notice that reports scheduled to run in future have already been executed. 
(QCCR1L39758)

N/A Message IDs in the JMS_MESSAGES table always start from zero when the active 
quartz scheduler switches node in a cluster. This may lead to constraint violations 
on the unique constraint in the JMS_MESSAGES table. (QCCR1L39937)

N/A Under certain conditions, a non-services-enabled PPM cluster node may insert 
messages into the JMS_MESSAGES table. In this case, subsequent startup of a 
services-enabled node may then lead to a constraint violation on the  
JMS_MESSAGES table.
This problem usually occurs if the quartz scheduler switches to being active on the 
latter node. (QCCR1L26787)

4610046564 A java.lang.NullPointerException error occurs when you try to logon to 
PPM Center. (QCCR1L39872)

4613946799 The KCRT_PARTICIPANT_CHECK_V view has performance issues. This may 
affect portlets, reports and some core functionality. (QCCR1L39893)

3605882193 A SQL query consumes 100% of the database CPU usage. This problem usually 
occurs when PPM Center contains projects with many tasks. (QCCR1L39673)

N/A On HP-UX cluster, background services getting "SpyJMSException: Cannot 
get a client ID" and "Unable to create new native thread" error 
messages.
The following patch packages are required:

PHCO_41946 for HP-UX 11.23 (IA-64)
PHCO_41407 for HP-UX 11.23 (IA-64)

(QCCR1L41066)
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Portfolio Management

Program Management

Tracking Number Problem Description

4628508506 When creating or viewing a portfolio, the forecast actual graph generates a null 
pointer exception. (QCCR1L41033)

4623199992, 
4625240258

When the LOGON_METHOD is set to LOGON_ID, and the user's LOGON 
IDENTIFIER is different from his or her USERNAME, the ksc_create_project 
special command and the underlying 
com.kintana.core.server.execution.CreateProject Web service operation fail without 
printing any error message. (QCCR1L39525)

4620967635 In PPM Center version 8.02, creating a project by using the ksc_create 
command in an execution step can fail. However, when the creation fails, no error 
message is generated in the server log file. Only a “failed” message can be found in 
the execution log on the request. (QCCR1L39917)

4614939197 You use a custom field as a filter in the advanced search when trying to add new 
content to a scenario comparison. However, the search result is not affected by the 
match of this custom filed and all requests that meet the rest of criteria are returned. 
(QCCR1L39675)

N/A For consistency with the Analyze Current Portfolio page, the Current Portfolio Map 
portlet has been renamed the Analyze Current Portfolio portlet. Portlets previously 
created as Current Portfolio Map portlets do not get renamed. (QCCR1L41659)

Tracking Number Problem Description

N/A If you receive the “Program name already exists” message when creating a 
program, the values entered in user data fields are removed. Because of this issue, 
you have to enter the values again after you rename the program. (QCCR1L29255)
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Tracking Number Problem Description

4616082690 When you use Project Management Web service operation to update a field, such 
as a date field, an error that resembles the following is generated in the server side:
org.apache.axis2.AxisFault: An error occurred while updating 
project <Project Name>.
(QCCR1L39644)

4627921745 The work plan policy on the Project Settings page cannot be updated after a work 
plan is created on the project. (QCCR1L40938)

4625649283, 
4627814399

On the Search Projects page, if you type the number of the project in the “View 
Details for Project No:” field, and then press ENTER, the search result will display 
all projects instead of displaying the project you search for only. If you click Go, the 
search result will display the correct project. (QCCR1L40905)

4628545376 Performance issues occur in the work plan task query. PPM Center version 9.12 
improves the performance of the query. (QCCR1L41228)

4622855391 After you export a project to PDF, the Project Associations portlet fails with the 
following error:
An Error has Occurred
An unknown exception has occurred. Please reload the page you were editing 
and try again.
The following is a stack trace of the exception:
com.kintana.core.server.AppException:
An HP internal error has occurred.

(QCCR1L39274)

4628736126 In PPM Center 9.1x, when you try to select a project manager to add to a project by 
clicking the Add Project Manager button, the search box displays all users, 
including non-licensed ones. However, you expect that only licensed users are 
displayed. (QCCR1L41205)
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4627037721 Performance issues occur when you perform a project search.
To resolve this problem, PPM Center version 9.12 introduces the following two 
server.conf parameters to restrict the number of projects being returned on a 
project search:

ENABLE_RESTRICTIONS_ON_PROJ_SEARCH

MAX_RESULTS_ALLOWED_ON_PROJ_SEARCH

The ENABLE_RESTRICTIONS_ON_PROJ_SEARCH parameter specifies whether 
to enable the restriction on a project search. 
The default value is false, meaning that by default there is no restriction on the 
number of projects being returned on a project search. To enable the restriction, set 
the value of this parameter to true.
The MAX_RESULTS_ALLOWED_ON_PROJ_SEARCH parameter specifies the 
maximum number of projects being returned on a project search. 
The default value is 1,000, meaning that if the parameter is not specified and the 
ENABLE_RESTRICTIONS_ON_PROJ_SEARCH parameter is set to true, at most 
1,000 projects can be returned on a project search.
(QCCR1L40699)

4626005106 The TSK.MASTER_PROJECT_ID and PRJD.PROJECT_DETAIL_ID tokens have 
been removed since version 9.11. 
This behavior change could cause an error message that resembles the following 
when you click an auto-complete list of a Task User data field on the work plan 
page:
Exception Correlation: GUID=FAF6FDF0-F999-5B78-EE33-38CA36C11A0A
Generated Time=2011/02/15-11:10:32.656 MEZ
Server Node Name: HPPPM8
  
message= ORA-00904: &quot;MASTER_PROJECT_ID&quot;: invalid identifier {KNTA_
TOKEN_PRIVATE-450}
 SELECT MASTER_PROJECT_ID FROM WP_TASKS WHERE  TASK_ID = :TASK_ID
select 1, 1 from dual
where 1 = 1
and 1 = 32002
and 1 = [TSK.MASTER_PROJECT_ID]
and 1 = [TSK.TASK_NAME]
and 1 = [PRJ.PROJECT_ID]
and 1 = [PRJD.PROJECT_DETAIL_ID]
and 1 = [SELECTED_TASK_ID]

After you install PPM Center version 9.12, these two tokens will be removed from 
the knta_entity_tokens table. And thus, the token builder does not show these 
tokens any more. (QCCR1L41092)

4601231666 When accessing a task in the project summary page using the link, you receive an 
error that reports an invalid token. This problem does not occur when you access 
the task by clicking the Edit button. (QCCR1L29274)

Tracking Number Problem Description
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4619713418; 
4618494183

The Task Actuals Rollup service fails if there is a task that has more than 1,000 
children tasks. When this problem occurs, an error that resembles the following is 
generated:
ppmLightServiceListenerContainer-1:com.kintana.services:2010/09/16-
21:30:16.644 GMT: Failed to rollup task actuals for some workplan, rolling 
back transaction
com.mercury.itg.exceptions.InfrastructureException: 
org.hibernate.exception.SQLGrammarException: could not execute query
Exception Correlation: GUID=08517E80-6692-5DC2-F2EF-029098A09AF7 

(QCCR1L39638)

4620661916 When a user removes a time sheet line that has a total effort of zero from a 
completed task, the Percent complete is set to 0 and the task is re-opened. (The 
status of the task is changed back to “In Progress.” (QCCR1L39636)

4610263557 Under some circumstances, it is possible to click the BACK button in the browser 
and resubmit the project information, which results in an unreadable error message. 
In PPM Center version 9.12, this error message has been improved to be 
understandable by the user. (QCCR1L39643)

4611016471 The Project List portlet shows closed projects even if you clear the Include 
Finished Projects check box when editing the portlet preferences to exclude the 
closed projects. (QCCR1L39646)

4618967435 When you install PPM Center 8.00 Service Pack 2, the script “upgrades/Production/
postupgrade/pm_project_types_800_1.sql” takes a long time to run. 
(QCCR1L39641)

4613660927 You receive a java error that resembles the following when trying to copy a project 
type from an existing project type that has been upgraded:
server:http-sms-r73-prod-test2.accenture.com%2F10.3.132.180-80-
Processor18:SystemErr:2010/04/26-06:54:12.494 EDT: 
org.apache.commons.beanutils.ConversionException: Cannot assign value of type 
'java.lang.String' to property 'activitySyncEnabled' of type 
'java.lang.Boolean'

This problem does not occur if you create a new project type and then copy it. 
(QCCR1L29257)

4618796807 For proposal, project, and asset requests, you cannot enter more than 200 
characters in the Project Manager field. (QCCR1L29258)

2606803977 A seeded query may cause performance issues. Further research on the Automatic 
Workload Repository (AWR) report indicates that part of the query checks whether 
all users have the permission to view a project unnecessarily for every task that 
belongs to the project. (QCCR1L39649)
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4617768670 You cannot export large work plans (for example, work plans that have more than 
5,000 entries) to PDF or Excel.
After the export screen appears, it continues to refresh and never completes the 
export. When this problem occurs, an error that resembles the following is 
generated in the server log:
Thread-42020:com.mercury.itg.pm.workplan.pdf.LoadingThread:2010/07/30-
13:23:15.698 GMT-07:00: Loading Excel Exception
org.hibernate.exception.SQLGrammarException: could not execute query. 

(QCCR1L29263)

4605373109 You fail to delete a project that has no references attached with the following error 
message:
The reference you are trying to add (Project Project ID) is already deleted 
and cannot be added as a reference. The entity might be deleted right before 
you try to save it. Please remove this reference and try again. (KNTA-11017)

This problem occurs when an entity that has a project reference pointed to the 
project is corrupted. (QCCR1L29267)

1600819251 Standard tokens cannot be resolved for the Project Details tab in the following 
scenario:

You create a user with the Project Management and Demand Management 
licenses and give the user the following access grants:

Demand Mgmt: Edit Requests
Demand Mgmt: View Requests
Project Mgmt: Edit Projects
Project Mgmt: View Projects

On the Request Type of a project, you set user access security to a standard 
token [PRJ.PROJECT_STAKEHOLDER_USERNAME] or  
[PRJ.PROJECT_MANAGER_USERNAME].
You set that user as a stakeholder or the project manager for the project.
Customers logon to PPM Center as that user and open the project.

In this scenario, the token is not resolve for the Project Details tab. As a result, this 
user cannot access the tab. (QCCR1L29269)
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4604050883 If you click Save Draft on the Submit Request page of a project request and the 
project name is duplicated with an existing project, you receive the following error:
An Error has Occurred
An unknown exception has occurred. Please reload the page you were editing 
and try again.
The following is a stack trace of the exception:
com.mercury.itg.pm.pmo.NameAlreadyExistsException:Project Name Project 1 
already exists
com.mercury.itg.pm.dao.ProjectDAO.create(ProjectDAO.java:361)
com.mercury.itg.pm.project.web.CreateProjectHelper.createProject(CreateProje
ctHelper.java:29)

If you search for the request that has been created, and then click the link in the 
search result, you receive the following error:
An Error has Occurred
Cannot load the Project with the specified id: 32003. Project may be deleted 
by another user.

(QCCR1L29270)

4606288867 In a work plan, if you enter the scheduled effort greater than 999 for a task, the 
value of the Estimated Remaining Efforts field will be truncated starting from the 
comma.
For example, if the scheduled effort is 8,000.00, the estimated remaining effort 
becomes 8.00. (QCCR1L29273)

4609213901 If you click the Create blank work plan link multiple times in quick succession, 
more than one work plans will be created for a project. (QCCR1L29272)

4615367809 Performance issues occur in the Project Management module when you use work 
plans. (QCCR1L29271)
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Tracking Number Problem Description

4627213561 The system tries to insert a value larger than the database maximum field size (255 
characters) to a field on the PPM_NOTIFICATIN_DETAILS table. When this 
problem occurs, the following message is generated in the sever log file:

org.hibernate.exception.GenericJDBCException: Could not execute JDBC batch 
update

JSESSIONID=E079FC449BE14CB72AA43BB45EE90467.ppm1,USERNAME=awarcola 
server:http-0.0.0.0-80-Processor19:SystemErr:2011/03/12-07:58:30.804 GMT-
07:00:            at 
com.mercury.itg.rm.staffing.dao.StaffingProfileDAO.getResourcePoolManagers(S
taffingProfileDAO.java:932)

JSESSIONID=E079FC449BE14CB72AA43BB45EE90467.ppm1,USERNAME=awarcola 
server:http-0.0.0.0-80-Processor19:SystemErr:2011/03/12-07:58:30.804 GMT-
07:00:            ... 22 more

JSESSIONID=E079FC449BE14CB72AA43BB45EE90467.ppm1,USERNAME=awarcola 
server:http-0.0.0.0-80-Processor19:SystemErr:2011/03/12-07:58:30.804 GMT-
07:00: Caused by: java.sql.BatchUpdateException: ORA-12899: value too large 
for column "PPMPROD_DB_SCHEMA"."PPM_NOTIFICATION_DETAILS"."DETAILS6" 
(actual: 302, maximum: 255)

After you install PPM Center version 9.12, the maximum field size is extended to 
2,000 characters. (QCCR1L40288)

4619752455 When setting the end date for a resource, the database sets the timestamp at the 
beginning of the day (00:00) instead of the end of that day (23:59). This behavior 
causes a resource to be invalid at the last day. (QCCR1L28131)

4622515322 In the Assignment Load Details section of an exported Analyze Assignment Load 
spreadsheet, the Description column always displays the string “Project Summary”, 
instead of the project names. (QCCR1L29324)

4616323158 When you search for a resource in a staffing profile, the search result shows all the 
available resource pools in the Resource Pool Name column. However, you expect 
that only the user's current resource pools and the corresponding parent pools 
should be returned. (QCCR1L26696)

N/A The following exception occurs when you use the Comparing to Workplan 
operation in a staffing profile:
An oracle exception is thrown:
ORA-01795: maximum number of expressions in a list is 1000
(QCCR1L24493)
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4622504964 The Organization Model portlet does not display correct information in the Manager 
field. This field displays the manager's username (logon ID) instead of the full 
name. (QCCR1L29226)

4629234050 You select the option to reject outstanding resource requests when a resource pool 
is disabled. However, when disabling a resource pool, the outstanding request 
resources are not removed from the resource pool overall page. Additionally, their 
status is not updated to “Rejected” in the staffing profiles overall page. 
(QCCR1L41258)

4626436569 Staffing profiles display unmet demand data even though all the resource requests 
are fulfilled. (QCCR1L40902)

4620291219 You create a project that has Financial Management for Staffing Profile enabled in 
the project settings. And then, you create a staffing profile for the project and add 
many positions and resources. In this case, you may encounter performance 
issues when you try to do the following:

Adding a position to the staffing profile.
Assigning a resource to a position.

(QCCR1L39821)

4611288078 Setting the RM_OVERRIDE_ASSIGNMENT_CONTROLS parameter does not affect 
what resources can be mapped between HP Project Management and Microsoft 
Project. (QCCR1L39301)

4602335556 In the Assignment Load Details section of an exported Analyze Assignment Load 
spreadsheet, the Description column does not display the project names. Instead, 
the column displays the string “Project Summary”, which is the same value with the 
Type column. (QCCR1L39682)

4619713418; 
4618494183

In the <PPM_HOME> directory, huge binary files with the name java_pid*.hprof are 
created when "Out Of Memory” errors occur. These files consume a lot of disk 
space, which affects the system performance. (QCCR1L39906)

4620109634 You have an instance that uses a language pack, such as the French language 
pack. When you try to add a resource to a project, you may receive an error 
message stating that the cost is invalid. (QCCR1L39746)

4621652875 If you assign a resource to a certain position by using the Manage Allocation 
button on the resource pool page, the system will not send out the notification for 
this resource assignment. (QCCR1L39761)
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4612790558 When you try to set the end period to an earlier date for a staffing profile that is 
associated with a lifecycle entity (such as a proposal, a project, or an asset), you 
receive the following error message:

An unknown exception has occurred. Please reload the page you were editing 
and try again
The following is a stack trace of the exception
com.kintana.core.server.RuntimeBaseException
A HP internal error has occurred. Please contact HP PPM support if the 
problem persists (KNTA-10023)

This problem also occurs if you change the staffing end period to a later date and 
then try to change it back to the original one.
This problem occurs when both of the following conditions are true:

If the lifecycle entity is a project, the “Calculate the forecasted labor costs from 
the staffing profile” option must be selected.
 You have created positions and made assignments for the staffing profile.

(QCCR1L39683)

4613485146 Users that have the “View all Resource Pools” and “Edit Resource Pools” access 
grants can disable resource pools for which they are not the pool manager.
In PPM Center version 9.12, only the resource pool manager will be able to disable 
a resource pool unless the user has the “Edit All Resource Pools” access grant. 
(QCCR1L39700)

4609215161 You track time against a certain request type by using Time Management. Users 
enter some actuals against a request of that type. However, the Analyze 
Assignment Load portlet does not show the actuals. (QCCR1L39935)

4617238862 You receive the following error message when clicking Manage Allocation on the 
Resource Pool page:
An unknown exception has occurred. Please reload the page you were editing 
and try again. 
java.lang.ArrayIndexOutOfBoundsException:2
com.mercury.itg.rsc.staffing.web.PageMarks.updatePageMarks(ManageAllocationA
ctionHelper.java:1236)
com.mercury.itg.rsc.staffing.web.ManageAllocationAction.doExecute(ManageAllo
cationAction.java:569)
com.mercury.itg.common.web.BaseAction.execute(BaseAction.java:146)
org.apache.struts.action.RequestProcessor.processActionPerform(RequestProces
sor.java:421)

(QCCR1L39744)

4614068689 You may see more actual FTEs than expected in the resource plan view of the 
scenario comparison for a project. (QCCR1L39869)
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4611224778 The Analyze Assignment Load (AAL) portlet shows logged time incorrectly. The 
total number of hours shown on the AAL portlet is correct. However, the hours are 
incorrectly distributed across the month contours. (QCCR1L39932)

4605545720 Cost rate rules that contain the Org Units cost factor do not work correctly for Time 
Management Reports. (QCCR1L39812)

4611421308 Data is truncated in an exported spreadsheet if this spreadsheet includes a staffing 
profile that contains a single quote mark (‘) in the name. (QCCR1L39934)

4605161025 Compare to Workplan--View by Role does not display any Actual Effort data if 
there is time logged against the project. (QCCR1L39933)

2607413269 Staffing Profile notifications do not work correctly when using the default 
notification settings. The recipient can not receive the notifications. When this 
problem occurs, the following error is generated in the server log:
server:RM Notification Service:com.kintana.services:2009/06/05-08:30:03.897 
EDT: java.lang.IndexOutOfBoundsException: Index: 0, Size: 0
at java.util.ArrayList.RangeCheck(ArrayList.java:546)
at java.util.ArrayList.get(ArrayList.java:321)
at com.mercury.itg.rm.notification.service.NotificationContent.
<init>(NotificationContent.java:31)
at com.mercury.itg.rm.notification.service.ResReqNotificationCo
ntent.<init>(ResReqNotificationContent.java:23)
at com.mercury.itg.rm.notification.rule.RMNotificationRule.getE
mailMessages(RMNotificationRule.java:236)

(QCCR1L39680)

4600458010 You receive the “Components size is bigger than compressed data” 
error message when trying to open a staffing profile. (14816)

4605746526 Previously entered user data values do not appear when you open a staffing profile 
header. (QCCR1L39689)
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4625907931 Negative total effort appears in a task when the project manager rejects invalid time 
sheets in the Time Approval portlet on the Project Overview page. (QCCR1L40813)

4616643099, 
4625477790

Additional database connections are being opened as part of loading a time sheet 
that contains project or task items. This is unnecessary and causes the connection 
pool to exhaust its available connections and throw the following error:
: org.hibernate.exception.GenericJDBCException: Cannot open 
connection
(QCCR1L28613)

4625907931 If you enter actuals in a time sheet and set the % Complete field to zero, a popup 
message will inform you that % Complete cannot be zero when there is effort in the 
work item. In this case, if you click OK on the popup message, and then refresh the 
page, the actuals you entered will be reset to zero in the Time Breakdown table. 
However, on the Other Actuals table, the actuals will still exist in the Actual Effort 
field. If you click Save, the actuals will not be synchronized to the corresponding 
work units, which results in corrupted data. (QCCR1L40812)

4617145058 Removing actuals from a time sheet by making the cell blank instead of entering 
zero and then clicking Save makes the actuals return to the time sheet but still be 
deducted from the work item. This behavior makes the actuals and the total actual 
effort of the work item unsynchronized. (QCCR1L41207)

4626930631 You have tasks with activities in your My Items list. You use the “Include Items from 
My Items List” option when creating a time sheet. However, the time sheet line only 
includes the tasks. The activities are not included in the time sheet line. 
(QCCR1L40319)

4623952277 When you use the Create, Update or Submit operation in Time Management Web 
services and include the record for the TM_ACTUALS totals in the Web service XML, 
the operation creates a duplicate totals row in the system. (QCCR1L41405)

4615300483 Consider that you have multiple lines in a time sheet, and the vertical scroll bar 
appears.
In the Time Break Down window, if you use the Tab key to move the cursor from the 
cell displayed at the end of the window to the beginning cell of the next line, the 
Time Break Down window will moves upwards. However, the corresponding the 
time sheet details (such as the Item, and Total columns) do not move. This causes 
mismatches between the time sheet details and the data logged in the Break Down 
window. (QCCR1L39654)
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4615289730 You use Override Rules to setting Charge Codes for certain time sheets. If there 
are many charge codes added to a time sheet line, the charging on certain items 
could be over 100%. (QCCR1L39653)

4621524577 PPM Center reevaluates approvers when loading and saving any time sheet, which 
affects the performance.
PPM Center version 9.12 improves the performance by checking the auto approval 
flag to decide whether a reevaluation of the approvers is needed or not. 
(QCCR1L39650)

4600633164 When a time sheet is frozen or closed, the LAST_UPDATE_DATE field and the 
LAST_UPDATED_BY field in the TM_TIME_SHEETS table are not updated with 
details of the freeze/close user. (QCCR1L29284)

4000772317 If you use the German (Switzerland) regional settings, you receive the following 
error message when editing or submitting your time sheets:
Error:
Invalid Actual Effort
Details:
Actual Effort has an invalid value, must be a numeric value.

This problem usually occurs if you enter numbers greater than 1,000 in the time 
sheets. (QCCR1L29285)

4610784235 You cannot approve, freeze or close time sheets older than 12 periods when using 
the following server.conf setting:
com.kintana.core.server.TM_MAX_PREVIOUS_TIME_PERIODS=200
(QCCR1L29294)

4616369512 You receive the following error message when submitting a time sheet:
server:Resource Pool Rollup Service:com.kintana.services:2009/10/20-
11:55:00.602 EDT: java.lang.NullPointerException
at com.mercury.itg.core.calendar.impl.CalendarWorkingDayCacheIm
pl.getNumOfWorkDays(CalendarWorkingDayCacheImpl.java:427)
at com.mercury.itg.core.calendar.impl.ITGCalendarImpl.getNumOfW
orkDays(ITGCalendarImpl.java:580) 

(QCCR1L29297)

4603592385 If you disable one or more MISC items for a submitted time sheet, and then copy 
that time sheet, the new one will have all the items including the disabled ones. 
(QCCR1L29293)

3606071468 When searching for time sheets to approve on the Approve Time page, you select 
Check all to select all the time sheets returned in the search result. However, after 
you click Approve, only the first time sheet is approved. (QCCR1L29296)
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4613955180 After you click Printable Version on the Edit Time Sheet page, the printable 
version of the time sheet takes a long time (about 15 seconds) to appear. 
(QCCR1L29299)

4609850155 A project has more than one task with the same name, and these tasks are added 
to the same time sheet, with different activities to each of them. In this case, the 
display of the time sheet is corrupted. There is non-related output between the Line 
Details window and the time sheet main page. (QCCR1L29295)

3605836805 The default time sheet policy is defined as auto-approve. You set a time sheet 
override rule to configure the charge code but you do not define the Time Approver 
and the Billing Approver in the rule. In this case, time sheets cannot be approved 
automatically. (QCCR1L29303)

4617035816 You enter the request ID of an existing request when trying to add this request to a 
time sheet. However, after you click Search, the following message appears:
No results returned. Please modify your search.
As a result, you cannot add this request to your time sheet. (QCCR1L29287)

3605845930 If you set the Resource field to another user when making a copy of a time sheet of 
a Resource Pool Manager or Direct Manager, that user can log time against the 
project even though the user is not in the staffing profile. (QCCR1L29290)

4616369512 You receive the following error message when submitting a time sheet:
server:Resource Pool Rollup Service:com.kintana.services:2009/10/20-
11:55:00.602 EDT: java.lang.NullPointerException
at com.mercury.itg.core.calendar.impl.CalendarWorkingDayCacheIm
pl.getNumOfWorkDays(CalendarWorkingDayCacheImpl.java:427)
at com.mercury.itg.core.calendar.impl.ITGCalendarImpl.getNumOfW
orkDays(ITGCalendarImpl.java:580) 

(QCCR1L29297)

4603592385 If you disable one or more MISC items for a submitted time sheet, and then copy 
that time sheet, the new one will have all the items including the disabled ones. 
(QCCR1L29293)

3606071468 When searching for time sheets to approve on the Approve Time page, you select 
Check all to select all the time sheets returned in the search result. However, after 
you click Approve, only the first time sheet is approved. (QCCR1L29296)

4613955180 After you click Printable Version on the Edit Time Sheet page, the printable 
version of the time sheet takes a long time (about 15 seconds) to appear. 
(QCCR1L29299)

Tracking Number Problem Description
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4609850155 A project has more than one task with the same name, and these tasks are added 
to the same time sheet, with different activities to each of them. In this case, the 
display of the time sheet is corrupted. There is non-related output between the Line 
Details window and the time sheet main page. (QCCR1L29295)

3605836805 The default time sheet policy is defined as auto-approve. You set a time sheet 
override rule to configure the charge code but you do not define the Time Approver 
and the Billing Approver in the rule. In this case, time sheets cannot be approved 
automatically. (QCCR1L29303)

4617035816 You enter the request ID of an existing request when trying to add this request to a 
time sheet. However, after you click Search, the following message appears:
No results returned. Please modify your search.
As a result, you cannot add this request to your time sheet. (QCCR1L29287)

3605845930 If you set the Resource field to another user when making a copy of a time sheet of 
a Resource Pool Manager or Direct Manager, that user can log time against the 
project even though the user is not in the staffing profile. (QCCR1L29290)

N/A When no periods exist in KTMG_PERIODS table for HP Time Management and 
there is no time sheet, on the My Tasks portlet clicking the Go To Time Sheet 
button or clicking a value (link) in the Actual Effort (hrs) column causes a 
NumberFormatException.
To address this issue, the code was changed so that the button is not shown and 
the values in the column have no links when there is no time sheet. 
(QCCR1L41648)

N/A The value of the Code field in the TMG - Misc. Work items validation must be 
numeric. Since version 9.10, an error message has been presented if an 
administrator tries to specify a non-numeric value. Prior to version 9.10, the 
presence of a non-numeric value in the Code field caused a stack trace. Customers 
who established non-numeric values for the Code field before version 9.10 must 
make those values numeric. (QCCR1L42207)

Tracking Number Problem Description
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4 Known Problems and Limitations in PPM 
Center 9.12
The following problems and limitations are known to exist in PPM Center 
version 9.12 (or other software, as indicated). The problems are categorized by 
the affected product area. If a problem has an assigned internal tracking 
number, that tracking number is provided (in parentheses) at the end of the 
problem description.

Best Practices - PPM Dashboard

New and modified text and field names introduced in version 9.12 are not translated 
into other languages. As a result, users who log into PPM Center un a non-English 
language will see some screens in the interface that have some English words. Future 
releases will provide translated text.

PROBLEM If you open PPM Center in Internet Explorer 7, and try to open a submenu (for 
example, Dashboard > Private > My Reporting Portlets > ...), the submenu may 
not open. This can occur if you have a large number of submenus for a given PPM 
Dashboard menu item. (QCCR1L41326)

WORKAROUND Maintain the number of submenus at 15 or fewer per PPM Dashboard menu item.
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PPM Dashboard

Installation and Administration

PROBLEM When the length of a word in a portlet name exceeds 30 characters (without a 
space), after you click Find Portlets in the Add Portlets window, the Portlet Name 
column in the resulting list is resized automatically, other columns are pushed to the 
right side, and no horizontal scrollbar is available. If the word is really long (say, 100 
characters), the buttons in the right side of the window may disappear. 
(QCCR1L41717)

WORKAROUND Maximize the Add Portlets window.

PROBLEM When a request contains HTML related characters in its request description, the 
request is not displayed in the My Requests portlet. (QCCR1L42543)

WORKAROUND Make sure not to include any HTML related characters in the description of a 
request.

LIMITATION If you open the generated CSV file in \ppmc\data\ folder after running 
kSupport.sh to generate support information, and make some format changes, 
such as changing column width, then save the CSV file (with or without warning), 
many lines of records display error next time you open it as Excel removes comma 
(,) by default. (QCCR1L41464)

WORKAROUND Instead of clicking Save directly, save the file in CSV file type by following the Save 
As option and selecting CSV (Comma delimited) (*.csv) for the Save as type field.

LIMITATION If a data sheet in the PPM Center database contains values starting with a special 
character, such as %, when you open the resulting CSV file in \ppmc\data\ folder 
after running kSupport.sh to generate support information, and if you have 
associated the .csv file type with Excel, the CSV file will not display properly for the 
cells containing special characters. (QCCR1L41463)

WORKAROUND To display the CSV file properly,
1. Rename the desired CSV file by appending.txt file extention to it.
2. Open the renamed file in Excel and select the following options in the Text Import Wizard: 

- For Original data type, select Delimited; 
- For Delimiters, select Comma; 
- For Column data format, select Text for each of the columns.
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Integrations

LIMITATION Software bundles that require PPM Center version 9.12 to be installed and are 
installed using kDeploy.sh should not set the DEPENDS_ON_VERSION variable 
in the deploy.info file. (QCCR1L41406)

WORKAROUND If configured, remove the DEPENDS_ON_VERSION variable and its value from the 
deploy.info file.

LIMITATION PPM Center version 9.1x does not support adding a top level menu. Your new 
customized menu items may fall under Open, Create, or Search menu.

WORKAROUND None.

LIMITATION If you perform BOM check by running the kSupport tool after deploying a service 
pack bundle file, the Files changed section in the resulting Bill of Materials 
Information page incorrectly lists some system libraries that can be ignored, for 
example:
/deploy/itg.war/WEB-INF/lib/XBeans-packaged.jar

/deploy/itg.war/WEB-INF/lib/knta_classes.jar

/deploy/itg.war/WEB-INF/lib/pm-web.jar

/deploy/itg.war/WEB-INF/lib/webservice.jar

/deploy/itg.war/WEB-INF/lib/webservice_client.jar

/deploy/itg.war/html/client/knta_client.jar

/lib/jboss/boot/knta_logging.jar

(QCCR1L41888)

WORKAROUND None available at this time.

PROBLEM If you are using the Plug-in for PPM, Microsoft Office Primary Interop Assemblies 
(PIA) for Microsoft Project must be installed. (QCCR1L39188)

WORKAROUND Install one of the following versions of Microsoft Office Primary Interop Assemblies 
(PIA) for Microsoft Project:

Version 2003 for Microsoft Project 2003
Version 2007 for Microsoft Project 2007
Version 2010 for Microsoft Project 2010
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Integrations - ALM

Integrations - CMQC

LIMITATION A “Test/Import completed successfully" message will be displayed even 
when the XML imported does not match the XSL template selected, but no 
corresponding request ID will be generated and the log will show “pass:0”. 
(QCCR1L41359) 

WORKAROUND None. 

PROBLEM If text field(s) of a request contain such special characters as “<“ and “&“, error 
occurs when you try to export the request to an XML file. (QCCR1L42539)

WORKAROUND None available at this time.

LIMITATION When you click drilldown list in the ALM - Releases By Category portlet, no result 
is displayed due to an error in the portlet definition in ALM bundle. (QCCR1L42542)

WORKAROUND None available at this time.

PROBLEM If PPM Center is integrated with Quality Center version 11.00, you create a CMQC - 
QA Test Status Report request and try to select a priority level from the 
autocomplete popup window for the field Define Priority Defect Levels, the 
autocomplete popup window shows nothing. This is because Quality Center 11.00 
renamed the table that stores all list values from ALL_LISTS in Quality Center 
10.00 to LISTS. (QCCR1L42561)

WORKAROUND To get the values for all priority levels, use a different SQL statement :
1. Launch PPM Workbench.
2. From the shortcut bar, select Configuration > Validations.
3. Locate and open validation CMQC_CMN_QC_PRIORITY.
4. Replace the existing SQL statement with the following:

ksc_capture_output sh ./ext/qcm/scripts/kqcm_qc_TdsqlQuery.sh 
TdProject:#@# "[REQD="[REQD.P.QC_INSTANCE_NAME]".VP.QC_ADMIN_DB_JDBC_
URL]" "[REQD="[REQD.P.QC_INSTANCE_NAME]".VP.QC_ADMIN_SCHEMA_NAME]" 
"[REQD="[REQD.P.QC_INSTANCE_NAME]".VP.QC_DBADM_USERNAME]" 
"[REQD="[REQD.P.QC_INSTANCE_NAME]".VP.QC_DBADM_PASSWORD]" "[REQD.VP.QC_
TARGET_DOMAIN]" "[REQD.VP.QC_TARGET_PROJECT]" "SELECT LS_NAME,LS_NAME 
FROM LISTS WHERE LS_FATHER_ID IN (SELECT SF_ROOT_ID FROM SYSTEM_FIELD 
WHERE SF_TABLE_NAME = 'BUG' AND SF_COLUMN_NAME = 'BG_PRIORITY')"

5. Click OK.
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HP Demand Management

LIMITATION If you are setting up multiple rules, note that unsaved token value(s) will not be 
applied by the subsequent rules in real-time. (QCCR1L29880)

WORKAROUND None.

LIMITATION If a field is set to “Display = No" or invisible by status dependency, you can not make 
it visible on the web UI by using UI rules. (QCCR1L40010)

WORKAROUND None.

LIMITATION Auto-complete component's valid value list is not in client UI, so when using rule to 
set values for auto-complete component, the values are not validated and invalid 
values can be set. As a result, when users create a request, a value that is not in 
auto-complete list can be inserted and saved in an auto-complete field as triggered 
by the SQL rule. (QCCR1L41050)

WORKAROUND PPM administrators who configure SQL rules to set values for auto-complete list 
should make sure that only valid values are set.

LIMITATION When applying advanced rules on requests with "Printable Version" and the Print 
function, the previewed and printed data does not match with what is displayed on 
the screen. 

WORKAROUND Now rules can be executed on the printable version of Request Details, but with the 
following limitations:  

Only SQL rules and UI Rule setFieldVisible()will be executed.
Only Apply on page load rule event is supported.
The printable version should be opened from Request Details page instead of by 
entering the URL address directly.

(QCCR1L39873)

PROBLEM After you enable field group Program Issue: Allows Requests to be considered 
as Issues In a Program for a request header type, no Program Issue section is 
added to the Fields tab of the request header type.(QCCR1L41722)

WORKAROUND This behavior is by design and it has no functional impact. Request types using this 
request header type can still be used as program issue type and it works fine for 
program issue tracking.
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HP Deployment Management

HP Portfolio Management

LIMITATION SQL for Hierarchical Display (tree validation) now supports resolving such static 
tokens as [SYS.USERNAME] and [SYS.USER_ID].
Other types of tokens, such as Request Details or Context related tokens, are not 
supported. (QCCR1L40379)

WORKAROUND None available at this time.

LIMITATION Rule dependency is not supported if the dependency field is using the () pattern to 
present negative numbers. For example, using (1000) to represent -1000. 
(QCCR1L42478)

WORKAROUND None available at this time.

LIMITATION Long field names in a request are not wrapped over multiple lines, which makes 
content on the rightmost of the page fail to display. (QCCR1L39695)

WORKAROUND Scroll the screen sideways to view the content.

PROBLEM Transfer of bundle to Destination environment fails as the ksc_copy command is 
not working for the Request Type Migrator. (QCCR1L40858)

WORKAROUND Set variable DISABLE_SCP_FILENAME_QUOTE in the Environment User Data. For 
details, see WORKAROUND on page 248 for QCCR1L24976.

LIMITATION The COST_CAPITALIZATION_ENABLED server.conf parameter cannot be 
changed using the Administration Console. (QCCR1L41323)

WORKAROUND The flag can be changed directly in the server.conf parameters as needed. 
However, HP strongly recommends not disabling cost capitalization if it has been 
enabled.
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HP Project Management

Platforms

LIMITATION Work plan workflow special commands might fail intermittently due to concurrency 
limitations. Processing of the Create Project special command must complete 
before processing of the Create Work Plan special command (ksc_create_
workplan) or the Update Work Plan Status special command (ksc_update_
workplan_status) begins, if the special commands are in the same workflow 
step or in a subsequently executed workflow. (QCCR1L42591)

WORKAROUND The following 30-second delay should be executed before the Create Work Plan 
special command or the Update Work Plan Status special command if it follows a 
Create Project special command (in the same or subsequent workflow steps):
ksc_local_exec sleep 30

LIMITATION If you run kStop.sh while background services are running, your PPM Center 
instance (either the nodes in a cluster or a single, stand-alone server) may take a 
while to shut down. In a cluster setup, service nodes may experience this, while the 
user node will not. The kStop.sh script waits for services to complete before it brings 
down the PPM Center instance. (QCCR1L29568)

WORKAROUND None.

PROBLEM SOCKS support for the RMI connection made by workbench to the PPM server is 
not working. Workbench will fail to establish the connection to the SOCKS server. 
(QCCR1L41991)

WORKAROUND None available at this time.

PROBLEM Quartz Scheduler Reassignment and Restart.
On a server cluster, after a services node starts the quartz scheduler, the quartz 
scheduler pauses.  Another services node detects the scheduler inactivity and starts 
the quartz scheduler again. This does not affect functionality. Background services 
are scheduled normally. (QCCR1L42301)

WORKAROUND None available at this time.
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Report Types

Resource Management

PROBLEM Users cannot open the PPM Workbench using the combination of the Mozilla 
Firefox 3.6 browser and version 1.6.0_07 (6.0 update 7) of the Java plug-in. Mozilla 
has desupported this combination of browser and plug-in. (QCCR1L42400) 

WORKAROUND Firefox 3.6 users who use the PPM Workbench must download and install version 
1.6.0_19 (6.0 update 19) or later of the Java plug-in from the JRE downloads on the 
following Web page:
http://www.oracle.com/technetwork/java/javase/downloads/index.html 

PROBLEM Internet Explorer versions 7 and 8 display a warning if the value set for the server 
configuration parameter JAVA_PLUGIN_PATH_IE contains the protocol identifier 
"http:". (QCCR1L42208)

WORKAROUND If you override the default setting for the JAVA_PLUGIN_PATH_IE parameter  
(//java.sun.com/update/1.6.0/jinstall-1_6_0_7-windows-
i586.cab), make sure that you remove the protocol identifier "http:"

LIMITATION When configuring an existing field or adding a new field from the Fields tab in a 
report type, if you set the Validation field to Text Area - 4000, the value of the 
Parameter Col. field does not automatically change to PARAMETER46 or a higher 
parameter number, as it should. (QCCR1L41587)

WORKAROUND After you select Text Area - 4000 as the Validation for the field, manually change 
the value of the Parameter Col. field to PARAMETER46 or a higher parameter 
number.

LIMITATION Data display format inconsistency between the staffing profile page and the Analyze 
Assignment Load portlet: the staffing profile page displays data by hours in the 
format of one decimal place, while the Analyze Assignment Load portlet displays 
data in the format of two decimal places.

WORKAROUND None.
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5 Documentation Errata
The following items are corrections for the version 9.10 documentation.

Changing PPM Center Master Data

APP_SERVER_MULTICAST_PORT and  
MULTICAST_PORT Parameters

LOCATION Installation and Administration Guide, page 282.

ERROR The Installation and Administration Guide needs to include a clear statement 
advising against changing PPM Center master data directly through the database. 
(QCCR1L40130)

CORRECTION A new section titled “Changing PPM Center Data” was added to Chapter 7, 
“Maintaining the Database” to advise against changing PPM Center master data 
directly in the database. 

LOCATION Installation and Administration Guide, page 179.

ERROR The descriptions provided for the APP_SERVER_MULTICAST_PORT and 
MULTICAST_PORT parameters in Table 5-2 were inaccurate. (QCCR1L40190)

CORRECTION The parameter descriptions were modified to reflect their true functionality. A new 
edition of the 9.12 Installation and Administration Guide is available at the HP 
manuals site.
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Required Permissions for PPM Center Database Access

Limits on Physical Memory for 32-bit Windows  
Operating Systems

LOCATION Installation and Administration Guide, page 68.

ERROR PPM Center database users need the Oracle RESOURCE role and CONNECT 
roles. The access needed is very broad. (QCCR1L40254)

CORRECTION A new section titled “Default Permissions for PPM Center Schemas” was added to 
Chapter 3 of the Installation and Administration Guide to provide clear details of the 
access required for the PPM Center application and RML user.

LOCATION Installation and Administration Guide, page 53.

ERROR The guide needs to include information about how to make sure that the physical 
RAM inside a Windows 2003 (Standard Edition) server machine is actually 
available.(QCCR1L40159)

CORRECTION The following note was added to the section “Preparing to Install PPM Center” in 
Chapter 3:
Limits on physical memory for 32-bit Windows operating systems depend in part on 
whether the Physical Address Extension (PAE) is enabled. The PAE allows some 
32-bit Windows systems (Windows Server 2008 Datacenter and Windows Server 
2008 Enterprise) to use more than 4 GB of physical memory. (To enable PAE, use 
the /PAE switch in the Boot.ini file.) 
However, PAE is not available for Windows Server 2003 Standard Edition, so the 
total available physical RAM on this system is limited to 4 GB. For detailed 
information about memory support and memory limitations on Windows operating 
systems, see Microsoft Support online.
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Server Cluster Configuration: Assigning Ports Outside of the 
Ephemeral Port Range

LOCATION Installation and Administration Guide, page 73.

ERROR The Installation and Administration Guide must advise administrators to avoid 
conflict between the ports assigned in the server.conf file and the ephemeral 
port range of the operating system. (QCCR1L39996)

CORRECTION The following section was added to Chapter 3:
PPM Center uses many client sockets for its internal communications. These are 
allocated randomly from the operating system’s ephemeral port range.
To prevent conflicts between internal client socket use and your PPM Server port 
settings, you must check to make sure that the ephemeral port range set for your 
operating system does not conflict with any of the ports assigned in your 
server.conf file. For information about the default ephemeral port range on your 
operating system and how to adjust it, see the documentation for your specific 
operating system.
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Setting the ulimit Value on UNIX Systems

LOCATION Installation and Administration Guide, page 94.

ERROR On UNIX systems, PPM Center (through the kStart.sh script) uses the ulimit 
utility to set the maximum number of open file descriptors to 1000. In a server 
cluster configuration, this setting may be too low, causing nodes to come down.
The Installation and Administration Guide must include guidelines on how to set the 
ulimit value.

CORRECTION (UNIX only) Setting the ulimit Value
On UNIX systems, PPM Center (through the kStart.sh script) uses the ulimit 
utility to set the maximum number of open file descriptors to 1000. In a server 
cluster configuration, this setting may be too low, causing nodes to come down.
If the default ulimit setting does not meet your requirements, reset it as follows:

1. Navigate to the <PPM_Home>/bin directory and open the kStart.sh file in a text 
editor.

2. Locate the following text:

if [ $HOST_TYPE = UNIX ]; then
    ulimit -n 1000
    umask 022

3. Change the ulimit value as follows:

ulimit -n 1100

4. Repeat step 1 through step 3 for each additional node in the cluster.

For example, if your server cluster consists of five nodes, then specifying the 
ulimit value of 1100 for each allocates 5500 open file descriptors for the PPM 
Server cluster deployment.
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Changing PPM Center Master Data

Upgrading Secondary Physical Servers

LOCATION Installation and Administration Guide, page 111.

ERROR The “Configuring Secure Web Logon” section needs additional information about 
important issues to consider if your users access PPM Center using Internet 
Explorer (IE) 6.0 or 7.0, or if you have PPM Servers running on AIX. 
(QCCR1L27117)

CORRECTION Additional Considerations for Configuring Secure Web Logon

This section describes additional steps required to set up secure Web logon if your 
users access PPM Center using Internet Explorer (IE) 6.0 or 7.0, or if you have  
PPM Servers running on AIX.

Enabling Transport Layer Security on Internet Explorer 6.0 and 7.0

Make sure that users who access PPM Center using Internet Explorer (IE) 6.0 or 
7.0 enable Transport Layer Security (TLS) on their browsers. (On the Advanced 
tab of the Internet Options dialog box, select the Use TLS 1.0 checkbox.)

Editing the server.xml File (AIX Only)
If you have PPM Servers running on AIX, open the server.xml file, and add 
algorithm="IbmX509" to it, as follows:

<Connector clientAuth="false" secure="true" scheme="https" debug="0" 
acceptCount="10" enableLookups="true" sslProtocol="TLS" 
address="${jboss.bind.address}" port="22383" minSpareThreads="5" 
maxSpareThreads="5" maxThreads="75" keystoreFile="/<PPM_Home>/
key.store" keystorePass="iamnotroot" algorithm="IbmX509" />

LOCATION Upgrade Guide, page 56.

ERROR Documentation is unclear with regard to upgrading secondary physical servers. 
(QCCR1L40257)

CORRECTION Modified the procedure described in the section “Upgrading a PPM Center Server 
Cluster”.
Documentation Errata 211



Keeping Request Rules and Customized JavaScript Methods 
During an Upgrade

Portlets: When this filter has a value, append Where Clause

LOCATION Upgrade Guide, page 34.

ERROR The Upgrade Guide must let users know that JavaScript files customized in the 
currently installed PPM Center instance will be overwritten during an upgrade to 
PPM Center version 9.10. (QCCR1L29817)

CORRECTION “Task 8, Back Up Customizations” was changed to indicate that JavaScript files that 
are customized in the currently installed instance will be overwritten during an 
upgrade to PPM Center version 9.10. The task now reads “Back up any 
customizations (such as request rules and JavaScript methods, which are 
overwritten during an upgrade) that you want to continue to use with PPM Center 
version 9.12.”

LOCATION Creating Portlets and Modules, page 35.

ERROR The When this filter has a value, append to Where Clause filter field description 
is missing information. (QCCR1L39262)

CORRECTION The following information should be included in the Creating Portlets and 
Modules, in the When this filter has a value, append to Where Clause filter field 
description:
Single quotation marks (‘), including those that may be embedded in a variable, 
cannot be used in the When this filter has a value, append to Where Clause filter 
field.
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Edit Security Groups Access Grant

LOCATION Security Model Guide and Reference, Access Grants appendix.

ERROR The document is missing information about the behavior of the Edit Security Groups 
access grant. (QCCR1L28519)

CORRECTION The following information should be included in the Security Model Guide and 
Reference, Access Grants appendix:
Any user given the Edit Security Groups access grant can add themselves to the 
PPM All Access Grants security group. This security group allows complete access 
to PPM Center. You cannot modify this security group to limit this ability.
If this complete access is not desired but you need to assign a user the Edit Security 
Groups access grant, you can limit this ability by creating a copy of the PPM All 
Access Grants security group, modifying the copy of the security group to limit 
access to itself, and disabling the existing PPM All Access Grants security group:

1. Copy the PPM All Access Grants security group. From the Security Group Workbench, select the 
PPM All Access Grants security group and click Copy.

2. Edit the copied security group: 
 
In the Ownership tab, set the ability to edit the copied security group.  
 
In the Users tab, assign all users who are part of the PPM All Access Grant security group to the 
copied security group. 
 
Make any additional updates to limit access to the security group. 
 
Save your changes.

3. From the PPM All Access Grants security group, remove all users and save your changes.
4. Disable the PPM All Access Grants security group by running the following SQL statements: 

 
UPDATE knta_security_groups SET enabled_flag='N' WHERE security_group_id = 3; 
commit;

5. Restart the PPM Server.
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Projected Utilization Calculation

Preparation to Install Deployment Management Extensions

LOCATION HP Resource Management User’s Guide, page 172.

ERROR The document states that “If the resource is not overallocated, projected utilization 
is less than 100%. If the resource is overallocated, projected utilization is greater 
than 100%.” (QCCR1L29905)

CORRECTION The document should state that “If the resource will not be overallocated, projected 
utilization is less than 100%. If the resource will be overallocated, projected 
utilization is greater than 100%.”

LOCATION HP Deployment Management Extension for Oracle E-Business Suite Guide, page 
39.
HP Deployment Management Extension for Oracle Technology Guide, page 13. 
HP Deployment Management Extension for SAP Solutions Guide, page 17. 

ERROR Bulleted lists on the indicated pages incorrectly include the item “The username and 
password you were given at the time you purchased the Extension.”

CORRECTION Delete the item from the bulleted lists on each of the indicated pages.
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Tracking of Capitalized Costs When a Proposal Becomes a 
Project

Availability of Net Present Value and Nominal Return Columns 
to Display on Proposals/Projects/Assets Tab of Portfolios

LOCATION HP Financial Management User’s Guide, page 74
HP Portfolio Management User’s Guide, page 19
HP Project Management User’s Guide, page 54

ERROR The documents need to clarify the tracking of capitalized costs when there is a 
conflict between the settings for a proposal and the project it becomes.

CORRECTION A proposal may or may not track capitalized costs (in addition to operating costs) 
based on the setting of the option The proposal is for a project that tracks capital 
costs on the Financial Summary Settings page of the proposal. When the proposal 
becomes a project, this setting can conflict with the setting of the option Allow 
capitalized costs on this project on the Cost and Effort policy of the project.
If the Cost and Effort policy of the project type is locked (meaning that no individual 
project of that type can be made to override any settings of that policy) and if the 
policy setting for tracking of capitalized costs conflicts with the financial summary 
setting for the proposal, the setting of the Cost and Effort policy prevails. Otherwise, 
the setting for tracking the project’s capitalized costs is consistent with the setting 
for the proposal.

LOCATION HP Portfolio Management User’s Guide, page 54.

ERROR The Net Present Value and/or Nominal Return columns have been configured on 
the Configure Portfolio Management page to be displayable on the          
Proposals/Projects/Assets tab of portfolios, but the columns are not available to 
users to display when they right-click a column heading on the tab and select the 
Columns option.

CORRECTION To add the Net Present Value and/or the Nominal Return columns, users must 
first change the Fiscal Year field on the tab to Total. 
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Columns Available in Proposals/Projects/Assets Tab of 
Portfolios

Maximum Number of Columns in Proposals/Projects/Assets 
Tab of Portfolios

LOCATION HP Portfolio Management Configuration Guide, page 16. 

ERROR On the Configure Portfolio Management page, an administrator can configure which 
fields users can select in the Proposals/Projects/Assets tab of portfolios. As 
stated in the document, the full set of fields that an administrator can configure is the 
combination of all the request fields in the PFM - Proposal, PFM - Project, and 
PFM - Asset request types. However, if a field appears in multiple request types and 
uses different validation types among any of those request types, HP Portfolio 
Management does not make that field available to configure, and the document 
does not explain this.

CORRECTION If different validation types are used in the request types and the field needs to be 
an available column, the validation types must be made identical.

LOCATION HP Portfolio Management Configuration Guide, page 17. 
HP Portfolio Management User’s Guide, page 53.

ERROR For display of the Proposals/Projects/Assets tab of portfolios, users can select 
from a set of columns that are always available and selectable (there are 18), and 
they can also add any subset of columns that administrators have configured to be 
available to them on the Configure Portfolio Management page.
However, the documents state that the maximum number of columns users can 
select in the Proposals/Projects/Assets tab of portfolios is 20. 

CORRECTION The limit of 20 applies to the set of additional columns that administrators can select 
on the Configure Portfolio Management page. Users can add any subset of these 
columns to the 18 columns that are always available and selectable on the 
Proposals/Projects/Assets tab. If administrators make 20 columns available to 
users to add, users can display up to 38 columns on the Proposals/Projects/
Assets tab.
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In Financial Summaries, Adding Categories and Values to 
Benefits

LOCATION HP Financial Management User’s Guide: 
For benefit categories in proposal, project, and asset financial summaries, pages 
48 and 59
For benefit categories in program financial summaries, pages 91 and 99
For financial data tables, page 124 

ERROR The descriptions of adding new benefit categories in financial summaries are 
incorrect.

CORRECTION The notes regarding adding benefit categories and values should state:
An administrator can add new categories and values for the benefit Category in the 
Benefit Details section of a financial summary by creating the following drop-down 
list validations in the PPM Workbench:

FINANCIAL_BENEFIT_AVOIDANCE_CATEGORY 
FINANCIAL_BENEFIT_REVENUE_CATEGORY 

Administrators can change the values for these two new benefit-related validations 
and for the existing Financial Benefits Line Category List validation. 

Also note that the same set of validations and values used for costs and benefits in 
the financial summaries of proposals, projects, and assets are also used for costs 
and benefits in program financial summaries and financial data tables. 
For more information about validations, see the Commands, Tokens, and 
Validations Guide and Reference. 
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Revised Field Names in Financial Data Tables

Time Sheet Override Rules Do Not Apply if Work Item Is Not 
Specified

LOCATION HP Financial Management User’s Guide, pages 122-123.

ERROR Some field names shown in Figure 4-9 on page 122 and Table 4-16 on page 123 
were renamed in version 9.10.

CORRECTION The corrections are as follows:
The field shown as Total Forecasts was renamed Total Forecast Cost. 
The field shown as Total Actuals was renamed Total Actual Cost. 
The field shown as Total Benefits Planned was renamed Total Forecast 
Benefits. 
The field shown as Total Benefits Actuals was renamed Total Actual Benefits. 

LOCATION HP Time Management Configuration Guide, page 85.

ERROR The document needs to clarify that for a project and its tasks, time sheet override 
rules for approvers are not applied when a Work Item is not specified.

CORRECTION Note that the time approver and billing approver results of an override rule for a 
project and its tasks do not take effect if both of the following conditions are met:

The option Time logged against this project must be approved by a project 
representative from the following group in the Cost and Effort policy for the 
project is selected.
In the Dependencies section of the override rule, the Work Item Type is Project 
or Task (so the Work Item Set is the project name) and the Work Item is not 
specified. 
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Percent Complete and Estimated Remaining Effort Calculations

LOCATION HP Project Management Configuration Guide, page 60.

ERROR The calculations for percent complete and estimated remaining effort are 
incomplete or incorrect for the includePC option of the kPMTMSync.sh 
synchronization script.

CORRECTION The following describes the calculations for percent complete (PC) and estimated 
remaining effort (ERE) for the includePC option of the kPMTMSync.sh 
synchronization script. The calculations may use actual effort (AE) or scheduled 
effort (SE).

If includePC is set to yes and if Track Estimated Remaining Effort per resource 
assignment in the Cost and Effort policy is enabled:

ERE Calculations
ERE = SE – AE
If ERE <= 0, ERE = 0

PC Calculations
If ERE > 0, PC = [ AE / (AE + ERE) ] * 100
If ERE <= 0, PC = 100

If includePC is set to yes and if Track Estimated Remaining Effort per resource 
assignment in the Cost and Effort policy is not enabled:

PC Calculations
If AE = 0, PC = 0
If AE > 0, PC is calculated by HP Project Management

If includePC is set to no or is not included (the setting of Track Estimated 
Remaining Effort per resource assignment in the Cost and Effort policy is not 
relevant):

ERE Calculations
If PC = 0, ERE = SE – AE
If PC = 100, ERE = 0
If 0 < PC < 100 and AE = 0, ERE = SE
if 0 < PC < 100 and AE > 0, ERE = (AE * 100 / PC) – AE

PC Calculations
PC is calculated by HP Project Management
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New Information for Customizing the Standard Interface

This section provides information about customizing menu items.

Adding a Menu Item

Add a new menu item only when it is really necessary to meet your business 
needs. 

To add a new menu item, follow the steps below:

1. Locate the menu.xml file that describes content of menu items in the  
<PPM_Home>/conf/menus/menu.xml directory and open it in an XML 
editor.

2. Locate the line that represents the menu group under which you want to 
add the new menu item. 

For example, the line for the Demand Management menu group under Open 
menu looks like:

<menu id="DEMAND_MANAGEMENT_MENU" key="DEMAND_MANAGEMENT_
MENU_TEXT.TXT" bundle="KNTA_Resources" seq="10">

For Create menu group, the line looks like:

<menu id="MENU_CREATE" key="menu.create" 
bundle="CoreResources" sorting="leaves-top">

3. Depending on the security level you want to apply to the new menu item, 
under the desired menu group, locate a code snippet with similar security 
requirements, copy and paste it into the appropriate location in the 
menu.xml file as a starting point for editing it. 

For example, if your new menu item has security requirements similar to 
the menu item Create > Project, copy and paste the following code section:

Make sure that your new menu item follows the XML schema (<PPM_Home>/conf/
menus/menu.xsd).

PPM Center version 9.1x does not support adding a top level menu. Your new 
customized menu items may fall under Open, Create, or Search menu.
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<menu id="CREATE_PROJECT" key="entity.project" 
bundle="CoreResources">

<url>/itg/project/CreateProjectPage.do</url>
<security> 

<and>
<or>

<license reference-code="6" />
<license reference-code="8" />
<license reference-code="3" />
<license reference-code="2" />

</or>
<access-grant reference-code="1316" />
<or>

<access-grant reference-code="1095" />
<access-grant reference-code="1091" />

</or>
</and>

</security>
</menu>

If your new menu item has no security requirements, you may simply copy 
and paste a code snippet with the <menu id> element and the <url> 
element, for example:

<menu id="IMPORT_CATALOG_DATA_MENU" key="IMPORT_CATALOG_
DATA_MENU_TEXT.TXT" bundle="KNTA_Resources">

<url>/itg/web/knta/src/SRCXMLImporter.jsp</url>
</menu>

For more information about applying security requirements on a menu 
item, see Restricting Access to a Menu Item on page 224.

4. Edit menu item text. 

a. Create a custom resource bundle under <PPM_Home>\server\<server 
name>\deploy\itg.war\WEB-INF\resources\web. For example, 
MyResources.properties.

b. Add a new resource in this file by adding a line, as follows:  
”myCustomLabel”=My Custom Label

c. Edit the code section you pasted in the menu.xml file by changing the 
menu ID, key, and bundle values to make them look like the following: 
<menu id=”MyMenuItem” key=”myCustomLabel” 
bundle=”MyResources”>
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5. Edit menu item URL.

To provide a URL for your new menu item, make sure that you already 
have a URL available for use. 

After editing, the URL for the new menu item should look similar to URLs 
for other menu items under the same menu group. 

For example, 
<url>/itg/MyMenuItem/MyMenuItemPage.do</url>

Or,
<url>/itg/web/knta/dem/MyMenuItemPage.jsp</url>

6. Edit security requirements. 

See details in Restricting Access to a Menu Item by Configuring Access 
Grants and Licenses on page 224.

7. Save and close the file.

If you are using non-standard (foreign language) characters, such as â, ç, é, 
ö, or ñ, make sure you encode the file in UTF-8 format.

8. Stop, and then restart the PPM Server.

9. (Optional, although highly recommended) Verify the changes by logging 
off, and then logging back onto PPM Center and reviewing the menu item.

Changing a Menu Item

Sometimes you may want to change an existing menu item so that it points to 
your custom entity. For example, you may want to change the PPM Center 
default proposal request type to your default request type for creating 
proposals.

Taking the PPM Center default proposal request type as an example, to change 
the menu item and make it point to your custom request type, follow the steps 
below:

Microsoft® Notepad supports UTF-8 encoding when using the Save As 
functionality.
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1. Locate the code snippet representing Create > Proposal menu item in the 
menu.xml file:

<menu id="CREATE_PROPOSAL" key="entity.proposal" 
bundle="CoreResources">

<url>/itg/web/knta/crt/
RequestCreateDispatcher.jsp?BUSINESS_KEY=_PFM_PROPOSAL</
url>
<security> 

<and>
<license reference-code="2" />
<or>

<access-grant reference-code="1045" />
<access-grant reference-code="1041" />

</or>
</and>

</security>
</menu>

2. (Optional) Edit menu item text. 

a. Under the <PPM_Home>\server\<server name>\deploy\itg.war\
WEB-INF\resources\web directory, locate the 
CoreResources.properties resource bundle file and open it.

b. Locate the line representing the Proposal entity:

entity.proposal=Proposal

Modify the line as necessary, for example: 

entity.myproposal=MyProposal

c. Edit the menu.xml file by changing the menu ID, key, and bundle 
values to make them look like the following:

<menu id=”CREATE_PROPOSAL” key=”entity.myproposal” 
bundle="CoreResources">

3. Edit the menu item URL to make it point to your default proposal request 
type.

You should already have a URL for your default proposal request type.

Replace the URL value in the following line with the URL for your default 
proposal request type:
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<url>/itg/web/knta/crt/
RequestCreateDispatcher.jsp?BUSINESS_KEY=_PFM_PROPOSAL</
url>

4. Save and close the file.

5. Stop, and then restart the PPM Server.

6. (Optional, although highly recommended) Verify the changes by logging 
off, and then logging back onto PPM Center and reviewing the menu item.

Restricting Access to a Menu Item

Starting from PPM Center version 9.10, you can restrict access to a menu item 
by combining any of the following four ways:

Access grant

License

Security group

Server parameter

Restricting Access to a Menu Item by Configuring Access Grants and Licenses

You may control the security level of the menu item by combining PPM 
Center product licenses and access grants. 

The code line for a product license looks like:

<license reference-code="<PRODUCT_KEY>" />

where the value for license reference-code represents a product key.

The code line for an access grant looks like:

<access-grant reference-code="<ACCESS_GRANT_KEY>" />

where the value for access-grant reference-code represents an access 
grant.

Edit the following code by adding or removing necessary lines to apply desired 
security level to your new menu item: 
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<security> 
<and>

<or>
<license reference-code="6" />
<license reference-code="8" />
<license reference-code="3" />
<license reference-code="2" />

</or>
<access-grant reference-code="1316" />
<or>

<access-grant reference-code="1095" />
<access-grant reference-code="1091" />

</or>
</and>

</security>

For product names and their corresponding product keys, check the KNTA_
PRODUCTS view for PRODUCT_NAME column and PRODUCT_KEY 
column in your Oracle database for PPM Center.

For access grant names and their corresponding access grant keys, check the 
KNTA_ACCESS_GRANTS view for ACCESS_GRANT_NAME column and 
ACCESS_GRANT_KEY column in your Oracle database for PPM Center.

Restricting Access to a Menu Item by Configuring Security Group Reference Code

To restrict access to a menu item by security group, you need to configure 
security group reference code in the menu.xml file.

For example, if you want to restrict the access to PPM Billing Manager that has 
Demand Management license, 

The menu.xml file configuration would looks like the follows:
<security>

<and>
<security-group reference-code="_PPM_BILLING_MANAGER" />
<license reference-code="2" />

</and>
</security>
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Note that the value of Reference Code field from the Security Group: PPM 
Billing Manager window in the Security Group Workbench is used to refer to 
access key for restricting access by security group.

Restricting Access to a Menu Item by Configuring server.conf Parameter Value

You can also use server parameters to restrict access to a menu item. This 
applies to server.conf parameters with a true/false value only.

Example:
<security>

<and>
<license reference-code="2" />
<server-parameter name="COST_CAPITALIZATION_ENABLED" />

</and>
</security>

This means that the menu item affected will be accessible when both of the 
following conditions are satisfied:

The user has Demand Management license

server.conf has a setting of COST_CAPITALIZATION_ENABLED=true
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6 New Features in PPM Center 9.11
The following new features are included in PPM Center version 9.11:

Hierarchical Selection

User Data for Resources

Hierarchical Selection

Hierarchical selection is the ability to list selectable field values in the form of 
a hierarchy or tree. If the field values can be defined hierarchically, the 
selectable field values can be presented to the user in a hierarchical list. For 
example, when a resource pool (ResourcePool_1a) is created, a parent resource 
pool can be set. If a parent resource pool (ResourcePool_1) is configured to 
ResoucePool_1a, in the hierarchical selection, Resource_Pool_1a appears as a 
child to ResourcePool_1. 

PPM Center versions 9.10 and 9.11 were released before versions 8.03 and 9.12. 
Versions 8.03 and 9.12 include improvements to core functionality that are compatible 
between those versions, but are not supported on the older versions 9.10 and 9.11. 
If PPM Center is running at version 8.03, do not upgrade to and then run at version 
9.10 or 9.11. Instead, upgrade from version 8.03 to version 9.10 temporarily without 
running PPM Center, and then upgrade immediately to version 9.12. 
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Figure 6-1. Hierarchical selection example

Hierarchical selection must be enabled by the system administrator and is only 
available for the Auto Complete List validation. 

Upgrade Considerations

Hierarchical selection can be enabled on upgraded Auto Complete List 
validations. By default, hierarchical selection is disabled.

Enabling Hierarchical Selection

Hierarchical selection can be enabled for Auto Complete List validations only. 

To enable hierarchical selection:

1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Open Workbench.

The PPM Workbench opens.

3. On the shortcut bar, click Configuration > Validations.
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4. From the Validations Workbench, 

If you are creating a new validation, click New Validation. Enter the 
required fields (Name and Reference Code). For Component Type, select 
Auto Complete List. For Validation By, select SQL - Custom.

If you are updating a validation, click List, and then find and double-click 
on the validation.

5. Select the Enable Hierarchical Selection? checkbox. The Hierarchical 
Display tab is enabled.

6. From the Hierarchical Display tab, set the following fields:

7. Enter any other information for the validation.

8. Select OK.

If a field uses this validation, the hierarchical selection icon (  ) appears next 
to the field.

If you cannot select the Enable Hierarchical Selection? checkbox, hierarchical 
selection cannot be enabled for the validation.

Field Description

Is folder selectable?

In a hierarchical selection, a parent node may be a 
container for selectable values or the parent node 
may be a selectable value.
Enable this checkbox if the parent node is a 
selectable value. Selecting this checkbox allows the 
parent node value to be selected as the field value.
Disable this checkbox if the parent node is only a 
container or folder. Disabling this checkbox does not 
allow the parent node value to be selected as a field 
value.

SQL

Provide the Select statement that queries the 
database information. An ending semicolon is not 
necessary. See Hierarchical Display Tab Query 
Example for more information.
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Hierarchical Display Tab Query Example

A basic SQL query used in the Hierarchical Display tab consists of the 
following:

Select <PrimaryIDColumn> id, 
<ParentIDColumn> parentId,
<FolderDefinition> isFolder,
<BusinessKeyColumn> name,
<DisplayInfo_1>, <DisplayInfo_2>, ... , <DisplayInfo_n>
from <Table_1>, <Table_2>, ... , <Table_n>
where <Condition_1> and <Condition_2> and ... and <Condition_n> 
and NVL(<ParentIDColumn>,0) = :parentId

where

<PrimaryIDColumn> Required. Column name whose data type is 
numeric. Identifies the object that is 
displayed in the hierarchical selection list, 
such as a resource pool      (rpl.resource_
pool_id) or skill (sk.skill_id).

<ParentIDColumn> Required. Column name whose data type is 
numeric and is a parent. Identifies the parent 
of the selected object such as a parent 
resource pool               (rpl.parent_
resource_pool_id) or parent skill 
(sk.parent_skill_id).
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<FolderDefinition> Required. A column name (such as a flag) or 
sub-query that determines if the object is a 
folder. The value or result must be either ‘Y’ 
or ‘N.’

An example of a column name is:     sk.is_
skill_folder_flag

An example of a sub-query is: 
decode(sign((select 
count(rpl2.resource_pool_id) from 
RSC_RESOURCE_POOLS rpl2 where 
rpl2.enabled_flag='Y' and 
rpl2.parent_resource_pool_id= 
rpl.resource_pool_id)),1,'Y','N')

<BusinessKeyColumn> Required. The user-defined name of the 
object that is displayed in the hierarchical 
selection list.

<DisplayInfo_1>, ... , 
<DisplayInfo_n>

Optional. Additional information about the 
object to be displayed in the hierarchical 
selection list.

<Table_1>, ... , <Table_n> Required. The name of the table from which 
to query. For example,                RSC_
RESOURCE_POOLS or RSC_SKILLS.

<Condition_1> and ... and 
<Condition_n>

Conditions to be met in order for the object 
to be selected to display in the hierarchical 
selection list. 

At a minimum, you must include the 
following condition: 
NVL(<ParentIDColumn>,0) = :parentId
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The following is an example of a hierarchical display query that could be used 
for a resource pool validation:

select rpl.resource_pool_id id, 

rpl.parent_resource_pool_id parentId, 

decode(sign((select count(rpl2.resource_pool_id) from       
RSC_RESOURCE_POOLS rpl2 where rpl2.enabled_flag='Y' and 
rpl2.parent_resource_pool_id=rpl.resource_pool_id)),1,'Y','N') 
isFolder, 

rpl.resource_pool_name name, 

krsc_utils.get_pool_managers_list(rpl.resource_pool_id), 
rpl.description 

from RSC_RESOURCE_POOLS rpl 

where rpl.enabled_flag='Y' and                   
NVL(rpl.parent_resource_pool_id, 0) = :parentId

Using Hierarchical Selection

Hierarchical selection is enabled for a field when the hierarchical selection 
icon (  ) appears next to the field. Clicking the hierarchical selection icon 
opens a list of selectable field values in the form of a hierarchy or tree.

If the field allows only one value to be entered, you can choose only one value 
from the hierarchical selection. If a value exists in the field, the selected value 
replaces the existing value.

If the field allows more than one value to be entered, you can choose one or 
more values from the hierarchical selection. If a value exists in the field, the 
selected values are appended to the existing value.
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User Data for Resources

Pages in PPM Center display a set of standard fields for collecting and 
displaying information. User data is the set of custom fields that can be defined 
by the system administrator.

If you want to include additional fields in a resource’s page, you can define 
them in the User Data Workbench.

Resource user data are customizable resource attributes that are added to the 
Details tab in a resource’s page. The system administrator configures the 
resource attributes that are displayed in a resource’s page and the resource can 
modify the values of these resource attributes from the Details tab.

Resource user data is not available in the Search Resources page nor can they 
be modified for multiple resources simultaneously.

To configure user data:

1. Log on to PPM Center.

2. Select Open > Administration > Open Workbench.

The PPM Workbench opens.

3. From the shortcut bar, select Configuration > User Data.

The User Data Workbench opens.

4. Click List.

The Results tab opens with the available user data types.

5. To configure resource user data, select Resource User Data and click Open. 

The User Data Context window opens.

6. To add a field, click New.

The Field: New window opens.
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7. From the Field: New window, do the following:

a. Configure up to 100 fields. Enter the following information: 

i. In the Field Prompt box, type the label to display for the new field.

ii. In the Token box, type an uppercase text string to use to identify 
this field.

The token name must be unique to the specific user data. An 
example token name is ASSIGNED_TO_USER_ID.

iii. In the Description box, you can enter text that describes what the 
field captures and how it is to be used.

iv. To enable the new field, leave Enabled selected.

v. In the Validation box, enter or select the validation logic to use to 
determine the valid values for the field. 

This can be a list of user-defined values, a rule that the result must 
be a number, and so on.

vi. The Component Type field indicates the field type (list, free-form 
text field, and so on). This read-only field is derived from the 
validation you selected.

vii. If the field lists selectable items, and you want users to be able to 
select more than one of these, select Multiselect.

If you select Multiselect, the PPM Workbench displays a dialog box 
that lists limitations imposed on multiselect user fields. 

If you selected Multiselect, make a note of the limitations, and then 
click Yes.

b. On the Attributes tab, enter the following information: 

i. In the User Data Col list, select the internal column in which the 
field value is to be stored. 

You can store information in up to 100 columns, which means that 
you can create up to 100 custom fields for resources. No two fields 
in user data can use the same column.
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ii. To make the new field read-only at all times, in the Display Only 
list, select Always. To make the field editable at all times, select 
Never.

iii. To make the field visible to users, next to Display, leave Yes 
selected. To hide the field, select No.

iv. To make the field required (the user must specify a value) at all 
times, in the Required list, select Always. To make the field optional 
at all times, select Never.

c. To configure a default value for the user data field, open the Default tab 
and enter the following information: 

i. To indicate that the field is to have a default value, in the Default 
Type list, do one of the following:

o To specify that the field default is to be a constant value, select 
Constant.

o To specify that the field default is to have no default, select 
None.

ii. If you specified a constant default type, then in the Visible Value 
list, select the constant value. 

8. To save your changes and create another field, click Add. The Field 
window clears so that you can create another new field. Repeat step 7, as 
needed.

To save your changes and close the Field window, click OK.

9. From the User Data Context window, use the Layout tab to rearrange the 
fields as you want the user to view them from the Details tab.

10. Click OK.
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7 Enhancements, Integrations, Certifications, 
and Fixes in PPM Center 9.11
This section includes information about the enhancements, integrations, 
certifications, and fixes in PPM Center version 9.11.

Enhancements

The following enhancement is included in PPM Center version 9.11:

User data for positions

With this enhancement, users now may add up to 100 fields.

Certifications

The following certifications are included in PPM Center version 9.11:

Support for Universal CMDB versions 9.00 and 9.01

Support for CCRM 9.1
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Support for Universal CMDB versions 9.00 and 9.01

This certification provides Universal CMDB versions 9.00 and 9.01 support 
for the following PPM Center integration solutions:

PPM Center integration with Universal CMDB for Service Portfolio

Note the following impact to configuration:

o Define the UCMDB_SERVER_VERSION parameter in the 
server.conf file with the proper value. For example, 9.00.

For more information about this integration solution, see the HP Solution 
Integrations Guide. 

PPM Center integration with Universal CMDB (using ALM)

Note the following impacts to installation and configuration:

o PPM Server must have the same domain name as the Universal CMDB 
server. For example, if the Universal CMDB server domain name is 
abc.chn.hp.com, the PPM Server must be xyz.chn.hp.com, such as 
anbo.chn.hp.com.

o PPM Server must be running on the save protocol as the Universal 
CMDB server. For example, if the Universal CMDB server is running 
on HTTPS, the PPM Server must be running on HTTPS as well.

o Define the UCMDB_SERVER_VERSION parameter in the 
server.conf file with the proper value. For example, 9.00.

o Consult your Universal CMDB server administrator and define the 
following new parameters in the server.conf file for impact analysis 
report:
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o Starting from PPM Center version 9.11, you need to encrypt the 
Universal CMDB password with PPM’s encryption tool kEncrypt.sh.

To encrypt the password, 

i. Navigate to the <PPM_Home>/bin directory.

ii. Run the following:

sh kEncrypt.sh -t admin

The encrypted text returns. 

iii. Copy and paste the encrypted text as the value for parameter 
UCMDB_PASSWORD in the server.conf file, making sure that 
you do not copy any carriage returns into the file.

For more information about the integration solution, see the HP Solution 
Integrations Guide. 

Parameter Description

IMPACT_ANALYSIS_REPORT_
CATEGORY 

Impact analysis report 
category, for example, UCMDB

IMPACT_ANALYSIS_REPORT_
SEVERITY 

impact analysis report 
severity, for example, 
Warning(1)

UCMDB_NAME_FIELD The field that stores the CI 
name, for example, name 

Cookies need to be enabled for the browser you use.
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Support for CCRM 9.1

This certification provides Change Configuration and Release 
Management (CCRM) 9.1 support for the following PPM Center 
extensions:

o PPM Project Task to SM RFC Integration

o SM RFC to PPM Project Task Integration

Fixes

The following fixes are included in PPM Center version 9.11:

Costing - Staffing Profile Budget Sync

Dashboard

Make sure that these two extensions support Service Manager 9.20, which is 
required for CCRM 9.1 support.

Tracking Number Problem Description

N/A Exception appears when editing header of any Staffing Profile that was 
synchronized with Financial Summary (budget) before upgrade. (QCCR1L27897)

Tracking Number Problem Description

N/A Discrepancies in indexes between upgrade and fresh. (QCCR1L27989)
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Integrations - SM RFC

Platform

Resource Management

Time Management

Tracking Number Problem Description

N/A Task finish date is changed after synchronization to SM RFC. (QCCR1L28357)

Tracking Number Problem Description

N/A Discrepancies in indexes between upgrade and fresh. (QCCR1L27408)

N/A Cannot add security group to users from workbench. (QCCR1L27785)

Tracking Number Problem Description

4620109634 Error occurs when adding resources to a project or saving tasks in work plan on a 
PPM Center instance with French (Canada) Formatting Options in User Profile and 
CAD currency. (QCCR1L28441)

N/A Discrepancies in indexes between upgrade and fresh. (QCCR1L27990)

Tracking Number Problem Description

N/A Discrepancies (missing) in indexes from fresh install to upgraded instance for  
TM_TIME_SHEET_LINES and PM_WORK_PLANS. (QCCR1L27986)
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8 Known Problems and Limitations in PPM 
Center 9.11
The following problems and limitations are known to exist in PPM Center 
version 9.11 (or other software, as indicated). The problems are categorized by 
the affected product area. If a problem has an assigned internal tracking 
number, that tracking number is provided (in parentheses) at the end of the 
problem description.

Center Management for Quality Center

LIMITATION CMQC bundle does not support Oracle 11.2.0.1. Deployment of the bundle using 
that environment will result in an error. (QCCR1L27892)

WORKAROUND Oracle 11.1.0.7 is supported.
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Installation

Dashboard

LIMITATION Because the PPM Center installation and configuration wizards are not fully 
localized in Chinese and Portuguese (Brazilian) languages, some of the text in 
wizard steps are shown in English only during installation or system configuration. 
(QCCR1L27173)

WORKAROUND None.

LIMITATION After you install PPM Center and then install language packs, the Import 
Notifications section of all of the language pack deployment logs saved to the 
<PPM_Home>\logs\Lang_Pack\ directory contain the error “Fail to deploy 
NotifBody...”
These error messages have no functional significance and can be ignored. 
(QCCR1L27539)

WORKAROUND None.

PROBLEM
Any PPM Center portlets that contain the word “program” do not display the new 
Chinese translation for “program” and instead display the old Chinese translation for 
“program”. (QCCR1L27636)

WORKAROUND None.
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Integrations

Integration with Quality Center (ALM)

PROBLEM Using Internet Explorer and Microsoft Project 2007, opening a work plan in 
Microsoft Project from PPM Center generates a lock file for the Microsoft Project 
file. However, after closing the Microsoft Project file, the lock file is not reset. When 
opening the same work plan in Microsoft Project from PPM Center (without 
restarting Internet Explorer), the File in Use message is displayed and the Microsoft 
Project file can only be opened in read-only mode (you may also choose to be 
notified when the file is no longer in use). (QCCR1L25812)

WORKAROUND After closing the Microsoft Project file you can reset the lock file by doing one of the 
following:

Delete the lock file. From any Internet Explorer window, do the following:
1. Select Tools > Internet Options.
2. In the General tabbed area, in the Temporary Internet files section, click Delete Files.
3. From the Delete Files dialog, click OK.
4. From the Internet Options dialog, click OK.

Restart Internet Explorer
Restart the system on which Internet Explorer is running.

LIMITATION Synchronization of workflows is not supported. PPM Center and Quality Center 
each has its own workflow to manage the process of defect handling. When driving 
the workflows from both sides, and moving a defect to another step in PPM Center's 
workflow, it cannot be reflected in Quality Center’s workflow, and vice versa.

WORKAROUND None available at this time.

LIMITATION Bi-directional synchronization of drop-down list values is not supported. 
(QCCR1L25919)

WORKAROUND None available at this time.

LIMITATION Comments and description format tags are displayed in PPM Center directly in 
normal text. (QCCR1L25815)

WORKAROUND None available at this time.
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Integration with Universal CMDB (ALM)

LIMITATION If a date-type field in Quality Center has a special format, the mapping field in PPM 
Center must have the same format, otherwise the date will not be synchronized to 
PPM Center correctly. (QCCR1L25917)

WORKAROUND None available at this time.

LIMITATION Quality Center support multi-value fields, such as target release and target cycle. 
However, current design of PPM Center does not support mapping a PPM field to a 
multi-valued Quality Center field.

WORKAROUND None available at this time.

PROBLEM If a user selects more CIs than the maximum allowed CI number, an error message 
will pop up and it returns to the CI selector, but the selected CIs are gone. The user 
needs to select them again.

WORKAROUND None available at this time.

PROBLEM View Type, View Tree Name, and View TQL Name are deprecated in Universal 
CMDB 9.0, thus their values are not available.

WORKAROUND None available at this time.

LIMITATION Due to Universal CMDB 9.0 limitation, PPM Server must have the same domain 
name as the Universal CMDB server. For example, if the Universal CMDB server 
domain name is abc.chn.hp.com, the PPM Server must be xyz.chn.hp.com, such as 
anbo.chn.hp.com.

WORKAROUND None available at this time.

LIMITATION Due to Universal CMDB 9.0 limitation, PPM Server must be running on the save 
protocol as the Universal CMDB server. For example, if the Universal CMDB server 
is running on HTTPS, the PPM Server need to be running on HTTPS too.

WORKAROUND None available at this time.
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HP Demand Management

PROBLEM If a request contains a rule that uses KNTA_MULTI.Find_User_full_
names([SYS.USER_ID]) from sys.dual, saving the request may fail or 
removing associated entities from the request may fail. (QCCR1L24349)

WORKAROUND Use KNTA_MULTI.Find_UserNames([SYS.USER_ID]) from sys.dual 
instead.

LIMITATION A token unparseable error occurs when creating a request of a request type, where 
its validation referenced a non-existing token. (QCCR1L27418)

WORKAROUND When you specify a validation for your request type, report type, or object type, 
make sure that the token(s) referenced by the validation already exist.

LIMITATION When Text Field is set to “is equal to” the value of an Auto Complete List or Drop 
Down List value in the Dependencies section of the Rules tab in the request type 
workbench, the dependencies do not work; However, if the Text Field is set to 
match the code of the Auto Complete List or Drop Down List, the dependencies 
work well. (QCCR1L27020)

WORKAROUND Considering the fact that Auto Complete List and/or Drop Down List values can be 
localized, which will then cause consistency issue for the dependencies, HP 
recommends you to match Text Field code to the code of Auto Complete List or 
Drop Down List when you set up request type field dependencies.
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HP Deployment Management

PROBLEM File transfer from source environment to destination environment using Reflection 
for Secure IT for Unix (version 7.1) server fails when the environments were 
configured in a workflow execution step. (QCCR1L24976)

WORKAROUND To use Reflection for Secure IT for Unix server to transfer files successfully, 
1. Create a new Environment User Data using the following values: 

Field Prompt: DISABLE_SCP_FILENAME_QUOTE
Token: DISABLE_SCP_FILENAME_QUOTE
Enabled: Yes
Validation: Yes No Radio Buttons
User Data Column: Select a value from the drop down list.
Display: Yes
Display Only: Never
Required: Never 

Then, in the Environment you want to use, enable the newly created user data.
For more information about creating and enabling user data, see the HP Deployment Management 
Configuration Guide. 

2. Note down the Server environment and Client environment values you used in step 1.
xx3. Configure the workflow execution step and use the Server environment and Client environment 
AAavalues you noted down earlier for Source Environment and Dest Environment fields. 
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HP Portfolio Management

HP Program Management

Multilingual User Interface (MLU)

PROBLEM If you used environment tokens in Object Type with special command ksc_copy_
server_server and set the Source and Destination environments as its 
parameters, file transfer from source environment to destination environment with 
Reflection for Secure IT for Unix (version 7.1) server fails. (QCCR1L27758)

WORKAROUND Modify the environment settings by following the instructions described in the 
WORKAROUND for QCCR1L24976.

PROBLEM Transaction History and Notes History cannot be enabled in the Associated 
Programs field of a PFM - Asset, PFM - Project, or PFM - Proposal request header 
type or a copy of one of these request header types. Selecting Yes or No does not 
enable these auditing features. (QCCR1L26865)

WORKAROUND None available at this time.

PROBLEM Program risk request types are not available.

WORKAROUND Program risk request types are part of the Best Practices content. Best Practices 
must be installed/re-installed in order to use this content.

PROBLEM When deploying language packs, the logs will show the following error for all 
languages, except for the system language:
[java] java.sql.SQLIntegrityConstraintViolationException: 
ORA-02291: Integrity-Constraint (GEEK_01.KNTA_NOTIFICATIONS_
LOC_FK) violated

This error has no functional impact. (QCCR1L27539).

WORKAROUND None.
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HP Project Management

PROBLEM When using Internet Explorer, using tooltips in the work plan may display a 
message about the page containing secure and nonsecure items, prompting you to 
continue. Each time a work plan is redrawn or refreshed, using tooltips in the work 
plan displays this message. (QCCR1L24383)

WORKAROUND This message may be disabled from the Security Settings of the browser.
From Internet Explorer:

1. Select Tools > Internet Options.
2. Select the Security tab.
3. Select the Internet Web content zone.
4. Click Custom Level.
5. Under Miscellaneous and Display mixed content, select Enable.
6. Click OK.
7. Click OK.
8. Restart Internet Explorer.

PROBLEM When a user (such as a project manager or summary task owner) edits a task’s 
resources directly from the work plan page, resources who are already assigned to 
the task are deleted if they do not belong to a resource pool managed by that user. 
Resources who have entered actual efforts for the task are not deleted. 
(QCCR1L26798)

WORKAROUND Assign all users who manage resource assignments for the project as a resource 
pool manager to all resource pools that are associated with the project.

PROBLEM If a user edits a task’s external predecessor from the work plan page, when the task 
is saved, the external predecessor is deleted. (QCCR1L27616)

WORKAROUND Use the Task Details page to edit a task’s external predecessors. Do not edit 
external predecessors from the work plan page.

PROBLEM When exporting a work plan to both PDF and Excel, if the work plan has a task with 
a name that contains double-byte numbers, the exported PDF differs from the 
exported Excel. In the exported PDF, the task name does not contain the 
doublebyte numbers. (QCCR1L14109)

WORKAROUND None.
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Operational Reporting

PROBLEM Opening a linked report from the parent WEB Intelligence report results in the 
removal of data from the parent report results. This happens only if you open a 
linked report after you export the parent report to Excel and save it. Thereafter, if 
you click the refresh button on the parent report prompt, saved filter values are lost. 
(QCCR1L16514)

WORKAROUND After you export a parent report to Excel, re-run the report with new prompt values, 
and then open the linked report without exporting it to Excel.

PROBLEM Although you can run the operational reports that HP supplies, you cannot create or 
edit reports in InfoView without security risk. If you attempt to create or edit a Web 
Intelligence document in InfoView, a dialog box displays the message, “The 
application’s digital signal has an error. Do you want to run the application?” 
(QCCR1L25229)

WORKAROUND Do not attempt to create or edit a Web Intelligence document in InfoView. If you do, 
then after the message, “The application's digital signal has an error. Do you want to 
run the application?” is displayed, click Cancel.

PROBLEM A database error occurs if you provide a query prompt value that contains a 
backslash (\) character. (QCCR1L16066)

WORKAROUND If you provide the prompt value manually, type two backslash characters instead of 
just one.

PROBLEM If you export a Web Intelligence document that contains Asian characters to PDF 
format, the Asian characters are not exported. (QCCR1L25538)

WORKAROUND None.

PROBLEM In order to display a long text string so that it wraps to fit the width of a cell, InfoView 
adds a hyphen to the string in Web Intelligence documents. If a text string such as 
this contains Asian or particular European (Russian, Turkish) characters, InfoView 
places the hyphen(s) incorrectly so that some characters are not displayed in report 
results. This can occur in the Time Sheet Compliance report if the resource pool 
names are long and contain Asian characters. (QCCR1L25537)

WORKAROUND Increase the width of cells in the report.

PROBLEM If you modify the fiscal period definition in PPM Center after you set up the 
Operational Reporting schema and load PPM Center data, the changes to the fiscal 
period definition are not brought into in the Operational Reporting schema during 
subsequent incremental ETL operations. (QCCR1L27596)
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Other

WORKAROUND Re-run the setup and load scripts to bring your changes to the fiscal period 
definition into the Operational Reporting schema.

PROBLEM HP-supplied operational reports can sometimes omit result rows or incorrectly total 
row values if the results require a large number of rows to display.
If you run an HP-supplied operational report and you specify query filter options that 
include a wide range of data that generate a large number of result rows, the last 
few rows and totals may be hidden by the Query Filter options text in the report 
results displayed. (QCCR1L26958)

WORKAROUND Run the report from a new Web browser session.

PROBLEM

If the PPM Center database schema is restored from a data dump in which 
BusinessObjects was already configured, and the BusinessObjects scripts are re-
run on the restored dump, the setup script cannot automatically drop the Oracle 
Change Data Capture (CDC) tables. 

WORKAROUND

If the PPM Center database schema is restored from a data dump in which 
BusinessObjects was already configured, and you must re-run the BusinessObjects 
scripts on the restored dump, make sure that you manually drop all of the CDC 
tables before you re-run the BusinessObjects setup script.

PROBLEM
HP has noticed Oracle Internal Errors (Ora 600) for certain test data sets when 
accessing the HP PPM Operational Reports or during the process of ETL in the HP 
PPM Operational Reports.

WORKAROUND If you encounter such errors, upgrade your Oracle Database software to version 
11.2.0.1 or later to fix the problem.

After you install PPM Center version 9.11, you can locate the packages rpt_sync_
objects.plb and rpt_request_update_dimension.plb under the 
OpsReporting folder, and then deploy these two packages on your Reporting DB 
schema to replace the previous version.

LIMITATION
Because Oracle Enterprise DB Server is not supported on VMware, PPM Center 
(including the Operational Reporting solution) does not work with Oracle Enterprise 
DB Server on VMware.

WORKAROUND None.
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